Oracle SCM Cloud

Using Replenishment Planning

20A
# Contents

<table>
<thead>
<tr>
<th>Preface</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1 Introduction to Replenishment Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Oracle Fusion Replenishment Planning</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>Overview of Supply Chain Planning Work Areas</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>Overview of the Replenishment Planning Work Area</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>Work with Page Layouts in Replenishment Planning</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>Overview of Supply Chain Planning Plan Types</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>How You Define Planners for Supply Chain Planning</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>Assign Time Zones to Locations in Supply Chain Planning</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2 Tables, Graphs, Analysis Sets, Infotiles, and Tile Sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>How You Manage Tables, Graphs, Analysis Sets, Infotiles, and Tile Sets</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>Create an Infotile in Supply Chain Planning</td>
</tr>
<tr>
<td>14</td>
</tr>
<tr>
<td>Create a Tile Set in Supply Chain Planning</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>Set Measure Targets for Use in Infotiles</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>Graph Layout Options</td>
</tr>
<tr>
<td>16</td>
</tr>
<tr>
<td>Why can't I edit the graph layout options?</td>
</tr>
<tr>
<td>17</td>
</tr>
<tr>
<td>Axis Scale Options</td>
</tr>
<tr>
<td>17</td>
</tr>
<tr>
<td>Manage Measure Data in Tables</td>
</tr>
<tr>
<td>18</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3 Planning Analytics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Planning Analytics</td>
</tr>
<tr>
<td>21</td>
</tr>
<tr>
<td>Configure Planning Analytics</td>
</tr>
<tr>
<td>21</td>
</tr>
<tr>
<td>Dimensions and Dimension Catalogs</td>
</tr>
<tr>
<td>23</td>
</tr>
<tr>
<td>Measure Catalogs</td>
</tr>
<tr>
<td>26</td>
</tr>
<tr>
<td>Levels and Attributes</td>
</tr>
<tr>
<td>27</td>
</tr>
</tbody>
</table>
## Planning Measures

- Predefined Measures in Supply Chain Planning
- How You Manage Planning Measures
- Configure Units for a Measure
- Configure Currencies for a Measure
- Configure Conditional Formatting for a Measure
- Manage User-Defined Measures

## Supply Network Model

- How You Maintain Your Supply Network Model
- Publish Order Forecasts to Suppliers
- How You Define the Approved Supplier List for Supply Chain Planning
- Associate Calendars with Supplier Sites
- Specify Catalogs for Assignment Sets
- Item Attributes and Order Modifiers for Supply Planning

## Planning Data Collection

- Overview of Data Collections for Supply Chain Planning
- Global Entities
- Data Collection Types for Supply Chain Planning
- Manage Planning Source Systems for Data Collections
- How the Order Orchestration and Order Promising Processes Use the Collected Planning Data
- How You Enable Cross-References of Entities by Data Collections
- How Planning Processes Collect Different Work Definitions and Item Structures
- Enable External Data Collection for the Oracle Fusion Source System
- Collect Planning Data from the Oracle Fusion Source System
- Load Planning Data from Others and External Source Systems
- Verify Collection Processes

## Exceptions

- Configure Exceptions and Exception Sets
- Work With Exceptions in Plans
- User-Defined Exceptions
# Oracle SCM Cloud
## Using Replenishment Planning

## 8 Segmentation
- Segmentation in Oracle Fusion Replenishment Planning 93
- Work with Segment Groups 95
- Run Segmentation 98
- View the Segmentation Summary 99
- Override Segmentation Results 100

## 9 Policy Assignment Sets
- Policy Assignment Sets 103
- How You Use Policy Assignment Sets 106
- How Average Daily Demand Is Calculated in Oracle Fusion Replenishment Planning 107
- How EOQ Is Calculated in Oracle Fusion Replenishment Planning 109
- How Safety Stock Is Calculated in Oracle Fusion Replenishment Planning 111
- Static Policies or Time-Phased Policies in Oracle Fusion Replenishment Planning 112
- How Order Modifiers Are Applied When Replenishments Are Calculated 114
- Work With Policy Assignment Sets 116
- Work With the Policy Comparison Feature 121

## 10 Statistical Forecasts
- Create a Forecasting Profile 133
- Edit a User-Defined Forecasting Profile 135
- Forecasting Methods 136
- Configure Decomposition Groups 137
- Forecasting Parameters 138

## 11 Replenishment Plans
- Create a Replenishment Plan 141
- Open a Replenishment Plan 142
- Copy a Replenishment Plan 143
- View a Replenishment Plan 144
- Manage Plan Options 144
- Best Practices for Setting Up Replenishment Plans 157

---

[Oracle](https://oracle.com)
## 12 Forecast Simulation  

- Overview of Forecast Simulations 161
- Simulate Demand 161
- Create a Simulation Set 162
- Edit a Simulation Set 163
- Edit a Simulation Set from a Spreadsheet 164

## 13 Business Insights  

- Manage Notes in Supply Chain Planning 167
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons ? to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

- Community: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

- Training: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Introduction to Replenishment Planning

Overview of Oracle Fusion Replenishment Planning

This topic provides an overview of Oracle Fusion Replenishment Planning. Here’s what you can do in the Replenishment Planning work area:

- Maintain optimum inventory levels at each node of your supply chain while meeting customer service targets.
- Use automated processes to maintain inventory policy parameters, dynamically update on-hand inventory, reduce costs by calculating the economic order quantity (EOQ) for replenishments, and improve customer service levels.
- Perform dynamic demand segmentation by grouping item-location combinations into segments that are meaningful to your business.
- Calculate service level-based inventory policies and thresholds.
- Integrate demand forecasting and time-phased inventory replenishment.
- Simulate inventory planning.
- Set up and monitor exceptions.
- Use rich, embedded analytics.

Also, with REST services, you can generate replenishment orders, manage segments, and integrate Replenishment Planning with other Oracle applications.

This table shows how Replenishment Planning integrates with other Oracle Cloud applications:

<table>
<thead>
<tr>
<th>Oracle Application</th>
<th>Entities Collected by Replenishment Planning</th>
<th>Entities Released by Replenishment Planning</th>
</tr>
</thead>
</table>
| Oracle Fusion Inventory Management        | • On-hand inventory  
• Inventory transfers  
• Consumption history | • Inventory transfer recommendations                           |
| Oracle Fusion Procurement                 | • Purchase orders  
• Requisitions                                                   | • Buy recommendations                                        |
| Oracle Fusion Order Management            | • Sales orders  
• Shipment history                                              | N/A                                                          |
| Oracle Fusion Product Management          | • Items  
• Organizations                                                 | N/A                                                          |
Overview of Supply Chain Planning Work Areas

The Oracle Fusion Supply Chain Planning solution contains products designed for specific supply chain planning processes and tasks. You perform these processes and tasks using work areas.

The Supply Chain Planning work areas that you can use are determined by:

- The products that your enterprise has licensed and configured
- The security privileges assigned to your user account

To use the Supply Chain Planning work areas, you must be aware of these points:

- Navigation to work areas
- List of Supply Chain Planning work areas and the applicable products

Navigation to Work Areas

You can use different paths to navigate to a work area:

- From the Navigator: You click the Navigator to see the work areas you have access to. The Supply Chain Planning work areas are listed within the Supply Chain Planning heading. The work area names are links. You click a work area link to open that work area.
- From the Springboard: On your home page, you may have one or more springboards that represent work area groups. Click the Supply Chain Planning springboard to view a set of icons, each of which represents a Supply Chain Planning work area. To open a work area, you click its icon.

List of Supply Chain Planning Work Areas

This table lists the Supply Chain Planning work areas and applicable products:

<table>
<thead>
<tr>
<th>Work Area</th>
<th>Products</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand Management</td>
<td>Oracle Fusion Demand Management</td>
</tr>
<tr>
<td>Supply Planning</td>
<td>Oracle Fusion Supply Planning</td>
</tr>
<tr>
<td>Demand and Supply Planning</td>
<td>This work area consists of:</td>
</tr>
<tr>
<td></td>
<td>• Oracle Fusion Demand Management</td>
</tr>
<tr>
<td></td>
<td>• Oracle Fusion Supply Planning</td>
</tr>
<tr>
<td>Planning Central</td>
<td>Oracle Fusion Planning Central</td>
</tr>
<tr>
<td>Sales and Operations Planning</td>
<td>Oracle Fusion Sales and Operations Planning</td>
</tr>
<tr>
<td>Backlog Management</td>
<td>Oracle Fusion Backlog Management</td>
</tr>
</tbody>
</table>
Overview of the Replenishment Planning Work Area

You use the Replenishment Planning work area to create, configure, and view your replenishment plans and analyze your real-world business processes.

Using the Replenishment Planning work area, you can:

- Create and configure replenishment plans.
- View replenishment plans and plan inputs.
- Use predefined or user-defined page layouts to view plan data that's tailored to your business.

To go to the Replenishment Planning work area and open a plan:

1. Open the work area by doing one of the following:
   - In the Navigator, go to the Supply Chain Planning group, and click **Replenishment Planning**.
   - On the home page, click the Supply Chain Planning springboard, and click the icon for Replenishment Planning.
2. To open a replenishment plan, use one of these methods:

<table>
<thead>
<tr>
<th>Method</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Through the <strong>Plans</strong> drawer</td>
<td>a. Click the Plans panel tab.</td>
</tr>
<tr>
<td></td>
<td>b. Expand Plans.</td>
</tr>
<tr>
<td></td>
<td>c. Right-click a replenishment plan, and select <strong>Open</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Only those replenishment plans that have been successfully run are shown in the Plans panel tab.</td>
</tr>
<tr>
<td>Through the Manage Plans page</td>
<td>a. Click the Tasks panel tab.</td>
</tr>
</tbody>
</table>
Your replenishment plan opens by default in the Edit Plan page, which consists of a header and configurable pane.

**Header**
The header contains the **Page Layout** list and drop-down buttons such as **Open**, **Actions**, and **Save**.

**Configurable Pane**
You can display the contents of your replenishment plan in the configurable pane. The number of panes displayed depends on the page layout that you're using. Using the **Change** drop-down button in the header, you can configure the number of displayed panes.

**Work with Page Layouts in Replenishment Planning**
In the Replenishment Planning work area, you can create and edit page layouts.

**Create a Page Layout**
To create a page layout:

1. In the Replenishment Planning work area, open the replenishment plan for which you want to create a page layout.
   
   The replenishment plan opens in the Edit Page.
2. In the header, select **Page Layout > Create**.
   
   The Create Page Layout dialog box opens.
3. Specify the following details:
   
   - Enter the page layout name and description.
   - Select **Public** to make the page layout accessible to all users, or select **Private** to restrict the page layout to yourself.
   - In the **Enable in Work Area** list, ensure that **Replenishment Planning** is selected.
4. Click **Save and Close**.
   
   The page layout is created with an empty pane.
5. Click the **Change** drop-down button to select a pane layout (for example, Two Pane, Horizontal Split) for your page layout.
6. To add content to a pane, click the **Open** drop-down button, and select the pane.
   
   The Open Table, Graph, or Tile Set dialog box opens.
7. Select a table, graph, or tile set from the displayed list, and click **OK**.
8. Add content to the other panes of the page layout.
9. Click the Save Layout drop-down button.

Edit a Page Layout

You can edit a user-defined page layout using the Save Layout drop-down button in the header or the Manage Page Layouts dialog box that’s opened from the Page Layout list. You can’t save your changes to a predefined page layout or a page layout that belongs to another user. If you modify a predefined page layout or a page layout that belongs to another user, you can save it as a new, user-defined page layout that belongs to you.

After making changes to the page layout, click the Save Layout drop-down button to save your changes. To save your changes to a new page layout, click Save Layout > Save As. The Save Layout As dialog box opens, and you can specify the name, description, access, and work area for the new page layout.

In the Manage Page Layouts dialog box, you can:

- Change the name, description, work area, and access for the page layout.
- Duplicate or delete the page layout.
- Make the page layout your default page layout.
- Add tables, graphs, or tile sets to the page layout panes.
- Remove tables, graphs, or tile sets from the page layout panes.
- Move tables, graphs, or tile sets among the page layout panes.

Note: You can’t delete the page layout if it’s presently being used by the displayed replenishment plan.

Predefined Page Layouts for Replenishment Planning

The Replenishment Planning work area has the following predefined page layouts:

- Demand and Replenishment Plan Summary: This page layout provides infotiles for policy execution, policy effectiveness, segment analysis, total inventory value, and shipment forecast MAPE. By clicking the bar at the bottom of each infotile, you can drill down to the predefined graphs. Use this page layout for integrated replenishment plans for which you select the Generate forecast, Calculate policy parameters, and Calculate replenishments check boxes on the Plan Options page.
- Replenishment Plan Summary: This page layout provides infotiles for policy execution, policy effectiveness, segment analysis, and total inventory value. By clicking the bar at the bottom of each infotile, you can drill down to the predefined graphs. Use this page layout for replenishment plans for which you select the Calculate policy parameters and Calculate replenishments check boxes on the Plan Options page.
- Replenishment Workbench: This two-pane page layout has the Replenishment Workbench table and an inventory sawtooth graph. Use this page layout when you want to simultaneously use a table and graph for analyzing replenishment planning results.

Overview of Supply Chain Planning Plan Types

When you create a plan in Oracle Fusion Supply Chain Planning, the plan type is the first choice that you make. After you run a plan, you can’t edit the plan type.
Supply Chain Planning provides these types of plans, which you can create, edit, run, and so on, depending on the work area that you have access to:

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Use This Plan Type</th>
<th>Work Areas the Plan Type is Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlog Plan</td>
<td>For backlog management</td>
<td>Backlog Management</td>
</tr>
<tr>
<td>Demand Plan</td>
<td>• When you want to perform collaborative and statistical demand forecasting.</td>
<td>Demand and Supply Planning</td>
</tr>
<tr>
<td></td>
<td>• When you want to use a demand plan as a demand schedule for a supply plan or replenishment plan.</td>
<td>Demand Management Planning Central Replenishment Planning</td>
</tr>
<tr>
<td>Supply Plan</td>
<td>When you want to generate a supply schedule.</td>
<td>Demand and Supply Planning</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Planning Central</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Supply Planning</td>
</tr>
<tr>
<td>Demand and Supply Plan</td>
<td>For integrated demand and supply planning.</td>
<td>Demand and Supply Planning</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Planning Central</td>
</tr>
<tr>
<td>Sales and Operations Plan</td>
<td>For aggregate planning.</td>
<td>Sales and Operations Planning</td>
</tr>
<tr>
<td>Replenishment Plan</td>
<td>For replenishment planning.</td>
<td>Replenishment Planning</td>
</tr>
</tbody>
</table>

How You Define Planners for Supply Chain Planning

Planners are the people in your organization who are responsible for a set of items, their inventory levels, supply and demand, and so forth. For example, some typical titles of planners are Material Planner, Supply Chain Planner, and Demand Planner. All supply chain planning products use planners. You can define a specific person as a supply chain planner for the Oracle Fusion source system or for any other source system. You can also associate a planner to an item at the organization level.

Use the ScpPlannersImportTemplate.xlsm import template to create the CSV file for the Load Planning Data from Files task for planners. You can also use the Manage Planners page to define supply chain planners for each source system. Access the Manage Planners page from a Supply Chain Planning work area. Click the Tasks panel drawer and then click the Manage Planners link.

For Oracle Fusion source systems, associate the employee identification number with the planner name because Oracle Fusion Purchasing requires a valid employee identification number. When a planner releases a planned order, purchasing checks the employee identification number before creating the purchase requisition.
For external source systems, determine if the employee identification number is required when releasing planned orders. If required, use the Manage Planners page to associate the planner with their employee identification number. Or, you can use the ScpPlannersImportTemplate.xlsm template to associate the employee identification number with the planner name.

Use Oracle Fusion Product Hub to assign planners at the item-organization level. During data collections, the planning processes collect the planner-item-organization assignment. Planners can then use the planner name to search the data on most of the demand and supply planning pages.

Assign Time Zones to Locations in Supply Chain Planning

You can view supplies and demands in your Supply Chain Planning work area based on the time zone of the organization, customer site, or supplier site. In addition, you can calculate precise in-transit time because supply chain planning considers the time zone difference between the source and destination locations.

The following points discuss in detail how you can collect time zone details and view orders depending on the locations' time zone:

- Update Time Zones Using Data Collections
- Assign Time Zones in Supply Network Model
- Calculate In-Transit Time
- View Time Zones in Supplies and Demands
- Release to Execution

Update Time Zones Using Data Collections

Use data collections to update organizations, customer site, or supplier site time zones. You can update the time zone in one of following three ways:

- Collect the organization's time zone from an Oracle Fusion source system.
- Collect time zones from an external source system using the organization, customer, and supplier import templates.
- Update the time zone on Customers and Suppliers tabs of the Maintain Supply Network Model page.

If you are collecting from an Oracle Fusion source system, then you can update the organization's time zone using the data collections method only. You cannot manually update the organization's time zone using the Maintain Supply Network Model page in your Supply Chain Planning work area.

Assign Time Zones in Supply Network Model

Before collecting time zones or converting time zones to a local time, you must first assign time zones to organizations, customer sites, and supplier sites. A new time zone field is available on the Organizations, Customers, and Suppliers tab of the Maintain Supply Network Model page in your Supply Chain Planning work area.
You cannot collect customer site and supplier site time zones from an Oracle Fusion source system. To update the
customer site or supplier site time zone, use one of the following options:

- Use the customer or supplier import template to update the customer site or supplier site time zone. You can
also use this template if you are collecting from an external source system.
- Update the customer site and supplier site time zones directly in the Maintain Supply Network Model page.

When you recollect new customer and supplier data from an Oracle Fusion source system, the existing customer site
and supplier site time zone information is preserved. If you do not collect or update the customer site or supplier site
time zone, then planning calculations assume that the customer site or supplier site is located in the same time zone as
the organization that is associated with the demand or supply.

When you collect the supplies and demands, collections automatically convert the associated dates from the database
server time zone (Coordinated Universal Time or UTC) to the local time zone based on where the event takes place. In
addition, when you collect shipments and booking history from the Oracle Fusion source system for use in the Demand
Management or the Demand and Supply Planning work area, collections converts the historical data from the database
server time zone (UTC) to the associated organization’s time zone.

Calculate In-Transit Time

When calculating in-transit times, supply chain planning considers the time zone difference between the shipping
and receiving locations. The following example shows how supply chain planning calculates the in-transit time. In this
example, the customer site is located in Sydney (UTC+10) and the shipping organization is in Sacramento, California
(UTC-8).

1. When planning collects a sales order with a requested arrival date of 25-March-2018, 21:00 (UTC) on the
database server, the requested arrival date is offset to the customer site’s time zone. The customer site’s time
zone is Sydney time zone (UTC+10 hours). The requested arrival date becomes 26-March-2018, 7:00 in plan
inputs (Sydney time zone).
2. When you run the plan with the Refresh with current data option, the sales order is included in the plan and
supply chain planning uses this date to calculate the scheduled ship date.
3. Consider the in-transit time for the selected shipping method (Air Freight) is 36 hours. Supply chain planning
first calculates the scheduled ship date as 25-March-2018, 19:00 hours (Sydney time) and then converts the
date to the Sacramento time. The product is shipped from Sacramento. The time zone difference is applied
to the scheduled ship date by subtracting 18 hours. The scheduled ship date becomes 25-March-2018, 1:00
Sacramento time, which is used to generate the pegged supplies.
4. After completing the calculations, supply chain planning moves all the dates to the end of the day. All dates
have the time stamp of 23:59:00. The time stamp is not available on the UI, but you can query the time stamp
from the planning database.

Supply chain planning makes similar in-transit calculations when shipping supplies from a supplier site to an
organization, or when transferring product from one organization to another.

View Time Zones in Supplies and Demands

On the Supplies and Demands page, use the following three columns to view supplies and demands in relation to the
time zone:

- Organization Time Zone
- Source Time Zone
- Destination Time Zone
The columns are not included in any predefined table layout. Create a user-defined table layout and include these columns in your table.

To display supply and demand measure values within a table such as Material Plan or Build Plan, supply chain planning assigns the measure value to the day based on the organization's local time zone. The supply and demand measure value is not assigned to a date based on a common time zone.

**Release to Execution**

When you release orders that are marked for release to Oracle Cloud execution system, the release action offsets the date from the location's time zone to the database server time zone (UTC).

For example, when you release a planned make order, supply chain planning converts the need-by date from the organization's time zone to UTC.
2 Tables, Graphs, Analysis Sets, Infotiles, and Tile Sets

How You Manage Tables, Graphs, Analysis Sets, Infotiles, and Tile Sets

You can configure the entities for tables, graphs, analysis sets, infotiles, or tile sets by using a selector tool. You can also create and manage groups on the Selector Tool page, and associate your tables and graphs with the group. To access the Selector Tool from your plan, click Actions and select Manage Tables, Graphs, and Analysis Sets. You can also navigate to the Selector Tool from the Actions menu on the table and graph toolbar.

Note: In the Selector Tool, the member values displayed are based on what's configured in the Member Identifier to Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can configure your tables and graphs to show item description instead of item name, which is what also appears when you're in the Selector Tool.

The selector tool has the following tabs:

- Measures
- Hierarchies
- Members
- Layout
- Comparison Options

Following are the details of each tab:

- Measures: Use the Measures tab to select measures for a table or graph by moving measures from the Available Measures pane to the Selected Measures pane. The measures that you select determine the content of the other tabs. The dimensions of the measures determine the dimensions available on the Hierarchies tab and the dimension members on the Members tab. For example, if a measure is the dimension created for Product, Organization, and Time, those dimensions and their hierarchies are visible on the other tabs. You can display the available measures by Measure Group or alphabetically by using the List View or Tree View icon. A measure is usually a named time series of values that represent the following at a particular intersection of customer, organization, product, supplier, and resource dimensions:
  - Historical performance (Bookings History). This measure isn’t applicable for supply planning.
  - Future projections (Shipments Forecast)
  - A key performance indicator (Gross Margin Percentage) or a derived calculation (Projected Available Balance)

The planning process aggregates measure data from lower levels to higher levels or compute KPIs and derived calculations from other values at the same level as needed. The planning process can also allocate or spread updates made at an aggregate level to the affected cells at lower levels. Measures can be expressed in different units of measure, such as inches, dollars, kilos, or liters. Depending on the context, you can display, update, or compare measures that are in different units. The planning process can convert among different units and among different currencies (for monetary values).
• Hierarchies: Use the Hierarchies tab to select the dimensions, hierarchies, and levels to include or exclude in the table or graph. For each dimension, select the hierarchies and levels that you want to include in the graph or table. Checking the box in the Display column includes that dimension in the table or graph. Expand the dimension to view the available hierarchies. Expand the hierarchy to view the levels of the hierarchy. Checking a level includes it in the table or graph. If multiple levels are checked, the top level is displayed in the table or graph by default. Each level in the table or graph can be expanded until all checked levels are visible. The **Show Unassociated** check box determines whether the measure values that aren’t associated with a specific dimension in the table or graph are hidden or displayed. For example, a table could include Shipments Forecast and Net Resource Availability. Shipments Forecast has product, organization, and time as dimensions. Net Resource Availability has resource, organization, and time as dimensions. With Show Unassociated, checked, the Resource column displays the word Unassociated when viewing Shipments Forecast rows.

• Members: You use the **Members** tab to manually select dimension members by moving members from the **Available** pane to the **Selected** pane. If no selections are made on this tab for a dimension, the graph or table displays the dimension starting at the top level checked on the Hierarchies tab. For example, if you selected the Gregorian Calendar hierarchy with Quarter and Month on the Hierarchies tab, the graph or table displays all quarters; each quarter has an icon to drill to its months.

• Layout: You use the Layout tab to format the table or graph.

• Comparison Options: The Comparison Options tab is applicable only for tables and graphs. On the Comparison Options tab, you can compare your current plan with an archived version or an alternate plan. Use this tab to compare how specific measures have varied over time. The Comparison Options tab contains three sections: Waterfall Analysis, Trend Analysis, and Plan Comparison.

   **Note:** The Comparison Options tab isn’t available for Oracle Planning Central Cloud.

   o In the **Waterfall Analysis** section, you can compare selected measures in a table or a graph with an archived plan.

   Select the **Use MAPE calculations** check box if you have scheduled your plan archival process. MAPE calculations use the system administrator archive and not an on-demand archive.

   In the **Measure Archives to Use** drop-down list, select one or more archives to reference. The number of weeks refers to how long the archive was created. The planning process uses the following logic for when to use an archive:

   • Match the exact dates. If multiple versions of an archive are within the waterfall time frame, use the closest, most current version.
   • If not match is found on the exact date, use the closest inside the range, which is +3/-3 days of a selected weekly waterfall time frame, or +15/-15 days for a monthly archive.
   • If no match is found within the +3/-3 days of a selected weekly waterfall time frame, or +15/-15 days for a monthly archive, then nothing is returned.

   For example, if you select 4 weeks ago, the planning process searches for the archive 4 weeks prior to today’s date, for instance, March 6. If your archives are stored at the month level and nothing is found on February 5, the planning process searches for the most recent archive within +15/-15 days.

   o In the **Trend Analysis** section, you can provide the number of archives that you want to reference. The planning process selects the latest archives. For example, you have five archives, where number five is the latest archive and you have specified the **Number of Previous Versions to Include** as 3. The planning process will select archive number five, four, and three for the comparison. The difference between Waterfall Analysis and Trend Analysis is that in Waterfall Analysis you can choose an archive created within each selected time frame that you want to compare. In Trend Analysis, you can select the number of archives that you want to compare, and only the latest archives are used for comparison.
The Plan Comparison section pertains to both archived plans and alternate plans that you consider for comparison. You can select the type of difference to display in tables or graphs for comparison. For example, you can choose to view the difference in percentage or absolute percentage.

Using Advanced Options in the Selector Tool
You can use the Advanced Filter criteria tools to filter data and select specific members that fulfill some criteria. Click the funnel icon in the Members tab to Access the Advanced Filter options. You can use the following filter criteria tools for predefined measures:

- **Levels**: Select by level. Select the members in a level such as Customer Site for the Customer dimension, or Period for the Time dimension.
- **Family**: Select parent or child of a dimension member. Select members based on a parent or child relationship, such as selecting the Days in a Week.
- **Attributes**: Select based on name. For example, select members based on items whose name contains Economy.
- **Measure Criteria**: Select based on meeting measure criteria. Select members that meet the criteria, such as Products for which the Gross Margin is greater than a particular value.
- **Time Range**: Select a range of dates. Select time periods based on a range, start date, or today's date.

The advanced filter criteria tools are used in conjunction with action keywords to refine selections. The following four actions determine how to apply the criteria:

- **Replace with**: Replace the current selection, if any, with members meeting criteria.
- **Add**: Add members meeting the criteria to the current selection.
- **Keep**: Keep only the members in the current selection that meet the criteria.
- **Remove**: Remove the members from the current selection that meet the criteria.

You can apply filter criteria tools sequentially to refine your selection. For example, select all the items for a category, and then keep the top 10 items based on sales.

Click the **Show Results** button to see the filtered list of members based on the criteria. Removed members are shown below the filtered list. You have the option of accepting the results or resetting to the previous members.

When you accept the results, the criteria used to retrieve the accepted members appear in the **Criteria Steps** area of the tab. These criteria are evaluated when the table or graph is displayed. You can remove criteria steps.

- To remove a step, click the X button in a row.
- To view the result of removing a criteria, click **Show Criteria Change**.
- To accept the Show Criteria Change results, click **Accept** and then **OK**.
- To make the change permanent, click **Save** or **Save and Close**.
- To view the results without making the change permanent, click **Apply** and **Close**.

Creating Analysis Sets
An Analysis Set is a named set of criteria that can contain selected measures, dimension members, or both measures and dimension members. Use the Apply Analysis Set and Save as Analysis Set actions to apply previously made selections, or save the selections made in the Selector Tool.

Applying an existing Analysis Set to a table or graph is a quick way to select the measures and dimensions members that are frequently used.
You have the option of saving measures and dimension members. You can save the dimension members as a list, or as a script. For example, you can select the top 10 items based on sales for a January. If saved as a list, the same 10 items would always be displayed in the table or graph regardless of the current month. However, as sales data changes over time, you would want the top items in the current month to be displayed. To accomplish this, save the dimension members in a script that would evaluate the criteria whenever the table or graph is displayed.

**Using the Table Drilling**

After a table is created, you use drilling in the table to expand and collapse the levels within the hierarchy by which you can view different levels of aggregation. When viewing a table or graph, the dimensions and hierarchies selected in the Hierarchies tab are visible. The top selected level is visible; use drilling to view lower levels.

To drill across hierarchies or dimensions, the levels must be adjacent. Drilling is automatically available for the levels within the predefined hierarchies, but you can also configure drill pairs to drill across hierarchies or dimensions.

To display a table showing Final Shipments History with the ability to drill from customer to item, the columns customer and item must be adjacent:

1. In the Layout tab, use the View menu to select **Configure Drill Settings**.
2. Configure Drill Settings to view the existing drill pairs.
3. Click the + icon to add a new drill pair.
4. In the Drill From column select Customer and in the Drill To column select Item.

With this configuration, you can view the Shipments History values by item for each customer in the table.

---

**Note:** Drilling is only active between the adjacent levels on the table.

---

**Using the Table Linking**

You can link a table or graph to another table or graph passing the context of one to another by selecting **Manage Links** from the Actions menu on the toolbar.

There are two tabs:

- **To Table or Graph:** Use this tab to create a link to another table or graph.
- **From Table or Graph:** Use this tab to link to the open table or graph from another table or graph.

Use the + icon to select the table or graph to link to or link from.

- **Enable Dynamic Linking:** This check box determines whether or not Dynamic Linking is enabled. If it’s enabled, then the target table or graph has the ability to be refreshed whenever the selections on the source table change.
- **Pass Highlighted Selections and Selected Members:** If this button is selected, then whatever is highlighted in the current table along with the filters in the Selector can be passed as context to the Drill To Table or Graph.

After you define the link, use the Drill icon on the toolbar to drill to the linked table or graph.

**Related Topics**

- How You Use Levels and Attributes in Supply Chain Planning
Create an Infotile in Supply Chain Planning

An infotile is a tile shaped component used to present a graphical summary of the data. Each infotile has one or more related tables or graphs with predefined drill-to actions to display additional information about that key performance indicator (KPI).

To create an infotile:

1. In the **Navigator**, click a Supply Chain Planning work area.
2. Open a plan and then click **Actions > Manage Tables, Graphs, and Analysis Sets**.
3. In the Manage Tables, Graphs, and Analysis Sets dialog box, in the Search Results region, click **Actions** and then select **Create > Tile**.
4. In the Selector Tool - Create Tile dialog box, on the Measures tab, select the required measures and move them from the Available Measures pane to the Selected Measures pane.
5. On the Hierarchies tab, select the dimensions, hierarchies, and levels to include or exclude in the infotile.
6. On the Members tab, select the required dimension members and move them from the Available Members pane to the Selected Members pane. If you do not select a dimension member, the infotile displays the dimension starting at the top level selected in the Hierarchies tab.
7. On the Layout tab, do the following:
   - Select the graph type for the infotile.
   - Expand the **Content Area** panel, and then click the **Add Row** button. You can add up to four tables or graphs to display them in the content area for that infotile.
8. Click **Save and Close**.

Create a Tile Set in Supply Chain Planning

You can create a tile set to group individual infotiles. Creating tile sets can be useful in cases where you want to track various metrics on a single page. You can add tile sets to a pane in a page layout.

**Tip:** Before you create a tile set, check whether you need to create the infotiles that you will be adding to the tile set.

To create a tile set:

1. In the **Navigator**, click a Supply Chain Planning work area.
2. Click **Actions > Manage Table, Graphs, and Analysis Sets**.
3. On the Search table toolbar, from the **Actions** menu, select **Create > Tile Set**.
4. In the Selector Tool - Create Tile Set dialog box, specify the following details:
   - Enter name and description for the tile set.
   - Select a group for the tile set.
5. From the Available Tiles pane, select the infotiles to include in the tile set and move them to the Selected Tiles pane.
6. Click **Save and Close**.
Set Measure Targets for Use in Infotiles

You can enter or update goals for a measure to track performance against the goals. Set targets by editing a measure and updating the measure goal. When the plan summary displays the measure, the goal or target for that measure is visible. You can define goals only for measures that are of data type currency, number, or percent.

For global goals, you can provide a low range or a high range. The ranges are displayed on the user interface when you view a measure in comparison with its goal. Global goals are measure level parameters and are not defined specifically for a data population.

To enter or update measure target goals, follow these steps:

1. Open the Manage Planning Measures page:
   a. In the Navigator, click a Supply Chain Planning work area link.
   b. On the Edit Plan page, click the Tasks panel tab.
   c. In the Tasks panel drawer, click the Manage Planning Measures link.
2. On the Manage Planning Measures page, select the measure and click the Edit icon.
3. On the Edit Measure page, navigate to the Advanced tab, Goals subtab.
4. In the Goals subtab, select whether low values or high values are better.
   For example, high values are better for Gross Margin, but low values are better for Demand at Risk.
5. In the Global Goals section, provide a low range or a high range.
6. Click Save and Close.

Graph Layout Options

The graph layout option is available in the Layout tab when you create or edit a graph using the Manage Tables, Graphs, and Analysis Sets option. In the graph layout options, you can define the type of graph and configure layouts and the dimension of axes. The layout options vary according to the type of graph. For example, a bar graph has X and Y-axis layout options whereas a Pie chart does not have any X or Y axis. General Options is common for all layout options and includes generic information for a graph such as title, font, and position of the graph. You can also preview a graph from the Layout tab before you save the graph. In the preview mode, you can format measures, change the layout, and modify the drill settings.

The following types of graphs are available:

- X and Y axes graphs
  - Vertical bar
  - Horizontal bar
  - Line graph
- X and Y axes graphs with additional parameters
  - Area graph
  - Combination graph
Tables, Graphs, Analysis Sets, Infotiles, and Tile Sets

- Bubble graph
  - Pie graph
  - Sunburst graph and Treemap graph
  - Funnel graph and Radar graph
  - Gauge graph

For graphs with an X, Y, or dual Y axes, you can select up to three entities in total: measures are mandatory, and you can select one or two dimension hierarchies. A dual Y-axis graph requires the measures on the Y axis. You must select one measure for the Y2 axis in the Y2-Axis panel. Axis title and tick label rotation options are available for all axes. Tick label options are also available for the X-axis. For example, skip a certain number of labels for legibility. The Formatting panel contains visual effect options for the graph, such as 2 dimension or 3 dimension, and bar or line style.

A Combination graph includes an area, bar, and line. The measures represented by each of these options are specified in the Formatting panel.

A Bubble graph requires selections for the bubble component of the graph in addition to the X and Y axes options. Select the hierarchy and the bubble sizing measure in the Bubble panel.

A Sunburst graph is comprised of rings. Select the number of rings to display. Each ring represents a level of the hierarchy. The rings are divided into sectors for each member of the level. The size and color of the sector is determined by the measures selected for those options.

A Treemap graph is comprised of rectangles. Select the depth of the rectangles for a hierarchy. The rectangles for a level of the hierarchy are nested within the parent level rectangle. The size and color of the rectangles are determined by the measures selected for those options.

Funnel and Radar graphs require only a hierarchy and measure selection.

Gauge graphs, which are used in infotiles, require measures with goals defined.

Why can't I edit the graph layout options?

If you have created the graph or table, only then you can edit the layout options. Also, you cannot edit any layout options for predefined graphs or tables.

Axis Scale Options

Using Axis Scale Options, you can define the minimum and maximum scale values on the Y-axis, and the incremental values between them. You can define the axis scales using the following options: Minimum, Maximum, and Increment. Minimum indicates the starting point of the axis and Maximum indicates the ending point of the axis. Increment indicates the increase in values that are displayed between maximum and minimum data points. Axis Scale Options is available only for Bar, Line, Area, or Combination graphs and it is applicable for Y-axis and Y2-axis.

For each field, you can define either automatic or user-defined values. If you select Automatic, the planning process automatically adjusts the axis scale for Y-axis and Y2-axis data points. If you select Manual, you have to manually specify the scale for Y-axis and Y2-axis. For example, if you provide Minimum as 3, Maximum as 10, and Increment as 2,
then for Y-axis or Y2-axis the graph displays 3 as the lowest value and 10 as the highest value. The graph also displays data points 5, 7, and 9 as incremental values.

Manage Measure Data in Tables

How You Can Edit Measure Data

While working in one of the Supply Chain Planning work areas, you might be editing measure data in a table. The following table provides a list of some features you can use when doing so, and where each feature is located:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Summaries</td>
<td>View menu</td>
</tr>
<tr>
<td>Data Calculation Options</td>
<td>Table toolbar</td>
</tr>
<tr>
<td>Lock and Unlock Cells</td>
<td>If at least one summary is configured:</td>
</tr>
<tr>
<td></td>
<td>Action menu, table toolbar, right-click in cell</td>
</tr>
</tbody>
</table>

Copy and Paste Values in Tables

Use the Copy and Paste options in the Actions menu for a table to copy cell values and paste them in editable cells. You can also copy values from one table to another within the same plan. Pasting overwrites any existing values, and any measures that are dependent on the overwritten measures are recalculated.

If your data is in an external application such as Microsoft Excel, you can use the following procedure to copy and paste your data:

1. Copy your data from the external application.
2. In your work area table, click the first editable cell from which you want the data to be pasted, and select Actions > Paste from Clipboard. The Paste from Clipboard dialog box opens.
3. Press Ctrl+V to paste your content in the dialog box. You can further edit your data in the dialog box.
4. Click Paste and Close. The copied content is pasted into the editable cells of the table.

Alternatively, you can export your table data to Microsoft Excel using the Export icon, work with your data in that application, copy your data, and bring it back into your table by using the Paste from Clipboard option. To copy data between plans, export the table data to Microsoft Excel from one plan, and use the Paste from Clipboard option to copy data into the other plan.

Note: You can paste values in only those cells that fall within your plan horizon. The number and orientation of the cells from which data is copied and the cells into which data is pasted must match. Only numeric data can be copied and pasted. Non-editable cells that are within a range of editable cells are skipped when data is pasted, and a warning is displayed to this effect.
Manage Data Calculations When Editing Measure Data in a Supply Chain Planning Table

When you are working in a Supply Chain Planning work area, you might be editing measure data in tables that include dependent measures. You can use the Data Calculation Options choices to determine when calculations are performed. You access **Data Calculation Options** from the table toolbar for the table you are editing.

The Data Calculation Options choices are:

- Enable Automatic Calculations
- Calculate Now

**Enable Automatic Calculations**

When you edit data with this option selected, each time you edit a value, calculations are performed for any applicable summaries or other measures that include an expression. The Enable Automatic Calculations choice is the default selection.

**Calculate Now**

To choose when calculations are performed, you must first deselect Enable Automatic Calculations. When you make edits with the Enable Automatic Calculations choice deselected, you must click the Calculate Now choice when you want calculations to be performed. Calculations will be performed for all edits made since the last time calculations were performed.

If you save a table after making edits, any needed calculations will be performed, but you must refresh the table to see the results.

How You Lock Cells While Editing Measure Data or Allocating Values in a Table

When you are working in a Supply Chain Planning work area, you might be editing measure data in a table. When you have locked cells, edits, including those that spread allocations to other cells, do not change locked cells.

**Note:** You must configure at least one summary to enable the **Lock** and **Unlock** actions.

Lock cells by performing one of the following:

- Click the Lock action in the Actions menu.
- Click the Lock icon on the table toolbar.
- Right-click in an editable cell.

**Related Topics**

- How do I enable the Lock and Unlock actions for a table while editing measure data in a Supply Chain Planning table
- Can I unlock all cells at once while editing measure data in a Supply Chain Planning table
How can I highlight editable cells in a table?

In the View menu for a table, select **Highlight Editable Cells** to provide a background color for cells that contain editable measures. Do note that any conditional formatting that has been applied to an editable measure or a table takes precedence over the highlight color. You can choose to save your page layout with this setting.
3 Planning Analytics

Overview of Planning Analytics

Configuring planning dimensions and hierarchies on the Configure Planning Analytics page is a key setup to use the analytics in Supply Chain Planning work areas. It has a unified dimensional hierarchy for various uses. Depending on your security privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work area by selecting the following:

- **Offering**: Supply Chain Planning
- **Functional Area**: Supply Chain Planning Configuration
- **Task**: Configure Planning Analytics

To run plans successfully, you must complete the following Configure Planning Analytics tasks:

- Set Up Dimension Catalogs
- Set Up Measure Catalogs
- Set Up Levels and Attributes

You can use the default hierarchies for most of the dimensions.

If the default product catalog named Product is not collected, then you must select at least one product hierarchy. If a default product catalog is collected, then the predefined Product hierarchy is selected as a product hierarchy by default. You can optionally add or change the product hierarchy. You must include at least one product hierarchy when creating a dimension catalog.

On the Configure Planning Analytics page, Levels and Attributes tab, you can configure your planning table and graphs to display descriptions instead of codes for the following entities: Items, Organizations, Resource, Work Center, and Work Area.

Configure Planning Analytics

To run plans successfully, you must set up dimensions and dimension catalogs, measure catalogs, and levels and attributes. You can open the Configure Planning Analytics task from one of the Supply Chain Planning work areas. Depending on your security privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work area.

---

**Note:** Default Catalog is the name of the predefined dimension catalog. It contains predefined hierarchies. Oracle recommends that you make a copy of the Default Catalog if changes are required, instead of editing the default catalog.
To configure planning analytics:

1. In the Navigator, click one of the Supply Chain Planning work areas or click the Setup and Maintenance work area.
   - If you clicked one of the Supply Chain Planning work areas, do the following:
     - Click the Tasks panel tab.
     - In the Tasks panel drawer, click the **Configure Planning Analytics** link.
   - If you clicked the Setup and Maintenance work area, select the following:
     - **Offering**: Supply Chain Planning
     - **Functional Area**: Supply Chain Planning Configuration
     - **Task**: Configure Planning Analytics

2. On the Configure Planning Analytics page, Dimension Catalogs tab, do the following:
   - Create a dimension catalog using the **Add Row** button, or duplicate the default dimension catalog using the **Duplicate** button.
   - Specify what hierarchies to use in the dimension catalog by moving hierarchies from the Available pane to the Selected pane.
   - Assign the dimension catalog to a plan that will use the set of hierarchies for analysis during the plan creation from Manage Plans.

3. Each Supply Chain Planning work area has a default measure catalog. Create a new measure catalog to add or remove measures.
   - Use the **Add Row** button to create a new catalog or use the **Duplicate** button to duplicate an existing catalog.
   - Specify the measures for the catalog by moving the measures from the Available pane to the Selected pane.
   - Assign the measure catalog to a plan that will use the set of measures during the plan creation from Manage Plans.

   After you create and define a measure catalog, you can select the measure catalog for a plan from the Edit Plan Options page.

4. Click the Levels and Attributes tab and select the desired dimension and hierarchy.
   - In the **Dimension** list, select a dimension.
   - Optionally, in the **Hierarchy** list, select a hierarchy.
   - Click the **Search** icon button.
   - To change how the level name appears in pivot tables and graphs, select the row and enter the level name in the **Level Name to Display** field.

     **Note:** You can't edit the Level Name to Display field for the lowest level of the hierarchy.

   - To display a particular member identifier in your tables and graphs, select a dimension (Product, Organization, or Resource) and level, and then select a value in the **Member Identifier to Display** column:
<table>
<thead>
<tr>
<th>Dimension</th>
<th>Level</th>
<th>Member Identifier to Display Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Item</td>
<td>Item Name, Item Description, Item Name and Description, or Item Description and Name</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization</td>
<td>Organization Name or Organization Code</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource</td>
<td>Resource Code, Resource Name, or Resource Description</td>
</tr>
<tr>
<td>Resource</td>
<td>Work Center</td>
<td>Work Center Code, Work Center Name, or Work Center Description</td>
</tr>
<tr>
<td>Resource</td>
<td>Work Area</td>
<td>Work Area Code, Work Area Name, or Work Area Description</td>
</tr>
<tr>
<td>Resource</td>
<td>Organization</td>
<td>Organization Name or Organization Code</td>
</tr>
</tbody>
</table>

**Tip:** The organization level in the Organization dimension and the organization level in the Resource dimension are separate settings. Oracle recommends that you set them to use the same identifier.

f. To add an attribute for the lowest level of the hierarchy, click the **Edit Page** button in the Attributes column.

   i. In the Manage Attribute List dialog box, click the **Add Row** button.
   
   ii. In the Attribute list, select an attribute.
   
   iii. In the Attribute Label text box, enter a label name and click **OK**.

5. On the Configure Analytics page, click the **Save and Close** button.

**Related Topics**
- How You Use Measure Catalogs in Supply Chain Planning

**Dimensions and Dimension Catalogs**
How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

Oracle Fusion Supply Chain Planning has hierarchy levels by which you can view, compare, and analyze demands and supplies of your products over various dimensions, such as geography and organizations. Supply Chain Planning uses a single set of dimensions and hierarchies to drive aggregation context for demand planning, supply planning, embedded analytics, and management analytics.

Supply Chain Planning provides predefined planning dimensions. Each of those dimensions has a predefined hierarchy. When you implement the Supply Chain Planning offering, you must decide which dimensions and hierarchies to use for demand and supply analysis.

Each dimension catalog has a collection of hierarchies in different dimensions that is enabled for use in the plan options. By default, all predefined hierarchies are available in Planning Analytics. You can disable certain dimensions that are not relevant for your plans. For example:

- If you are only using demand plans, then supplier, resource, and order type dimensions may not be relevant
- If you are using sales and operations plans, then the order type dimension is not relevant

The following hierarchies are predefined in Supply Chain Planning:

- Customer
- Demand Class
- Exception Type
- Order Type
- Organization
- Plan
- Product
- Resource
- Supplier
- Source
- Time

Access the Configure Planning Analytics page from a Supply Chain Planning work area. Depending on your security privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work area.

- To access the Configure Planning Analytics page from a Supply Chain Planning work area:
  a. Click the Tasks panel tab.
  b. In the Tasks panel drawer, click the Configure Planning Analytics link
- To access the Configure Planning Analytics page from the Setup and Maintenance work area, select the following:
  o **Offering:** Supply Chain Planning
  o **Functional Area:** Supply Chain Planning Configuration
  o **Task:** Configure Planning Analytics
In the Dimension Catalogs tab, several hierarchies are available in various dimensions. You can specify which hierarchy to use in a particular dimension catalog. For example, you can select an organization type hierarchy, a product type hierarchy, or a customer hierarchy to use in plans for analysis. After you define a dimension catalog, you can assign it to a plan that will use the set of hierarchies for analysis.

You can select one of your dimension catalogs to be used as the default dimension catalog in plans. If you do not select a default catalog, the predefined catalog named Default Catalog is used.

**Related Topics**

- Why You Disable or Enable Dimensions for Supply Plan Measures

**Considerations for Setting Up Dimension Catalogs**

Supply Chain Planning provides predefined planning dimensions and each of those dimensions have predefined hierarchies. The predefined hierarchies are included in the default dimension catalog and are available in all plans.

**Hierarchy Selections for the Product Dimension**

A predefined Product hierarchy is included in the default dimension. The default Product hierarchy has three fixed levels: Item, Category 1, and Category 2. Other Product hierarchies (other item catalogs in Oracle Fusion Product Model that are collected into Supply Chain Planning work areas) can be optionally enabled as user-defined product hierarchies.

For Oracle Fusion Sales and Operations Planning, the Lifecycle Phase attribute is also included in the default dimension.

By default, Oracle Fusion Product Model's planning functional area catalog is collected into the Product hierarchy. For the collection to run successfully, you must create the planning functional area catalog in Product Model with the following attributes:

- Controlled at = Master-Level (not Org-Level)
- Allow hierarchy of categories = No
- Default category must be selected
- Allow multiple item category assignments = Not selected
- Catalog Content = Items at Leaf Level

If this catalog is not set up with these attributes, the planning functional area catalog is not collected and the Product hierarchy will not be populated. This will result in the forecasting engine not being able to use the product aggregation and some of the predefined tables and graphs will not work correctly.

**Hierarchy Selections for the Organization Dimension**

Enterprise is the default organization hierarchy and has three fixed levels: Organization, Business Unit, and Legal Entity. This default organization is defined in Oracle Fusion HCM and you can only modify it there. Optionally, you can enable other Organization hierarchies (based on regions, one per country).

**Hierarchy Selections for the Customer Dimension**

The default Customer hierarchy has three fixed levels: Customer site, Customer, and Customer Class. This default customer hierarchy is defined in the trading community model and you can only modify it there.

**Hierarchy Selections for the Resource Dimension**

The default Resource hierarchy has four fixed levels: Resource, Work Center, Work Area, and Organization. This default resource hierarchy is defined in Oracle Fusion Manufacturing and you cannot modify it.
Hierarchy Selections for the Supplier dimension
The default Supplier hierarchy has two fixed levels: Supplier Site and Supplier.

Hierarchy Selections for the Exception Type, Order Type, and Source Dimensions
Predefined Exception Type, Order Type, and Source dimensions are included in the Default dimension catalog. Each has only a single hierarchy with a single level.

Hierarchy Selections for the Time Dimension
In the Time dimension, Gregorian calendar is the only predefined hierarchy. All other hierarchies can be optionally included as user-defined hierarchies. These include workday calendars of inventory organizations collected from Oracle Fusion Supply Chain Management and fiscal calendars from Oracle Fusion Financials.

Related Topics
- Why You Disable or Enable Dimensions for Supply Plan Measures

What's a dimension in Supply Chain Planning?
A dimension is a structure that organizes data. It categorizes data to enable you to answer business questions. Commonly used dimensions are customers, products, and time.

How can I use dimensions in Supply Chain Planning?
Supply Chain Planning applications come with predefined hierarchies in the Product dimension. These predefined hierarchies are part of the Dimension catalog structure in Oracle Fusion Product Model. Integrations with Oracle E-Business Suite and third-party systems where the product dimensions can still be maintained and uploaded for use by the Oracle Supply Chain Planning Cloud applications is supported.

What's a dimension catalog in Supply Chain Planning?
In Supply Chain Planning, a dimension catalog is a selected list of dimensions enabled for use in plans. In Supply Chain Planning, a dimension catalog is a selected list of hierarchies in different dimensions that is enabled for use in plans. The Default dimension catalog appears by default, but can be changed to another dimension catalog that has been defined.

Can I modify the default dimension catalog?
Yes, you can modify the Supply Chain Planning default dimension catalog. However, if you want to make any changes, Oracle recommends that you create a duplicate of the default dimension catalog.

Measure Catalogs
Can I modify the default measure catalog?

No. Although you cannot modify the default measure catalog, you can create a measure catalog, modify the list of measures, and assign it to plans on the Plan Options page.

Related Topics

• How You Use Measure Catalogs in Supply Chain Planning

Levels and Attributes

How You Use Levels and Attributes in Supply Chain Planning

On the Levels and Attributes tab, you can enable certain item and organization attributes (standard fields or flexfields) to be available in Planning Analytics as filters. For example, you can enable PLANNER_CODE to use in an analysis to group metrics and measures by that particular attribute.

You can create a display name to use in the various pivot tables and graph configurations. For example, if the predefined level name is Product Category 2, you can enter a display name of Laptops. You can also configure which identifier to display in tables and graphs for selected hierarchies. For example, you can choose to display item name or item description in your tables and graphs.

Displaying Descriptions in Tables and Graphs

You can analyze planning data in planning tables and graphs by using the description fields of entities in hierarchies, such as items and organizations. You can use the description fields when their primary identifier is a difficult to understand alphanumeric code. You can toggle between the code and description, or display both, in planning tables and graphs for the following entities:

• Items
• Organizations
• Resources
• Work Centers
• Work Areas

Tip: The organization level in the Organization dimension and the organization level in the Resource dimension are separate settings. Oracle recommends that you set them to use the same identifier.

Changing a member identifier can impact the advanced criteria in tables and graphs. If you use an advanced filter criteria in a table or graph, then the criteria will be compared to the new member identifier, which can affect the search results. The change to the member identifier can result in different or no members meeting the filter criteria. For example, many names might start with AB, but no descriptions start with AB. After you make this change, you should verify that any advanced filter criteria used are still valid.

Note: In the Selector Tool, the member values displayed are based on what is configured in the Member Identifier to Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can configure your tables and graphs to show item description instead of item name, which is what also appears when you are in the Selector Tool.
Planning Measures

Predefined Measures in Supply Chain Planning

When you use one of the Supply Chain Planning work areas, you have access to many predefined measures. To review the details of each predefined measure, use the following:

- The Manage Planning Measures task
- A spreadsheet available at My Oracle Support

The Manage Planning Measures Task

On the Manage Planning Measures page, select a measure, and then select edit. You can review the details of the measure on the Edit Measure page even if you can't make changes to the measure.

A Spreadsheet Available at My Oracle Support

Use Doc ID 2374816.1, Oracle Supply Chain Planning Cloud: List of Predefined Measures.

The List of Predefined Measures spreadsheet contains only the core measure attributes. You can use the Edit Measures page to view all the attributes associated with a particular measure.

How You Manage Planning Measures

Use the Manage Planning Measures task to review Supply Chain Planning measures. You can edit several measures, but some measures you can only view. You use the pivot table to view the data you edited at different aggregations. The results of the edits are stored based on definitions of a measure.

This topic discusses how you can perform these tasks:

- Update the definition of a measure
- Update aggregation parameters
- Update disaggregation parameters
- Edit data of a measure

Update the Definition of a Measure

To update the definition of a measure:

1. In the Navigator, click a Supply Chain Planning work area.
2. Click the Tasks panel tab.
3. In the Tasks panel, click the Manage Planning Measures link.
4. Expand a measure group and scroll manually or use the search option to find all measures that match the search criteria.
5. Select the measure that you want to modify and then click the **Edit** icon.

   **Note:** Look for a check mark next to **Allow editing** at the top of the measure definition controls to confirm that the measure is editable.

6. Click the **Aggregation and Disaggregation** tab to view measure definitions.

   The dimensions, hierarchies, and levels at which data persists vary from measure to measure. For the dimensions with a check mark, the measure is defined on the current dimension. For these dimensions, each measure is defined on a single hierarchy as listed on the dialog box.

7. Click **Save and Close**.

### Update Aggregation Parameters

Aggregation parameters control the way in which data of a measure is aggregated from the storage level to a table, graph, or infotile. Calculation Order enables you to chose between the following options:

- **Calculate and Aggregate:** Calculates the measure's expression at the lowest data level and then aggregate up.
- **Aggregate and Calculate:** Aggregates all measures referenced in the measure's expression and then calculate the expression.

### Update Disaggregation Parameters

The disaggregation methodology is driven by the definitions of the disaggregation parameters. Disaggregation for definitions that include time can be different from disaggregation for definitions that do not include time. For noneditable measures there are no configuration in the disaggregation parameters.

The four different allocation methods are the following:

- **Same:** Indicates that all lower-level entries into which the data is being saved will receive the same value. Service level would be a good measure to use Same Value settings as the percentage being entered should not be allocated between different items and organizations.
- **Equal:** Spreads the edited value among the lower level entries into which data is being saved. Each entry receives an equal share of the update. This could commonly be seen on the time dimension, where data may be updated for a week or month, but there is no guidance on how it should be allocated to the common storage level of days. It is typically set to the time dimension to equal value to support equal allocation between the days.
- **Self:** Uses a measure's own pre-calculated values to allocate the data to the dimension member combinations. For example, item-organization. The weights for each combination are calculated and stored for the measure during plan run. These weights are used to allocate the data. For example, the forecasts for P1-Org1 and P2-Org1 are 40 and 60 respectively. Therefore, the weights used for allocation would be 40% for P1-Org1 and 60% for P2-Org1.
- **Measure:** Uses values of a different measure to allocate.

### Edit Data of a Measure

To edit the data of a measure, open a table containing the measure, double-click the cell where the data is to be entered and then enter the data. In a table, editable and noneditable cells look similar. However, when you double-click a cell of an editable measure, the cell enables you to enter values.
Copy Data from One Measure to Another

In a Supply Chain Planning table, you can update the value of one measure by using values from another measure. In several cases, a measure can have other related measures that enable you to override the value of a base measure. For example, Sales Forecast is one of those measures:

- Sales Forecast: Base measure.
- Adjusted Sales Forecast: You can override what is in Sales Forecast.
- Final Sales Forecast: The planning process takes the Adjusted Sales Forecast, if there is one, or uses the Sales Forecast. The planning process uses the Final Sales Forecast, which takes into account any manual adjustments that you made.

You can specify the data source whose values you want to copy to the selected range of cells in the target measure. Using a table containing the three measures listed in our previous example, select a range of cells associated with the Adjusted Sales Forecast measure, click Actions and then select Edit. In the Edit Measures dialog box, use the Sales Forecast measure as the source measure for Adjusted Sales Forecast and increase it by 10 percent. If your Sales Forecast is 200, then Adjusted Sales Forecast now reflects 220.

For a measure to appear in the list of values for Source Measure in the Edit Measures dialog box, the measure must be included in the table. The measure must also conform to the same dimensions as the measure you are editing.

When editing a measure's value at an aggregate level, the value is allocated down to the lowest level. For example, when editing weekly data, the value will be allocated down to the day.

You can also edit multiple measures at a time; however, you can't have circular references. In the following example, Measure3 is used as a source measure for Measure1. But, Measure3 is also being edited at the same time to increase the measure by 10 percent.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Source Measure</th>
<th>Action</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure1</td>
<td>Measure3</td>
<td>Increase by percentage</td>
<td>10</td>
</tr>
<tr>
<td>Measure2</td>
<td>Measure2</td>
<td>Increase by percentage</td>
<td>10</td>
</tr>
<tr>
<td>Measure3</td>
<td>Measure3</td>
<td>Increase by percentage</td>
<td>10</td>
</tr>
</tbody>
</table>

In this scenario, the planning engine won't know which value of the source measure to use: the original Measure3 value, or the value of Measure3 after increasing it by 10 percent. To avoid circular references, you must handle these edits separately.

Configure Units for a Measure

You can view a measure in several units of measure (UOM) and currencies side by side without needing separate measures. By converting a single measure into various values and currencies, you get superior data consistency and do not require recalculation and data synchronization.
In addition, sometimes different products and organizations have data that is loaded externally using different units of measure. For example, vitamins sold in Europe may be shipped in bottles, while in Asia the quantities are by pill count. By defining units, you enable these values to be converted into a cohesive value, which can be aggregated in a seamless manner.

To configure units for a measure:

1. In the Navigator, click a Supply Chain Planning work area.
2. Click the Tasks panel tab.
3. In the Tasks panel, click Manage Planning Measures.
4. Locate the measure for which you want to configure units and click Edit.
5. On the Advanced tab, select the Properties tab.
6. Select UOM from the list as the default value for the Base Units of Measure.

The base units of measure define the default unit of measure to which displayed data is converted. It is editable only for numeric measures, which do not have product and organization-based levels. For measures that have product and organization, the definition comes from the data source. When using the measure, you must attempt to select only the relevant UOM entries for the measure to streamline the user process.

7. Select the relevant units of measure from the Display Unit of Measure.

You completed defining the unit of measure. You can view the measure using a specific table or graph.

Note: To show the same measure with different unit of measures, you can create a copy from the original measure. Rename the duplicated measure to use another unit of measure of your choice. You can show the same measure as both numbers and currencies.

To override the default UOM:

1. Open a table and select View, Format Measures to find the measure.
2. Click the measure you want to modify and select the value from the Unit of Measure list.
3. Click Save and Close.

Configure Currencies for a Measure

You can view a measure in several units of measure and currencies side by side without having separate measures. By converting a single measure into various values and currencies, you get superior data consistency and do not require recalculation and data synchronization.

To configure currencies for a measure:

1. In the Navigator, click a Supply Chain Planning work area.
2. Click the Tasks panel tab.
3. In the Tasks panel, click the Manage Planning Measures link.
4. Locate the measure for which you want to configure currencies and click Edit.
5. On the Advanced tab, select the Properties tab.
6. Select Currency from the list as the default value for the Base Currency.

The base currency defines the default currency to which displayed data is converted and is editable only for currency type measures.

7. Select the relevant currencies from the Display Currency.

You completed defining the currencies for a measure. You can view the measure using a specific table or graph.
The currency value is editable only if the measure type is Currency. For numeric measures, you can change the type from Number to Currency. Select the currency that you want to use in this instance of the measure.

Note: To show the same measure with different currencies, you can create a copy from the original measure. Rename the duplicated measure to use another unit of measure of your choice. You can show the same measure as both numbers and currencies.

To override the default currency:

1. Open a table and select **View, Format Measures** to find the measure.
2. Click the measure you want to modify and select the value from the **Currency** list.
3. Click **Save and Close**.

### Configure Conditional Formatting for a Measure

Use conditional formatting to change the background color of a cell when a specific condition occurs. Conditional formatting is useful to draw the attention of the user for information that requires action. You define conditions for an individual measure. A measure can have one or more formats applied. The condition is evaluated at the table level using the configured units and currencies. Two tables with different units of measure or currencies defined can have different cells trigger the conditional formats.

To configure global conditions:

1. In the Navigator, click a Supply Chain Planning work area.
2. Click the **Tasks** panel tab.
3. In the Tasks panel, click the **Manage Planning Measures** link.
4. Locate the measure for which you want to apply conditions and click **Edit**.
5. On the **Advanced** tab, select the **Conditional Formatting** tab.
6. Click the + icon to add a row and complete the information.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure</td>
<td>Locate the measure you want to use to evaluate. Conditional format for a measure can be based on another measure.</td>
</tr>
<tr>
<td>Condition</td>
<td>Compares the selected measure to a value or another measure</td>
</tr>
<tr>
<td>Compare to Measure</td>
<td>Measure to which the selected measure is compared</td>
</tr>
<tr>
<td>Value</td>
<td>When the <strong>Compare to Measure</strong> is empty, this value is used to compare the selected measure</td>
</tr>
<tr>
<td>Color</td>
<td>Defines the color for the cell background when the condition is met</td>
</tr>
</tbody>
</table>

7. Click **Save and Close**.

To configure local overrides to conditions:

1. Open a table and select **View, Format Measures**.
2. Locate the measure that you want to modify and then select the **Use Override Conditional Formatting** check box.

3. The Conditional Formatting section appears. Select a new conditional format to use in your table.

4. For only the Build Plan table accessed through a Supply Planning work area, the Conditional Formatting section also includes the **Apply** and **Name** columns.

   In the **Apply** column, select whether you want the conditional formatting to be highlighted in your Build Plan table all the time or only when you select it from the Highlight Exceptions drop-down list.

   For example, if you set up a conditional format named Resource Overload and select **When selected**, Resource Overload appears in the Highlight Exceptions drop-down list in your Build Plan.

5. Click **Save and Close**.

## Manage User-Defined Measures

### Create Measures and Assign to a Measure Catalog

In addition to reviewing measures, you use the Manage Planning Measure task to create, edit, duplicate, and delete measures. You can also create measure groups and add predefined and user-defined measures in them.

This topic discusses the following:

- Creating measures
- Duplicating, editing, and deleting measures
- Creating measure groups
- Assigning measures to a measure catalog

### Create Measures

You can create measures with appropriate privileges if the predefined measures don't meet your business requirements. The measures that you create have the same features and functionality as predefined measures.

To create a measure:

1. In the Navigator, click a Supply Chain Planning work area link.

   You can create measures from one of the following work areas: Demand Management, Supply Planning, Sales and Operations Planning, Demand and Supply Planning, or Plan Inputs.

2. Click the **Tasks** panel tab.

3. In the Tasks panel, click the **Manage Planning Measures** link.

4. Click **Create** from the Actions menu.

   a. On the Create Measure page, enter a measure name and description.
   
   b. Select a measure group.
   
   c. Select a data type.
   
   d. Select the **Allow editing** check box if you want the measure to be editable in a pivot table.
   
   e. Select **Edit Range** to enable the Edit Lock tab, which controls the editable status of the measure.

   The Edit Range value determines the time range over which the measure is editable. The available values are: History, Future, History and Future.
f. On the Aggregation and Disaggregation tab, define the dimension parameters. Select the dimensions, hierarchy, and hierarchy level within the dimension to store the measure data. When a dimension and hierarchy are selected, the default setting for the Stored Level is the lowest level of the dimension’s hierarchy. You can modify the level to store by selecting the hierarchy from the list and setting the stored level parameter within that hierarchy.

- **Aggregation Parameters:** The Aggregation parameters control the way a measure's data is aggregated. You have two options:
  
  - Calculate and aggregate: Calculate and Aggregate calculates the measure's expression at the lowest data level and then aggregate up.
  - Aggregate then calculate: Aggregate and Calculate aggregates all measures referenced in this measure's expression and then calculate the expression.

  In the Time Dimension field, select the aggregation function that controls how data is aggregated for the time dimension. The Other Dimensions fields are the same as the Time dimension fields. These options control how the data is aggregated across all the dimensions except for time. The Weighted By field is enabled only if you select Weighted Average as the aggregation parameter for either Time or Other Dimensions. It enables you to pick the measure to drive the weighted average calculation.

  The aggregation types include: Sum, Average, Weighted Average, Minimum, Maximum, Count, Latest, Median, Variance, and Standard Deviation.

- **Disaggregation Parameters:** The Disaggregation Parameters control how changes to the data at an aggregated level are allocated down for storage. This is used when data changes are made in a pivot table, but also when made by the demand forecast. The weights for each combination, such as item-organization are calculated and stored for the measure during plan run. These weights are used to allocate the data. For example, the forecasts for P1-Org1 and P2-Org1 are 40 and 60 respectively. Therefore, the weights used for allocation would be 40% for P1-Org1 and 60% for P2-Org1.

  The parameters for the Disaggregation Type field are: By Measure, By Self, Equal, and Same Value. The default parameter is Equal.

  The Disaggregation Basis field is enabled only if you select the Disaggregation Type as By Measure. Select the measure to use as the disaggregation basis from the list of measures.

  The Secondary Basis field is enabled only if you have selected the Disaggregation Type field as By Measure or By Self. The values for Secondary Basis are Booking History Average or Shipment History Average.

  The Secondary Basis measure is selected in case the basis measure has no value. You can select only measures that contain pre-calculated proportions as a secondary basis. That is, they are calculated during plan run.

g. On the Expression tab, define any new expressions for a measure. You create an expression when you have to show any value other than its stored information. The expression provides a flexible framework for an extensive variety of calculations and information. An expression for a measure references other measures, operators, and numbers.

  In the Expressions subtabs:

  - The Functions tab lists the available functions, a description, an example of the function's use.
The Measures tab lists the available measures, their descriptions, and data type. The Insert button inserts the highlighted measure into the expression building area where functions or arithmetic operations can be specified.

The Attribute tab lists the attributes available for the Product dimension at Item level. The description and data type of the attribute is shown in the description pane.

After you complete the expression, use the Validate button to ensure the syntax is correct. An error or succeeded message is displayed.

h. On the Edit Lock tab, you can define a new expression similar to the measure expression. The difference is rather than evaluating and displaying the expression result, the expression result is used to control or refine the editable status of the measure. If the expression evaluates as true, the measure is locked from editing. The expression is evaluated every time the table is run, and may change as relevant measures or attributes are modified.

i. On the Advanced tab, click the Properties tab and review the following parameters:

- If you select the Shared measure check box, then the measure is shared across plans. By default, the parameter isn’t selected and hence the measure is plan specific
- If you select the Refresh with current data check box, then the current measure value needs a placeholder to store the result in the application. For example, a non-editable measure where the data is imported from a legacy or other application. Selecting this check box allocates a space to store the measure by the defined dimensions.
- Conversion Type enables you to define the valid Unit of Measure (UOM) and Currency conversions that will be available for a measure in a table.

Base Units of Measure defines the default unit of measure used to convert displayed data. The field is editable only for Numeric measures, which don’t have Product and Organization-based levels (for measures that have product and organization, the definition comes from the data source). Select any relevant units of measure, which may be useful in a table, graph, or tile. Only the UOMs that you select will be available for selection in a table or graph.

Base currency defines the default currency to which displayed data are converted. The field is editable for only Currency type measures.

You use Price lists to convert quantities into values, which are then converted to a currency.

- Data Lookup value enables you to identify a data lookup source that displays the measure as a list of value. The source attributes have 3 options: None (Default), Level, and List.
  - If Source=Level, you must identify the level and the attribute to display in the measure list.
  - If Source=List, then you can create and maintain the list of values. You can either add or remove members in this list.

j. On the Advanced tab, click the Goals tab to define if low or high values are better for measure goals.

k. On the Advanced tab, click the Conditional Formatting tab to define conditional formatting settings for the measure.

5. Click Save and Close.

Assign Measures to a Measure Catalog

To use the user-defined measure in your plan, add the new measure to the plan’s measure catalog. Navigate to Configure Planning Analytics, find the plan’s measure catalog on the Measures Catalog tab. In the Available Measures pane, search for the new user-defined measure, and add it to the Selected Measures. After you perform a plan run you can create a table or use an existing table, and add your new measure to the table.
Duplicate, Edit, and Delete Measures

You can duplicate, edit, or delete user-defined measures using the Manage Planning Measures task, which is available in the Tasks drawer.

To duplicate the measure: Select a measure from the list of measures, select the Action menu on the toolbar, and then click Duplicate. Duplicating the existing measure gives you a starting point for creating a new measure definition. When you duplicate a measure the default name is Copy of <original measure name>. Other definitions of the duplicated measure remain the same as the original measure.

To edit the measure: Select a measure from the list of measures, select Actions menu, and then click Edit. Editing a measure enables you to select an existing measure and edit its attributes.

To delete the measure: Select a measure from the list of measures, select Actions menu, and then Delete. A complete list of all objects including tables and measure groups are be displayed to ensure you are aware of impacts of deleting a measure.

Create Measure Groups

Use Manage Planning Measures task to create a measure group. Measure groups are created to group measures together that you need frequently. Depending on your business need you can create measure groups and associate measures with appropriate groups.

To create a measure group:

1. In the Navigator, click a Supply Chain Planning work area link.
2. Click the Tasks panel tab.
3. In the Tasks panel drawer, click the Manage Planning Measures link.
4. Click Create Group from the Actions menu.
   - Enter a name and description.
   - From the Available Measures pane you can select measures and move to the Selected Measures pane.
5. Click Save and Close.

You can also create Measure Groups in the Selector tool when you create or edit a table or graph. In the Group field in the header section, select Manage Groups from the list of values. Use the plus icon, +, to add a row, type a name, and click Save.

Configure Global Goals for Measures

You can define global goals for a measure using the Goals tab when you create or edit a measure. On the Create Measure page, click the Advanced tab and then select the Goals tab to configure global goals.

Define if low or high values are better. For example, a high value is good for revenue; a low value is good for expenses.

For global goals, you can provide a low range or a high range.

Goals option is available only for measures of type Currency, Number, and Percent. Using Global Goals, you can first define if low or high values are better for a measure. The ranges are displayed on the page when you are viewing a measure in comparison with its goal, for example, in an infotile. Global goals are measure level parameters and are
not defined specifically for a subset of the data. For example, you cannot have a goal of 1000 for one organization and 50000 for another.
5 Supply Network Model

How You Maintain Your Supply Network Model

Use the Maintain Supply Network Model page to view your collected data that includes details of organization, customers, suppliers, carriers, and interlocation shipping networks. To access the Maintain Network Model page, navigate to a Supply Chain Planning work area. Click the Tasks panel tab and then select the Maintain Supply Network Model link.

You use organizations to represent your business facilities or functions. Typically, if your business has a single physical facility that performs two different functions, then you model it as two organizations. For example, you have one facility that’s a manufacturing plant and a distribution center. You can model them as two separate organizations. Additionally, if your business has one function located in two separate physical facilities, you can model those as one organization. If you modeled your facilities as one organization, you can create separate subinventories to represent inventory for each facility.

Review the Collected Data

Based on your search results, use the information on the Organization tab to do the following:

- Review organizations, including the time zones associated with the organizations, for all source systems.
- Create customer and supplier association to organizations. This is used when creating the buy-sell transfers.
- Select the drop ship validation organization. For each source system, you can select only one organization as the drop ship validation organization. You can also assign a calendar to a drop shop validation organization.
- Set past due parameters for each organization, which include:
  - Past due forecast days
  - Past due sales order days
  - Past due supply days

Use the Customer and Supplier tabs to review collected data and assign time zones to customer sites and supplier sites. If the customer site or supplier site doesn’t have an associated time zone, then the customer site or supplier site is assumed to be in the same time zone as the organization that’s associated to the demand or supply.

Use the Carrier and Interlocation Shipping Locations tabs to review collected data on carriers, shipping methods, and transit times.

Manage Organization Groups

Click the Manage Organization Groups button on the Organization tab to create and manage organization groups. Organization groups are managed within the source systems and are used to limit the net change data collection from a source system to specific organizations.
Buy and Sell Transfers

You can conduct material transfers between two organizations in a single Oracle Fusion source system by using the purchase order and sales order documents. The sales order at the source organization is used to ship the transfer. The purchase order at the destination organization is used to receive the transfer.

In the supply network model for the purchase order supply at the receiving organization:

- Define the supplier to source organization relationship and for the sales order demand at the shipping organization.
- Define the customer to destination organization relationship.

To model an organization as a supplier, update the Supplier and Supplier Site columns of the associated organization.
To model an organization as a customer, update Customer and Customer Site columns of the associated organization.

Forecast and Consume Internal Orders

To forecast and consume internal orders, assign a customer and customer site to the organization that's the destination of the transfers. Use a customer name that makes sense for the destination organization, such as M1 Transfers. After you assign a customer and customer site on the Organizations tab, select the Use Customer and Customer Site for Interorganization Transfers check box for the organization.

Note: To complete the setup to forecast and consume internal orders, you must also do the following:
- On the Collect Planning Data page, Parameters tab, Demand Planning Data subtab, select the Collect historical transfer orders check box.
- In the plan options for your plan, select the Include transfer orders check box in the Demand: Advanced Options dialog box. This check box is only available from a Demand Management, Planning Central, or Demand and Supply Planning work area.

Related Topics
- Overview of Data Collections for Supply Chain Planning
- How You Collect Different Data Types for Supply Chain Planning
- How You Load Planning Data from Files
- Set Up Forecast Consumption for Transfer Orders

Publish Order Forecasts to Suppliers

You publish order forecasts to your suppliers to enable them to commit supply and indicate their ability to meet the demand. Collaborating with suppliers by publishing an order forecast enables:

- Suppliers to send supply commits to the Original Equipment Manufacturer (OEM)
- OEMs to receive supply commits as supplier capacity

Collaboration enables suppliers to get an insight into the demand that the OEMs forecast and plan supply chain activities to meet the demand. Additionally, collaboration with suppliers enables OEMs to plan their downstream activities in the supply chain more efficiently.
Use the Collaboration Basis column in the Suppliers tab on the Maintain Supply Network Model page to indicate the basis on which you want to publish the order forecast to your suppliers. You can choose to publish the order forecast at the supplier and supplier site levels based on one of the following dates:

- **Start date**: Suppliers use the start date to know when they need to start manufacturing an order to fulfill the order on time
- **Dock date**: Suppliers use the dock date to know the date by which they need to fulfill the order

### How You Define the Approved Supplier List for Supply Chain Planning

An approved supplier list (ASL) is a repository of information that links items to the suppliers and supplier sites that provide them to either a specific ship-to-organization or the entire enterprise. An ASL can be global or specific to an organization; however, supply planning only recognizes global ASLs. The planning process collects ASLs from Oracle Fusion Procurement to determine the supplier and supplier sites for items.

Define ASL attributes in two different ways to use in supply planning. You can define some attributes in Oracle Fusion Procurement and then upload a CSV file that defines the attributes you want supply planning to use.

Define the following item-to-supplier relationships and order modifiers in Oracle Fusion Procurement:

- Supplier
- Supplier site
- Minimum order quantity
- Fixed lot multiple

To upload additional attributes for supply planning to use, you must create and collect the ASL from purchasing. You can then use the CSV file upload to define additional attributes such as the following:

- Item-supplier lead time
- Supplier capacity calendar
- Daily supplier capacity

**Related Topics**

- **Supplier Capacity Options**

### Associate Calendars with Supplier Sites

Use a supplier site calendar to measure processing lead times for purchases from a supplier site. You can associate a Supply Chain Planning calendar with a supplier site to use for all items sourced from that supplier site. The calendar is in the collected planning data.

You can associate a calendar with supplier sites to use if there is no calendar defined through the Approved Supplier List upload for a supplier site-item combination. From a Supply Chain Planning work area, navigate to the Maintain Supply Network Model page, Suppliers tab. In the **Supplier Site Calendar** column for a supplier, select a calendar name from the list of collected calendars. You can only edit this field if the supplier row contains a supplier site.
When you run the plan, the planning process uses the selected calendar on the Maintain Supply Network Mode page if the approved supplier list calendar for the supplier site-item is blank. If the approved supplier list calendar for the supplier site-item is blank, and you do not associate a calendar with a supplier site on the Maintain Supply Network Model page, then the planning process uses the 24/7 calendar.

Specify Catalogs for Assignment Sets

A catalog is a collection of categories used to classify items that you can organize into a hierarchy. A catalog can have a flat or single-level structure of categories or you can have a hierarchical structure of categories.

When creating assignment sets, you must specify a catalog for each assignment set. You associate an assignment set with a catalog to:

- Use the categories associated to that catalog in your assignment set.
- Link the sourcing assignments to the categories associated with the catalog.

If you do not specify a catalog for an assignment set, the assignment set uses the Catalog for Sourcing Assignments (MSC_SRC_ASSIGNMENT_CATALOG) profile option as the default catalog.

To create an assignment set and specify a catalog, use the Manage Assignment Sets task in one of the Supply Chain Planning work areas.

Note: Assignment sets are not applicable to the Demand Management work area.

Item Attributes and Order Modifiers for Supply Planning

Items represent the material that you use in manufacturing and distribution processes and store in inventory. Item attributes specify properties of each item. You set the item attributes for supply planning through the Product Information Management work area.

Use these steps to set item organization attributes for supply planning:

1. Navigate to the Product Information Management work area and open the Manage Items task from the Tasks drawer.
2. Search for your items.
3. Select an item and edit attributes on the specification tab. You can locate the Planning attributes under the planning section.

This table lists the attributes related to supply planning.

<table>
<thead>
<tr>
<th>Item Attribute</th>
<th>Item Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Overview</td>
<td>Unit of Measure</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>Structure Item Type</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>Base Model</td>
</tr>
<tr>
<td><strong>Item Attribute</strong></td>
<td><strong>Item Structure</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>Autocreated Configuration</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>Assemble to Order</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>Build in WIP</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>Supply Type</td>
</tr>
<tr>
<td>Inventory</td>
<td>Inventory Item</td>
</tr>
<tr>
<td>Inventory</td>
<td>Stockable</td>
</tr>
<tr>
<td>Inventory</td>
<td>Transactable</td>
</tr>
<tr>
<td>Order Management</td>
<td>Customer Orders Enabled</td>
</tr>
<tr>
<td>Order Management</td>
<td>Transfer Orders Enabled</td>
</tr>
<tr>
<td>Planning</td>
<td>Make or Buy</td>
</tr>
<tr>
<td>Planning</td>
<td>Safety Stock Method</td>
</tr>
<tr>
<td>Planning</td>
<td>Planner Code</td>
</tr>
<tr>
<td>Planning</td>
<td>Planning Method</td>
</tr>
<tr>
<td>Planning</td>
<td>Forecast Control</td>
</tr>
<tr>
<td>Planning</td>
<td>Time Fences: Demand</td>
</tr>
<tr>
<td>Planning</td>
<td>Time Fences: Release</td>
</tr>
<tr>
<td>Planning</td>
<td>Time Fences: Planning</td>
</tr>
<tr>
<td>Planning</td>
<td>Cost</td>
</tr>
<tr>
<td>Planning</td>
<td>Carrying Percentage</td>
</tr>
<tr>
<td>Item Attribute</td>
<td>Item Structure</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Planning</td>
<td>Shrinkage Rate</td>
</tr>
<tr>
<td>Planning</td>
<td>Acceptable Early Days</td>
</tr>
<tr>
<td>Planning</td>
<td>Lead Times: Processing</td>
</tr>
<tr>
<td>Planning</td>
<td>Lead Times: Preprocessing</td>
</tr>
<tr>
<td>Planning</td>
<td>Lead Times: Postprocessing</td>
</tr>
<tr>
<td>Planning</td>
<td>Lead Times: Fixed</td>
</tr>
<tr>
<td>Planning</td>
<td>Lead Times: Variable</td>
</tr>
<tr>
<td>Planning</td>
<td>Minimum Order Quantity</td>
</tr>
<tr>
<td>Planning</td>
<td>Maximum Order Quantity</td>
</tr>
<tr>
<td>Planning</td>
<td>Fixed Order Quantity</td>
</tr>
<tr>
<td>Planning</td>
<td>Fixed Lot Multiplier</td>
</tr>
<tr>
<td>Planning</td>
<td>Fixed Days Supply</td>
</tr>
<tr>
<td>Planning</td>
<td>Rounding</td>
</tr>
<tr>
<td>Purchasing</td>
<td>Purchasable</td>
</tr>
<tr>
<td>Purchasing</td>
<td>Approved Supplier List</td>
</tr>
</tbody>
</table>

You can use these attributes for specific purposes:

- **Make or Buy**: This attribute is used by default if no sourcing rule is present.
- **Planning Method**: Use either MRP planned or MPS planned as the planning method.
- **Time Fences**: All are used by planning.
- **Buy items** use the processing lead times. Make items use fixed and variable.
- **Make, buy, transfer** all use preprocessing lead time. Buy and transfer use post processing lead time.
• Acceptable Early Days is used if you need to reschedule existing supplies. If the supply due date is within the acceptable early days, then no reschedule out recommendation is issued.

Order Modifiers
You use order modifiers to obtain planned orders that you are more likely to use in your environment. For example, you may purchase an item from a supplier who only provides it on pallets of quantity 100. If you are short in some quantity, say 72, you can set the planned order quantity to 100 instead of 72 to support your requirement. You can't apply order modifiers to phantoms.

These are the order modifiers that you can use:

• Minimum Order Quantity
• Maximum Order Quantity
• Fixed Order Quantity
• Fixed Lot Multiplier
• Fixed Days Supply
• Rounding

Material planning uses a priority sequence (precedence) of order modifiers. It applies certain order modifiers before others and rules out certain order modifiers based on its using certain other order modifiers. The order modifier precedence is:

• Fixed Days Supply: One planned order for this item must cover all the shortages for the number of days specified in the value. For example, if the net requirements are 50 on Monday, 100 on Wednesday, 70 on Thursday, and you have set fixed days supply to five, the planning process creates one planned order, with quantity of 220 (50 + 100 + 70) and due on Monday. The period start dates are not fixed. In the example, the next period of five days would not always start on the following Monday but would start on the next day after Friday that has net requirements. You can adjust the fixed days supply value using the other order modifiers. Therefore, the next period of five days could be the following Wednesday through the second Tuesday.

• Fixed Order Quantity: You must always set the planned order quantity with this value. For example, if the net requirements are one and you have set fixed order quantity to 200, the planning process creates one planned order with quantity of 200. If set, the planning process skips to the modifier Round order quantities.

• Fixed Lot Multiplier: You must always have the planned order quantity with this value. For example, if the net requirements are 400 and you have set fixed lot multiple to 150, the planning process creates one planned order with quantity of 450.

• Minimum Order Quantity: The planned order quantity may never be less than this value. For example, if the net requirements are 100 and you have set minimum order quantity to 150, the planning process creates one planned order with quantity of 150. If set, the planning process skips to the modifier Round order quantities.

• Maximum Order Quantity: One planned order for this item may not have a quantity more than this value. For example, if the net requirements are 200 and you have set maximum order quantity to 150, the planning process creates two planned orders, one with quantity of 150 and the other with quantity of 50.

• Rounding: The planned order quantity must always be a whole number; the planning process always rounds fractional quantities up to the next highest whole number. For example, if the net requirements are 99.2 and you have selected round order quantities, the planning process creates one planned order with quantity of 100.
6 Planning Data Collection

Overview of Data Collections for Supply Chain Planning

To run plans from one of the Supply Chain Planning work areas, you must collect data into a planning data repository. Order promising and order management processes also use the planning data repository to promise and manage orders.

To collect data into the planning data repository, you can perform these tasks from one of the Supply Chain Planning work areas:

- Collect Planning Data: Use this task when you collect data from the Oracle Fusion source system.
- Load Planning Data from Files: Use this task when you collect data from a completely external source system.

Depending on your security privileges, you may need to manually add these tasks. In the Setup and Maintenance work area, use the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Collect Planning Data

The following figure illustrates the collections processes that you can use to populate the planning data repository.
Collect Planning Data

There are two steps involved in the data collection process. The Collect Planning Data process first pulls data from the Oracle Fusion source system into staging tables. The process then loads data from the staging tables into the planning data repository.

On the Collect Planning Data page, use the following tabs to select what data you want to collect:

- Reference Data
- Demand Planning Data
- Supply Planning Data

Most of the reference data are global entities. Global entities are common for all source systems. For example, Units of Measure (UOM) is common for all source systems. The supply planning and demand planning data are transactional data. Most of the transactional data are local entities. Local entities are specific to each source system. For example, On-hand Quantity is specific for each source system.

You can also select collection filters to further refine what data you want to collect. You can save your selections to collection templates.

Load Planning Data from Files

Use this option to populate the planning data repository using CSV files:

To load the planning data from files, follow these steps:

1. Create the CSV files. To create the CSV files, you can use a predefined set of Microsoft Excel files as import templates.
2. Import the CSV files. From the navigator, click File Import and Export, and create a new import. Specify scm/planningDataLoader/Import for the account.
3. Submit the Load Planning Data from Files process. When you submit the process, the process first pushes the data from the CSV files into the staging tables. The process then loads the data from the staging tables into the planning data repository.

Related Topics

- Update Existing Setup Data

Global Entities

Within data collections, Oracle Fusion Supply Chain Planning refers to certain business entities as global entities. Global entities are specific for each instance and are common for all source systems. They are common without regard to whether they are collected from the Oracle Fusion source system or collected from an external source system using the file-based data import (FBDI) method.

When collecting data for a global entity, the planning data repository stores only one record for each instance of the global entity. The data collections process removes the source system reference from the global entity and stores the data in the data repository. If the data collections process collects the same instance of a global entity from more than one source system, the data repository stores the value from the last collection.
For example, the following scenario describes the collection method of the global entity called units of measure (UOM) from three source systems, namely source system A, B, and C respectively.

- Source system A has an instance of UOM. During the collection of UOMs from source system A, the kilogram UOM is collected. This is the first time the kilogram UOM is collected. The data collections process creates a kilogram record in the data repository.

- Source system B does not have any instances of UOM. During the collection of UOMs from source system B, the data collections process does not collect the kilogram value. Since there was no record for the kilogram UOM in source system B, the data collections process does not change the kilogram record in the data repository. The record of the kilogram value from source system A is still valid.

- Source system C has an instance of UOM. During the collection of UOMs from source system C, the kilogram UOM is again collected. The data collections process registers the kilogram record in the data repository to match the values from source system C.

**Note:** When you use the FBDI collection method, the global entity files require a source system. The collections framework validates that the source system matches each record’s source system. A source system identifier marks each data record.

In Supply Chain Planning, the following entities are classified as global entities:

- Order Orchestration Reference Objects
- Units of Measure and UOM Conversions
- Demand Classes
- Currency and Currency Conversion Class
- Shipping Methods (Carrier, Mode of Transport, Service Level)
- Customer and Customer Site
- Suppliers and Supplier Sites
- Regions and Zones
- Approved Supplier List
- Supplier Capacity
- Planners

### Data Collection Types for Supply Chain Planning

When you collect planning data, one of the parameters you specify for the Collect Planning Data task is the Collection Type parameter. You can select this task from any of your Supply Chain Planning work areas. For the Collection Type parameter, you can select one of the following values:

- **Targeted:** Choose the Targeted collection type when you want to collect a significant volume of source system data. Typically, you use the Targeted collection type in scenarios such as bulk upload of transaction data, instance upgrade, and change in collection filters.

- **Net change:** Choose the Net change collection type when you want to collect changed data and new records since the last successful collection cycle.

- **Automatic selection:** Choose the Automatic collection type when you want the planning process to decide and automatically select an appropriate collection type for each of the entities.
Targeted
You use the Targeted collection type when you want to perform a complete refresh of the data in the data repository. In this mode, the planning process deletes the existing data for the selected entities from the data repository. Next, if subsequently collected from the source, the data for the selected entities replaces the deleted data.

Note: For the following data collection entities, you can use only the Targeted collection type: Item Costs, Resource Availability, Fiscal Calendars, and all Shipment and Booking History data.

Net change
When you use the Net Change collection type, you collect data incrementally. The Net Change collection type collects only changed or new data. Collecting data using the Net Change collection type is usually faster than using the Targeted collection type. You typically use the Net Change collection type when you have previously performed a Targeted collection, and now you want to keep your planning data current with your execution system data. You cannot select the demand planning data when the collection type is Net Change.

Automatic selection
You use the Automatic collection type when you are not sure which collection type to select and you want the planning process to decide the collection type for each entity. The planning process evaluates each entity on multiple factors, such as the last collected date for an entity, and decides whether to perform a Targeted or a Net Change collection for the entity. You can manually select the entities that you want to collect or you can use one of the predefined templates to select your entities. If you select one of the predefined templates, you can’t make any changes in the Reference Data, Demand Planning Data, and Supply Planning Data tabs.

Manage Planning Source Systems for Data Collections
To populate the planning data repository, also known as the order orchestration and planning data repository, you collect data from the Oracle Fusion source system. On the Manage Planning Source Systems page in one of the Supply Chain Planning work areas, enable organizations for collections. Depending on your security privilege, you can also enable organizations from the Setup and Maintenance work area.

In the Setup and Maintenance work area, use the following:
- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Manage Planning Source Systems

The Oracle Fusion Source System
The Oracle Fusion source system is included as a source system for data collection. Supply chain planning, order orchestration, and order promising processes use data that are stored in the planning data repository. You ensure the Collections Allowed check box is enabled and manage which organizations you enable for collections.

To open the Manage Trading Community Source Systems page, navigate to the Setup and Maintenance work area and use the following:
- Offering: Supply Chain Planning
• Functional Area: Supply Chain Planning Configuration
• Task: Manage Trading Community Source System

External Source Systems
You can also allow collections for external source systems if you will be loading planning data from files for Oracle Fusion Global Order Promising. You must first define the external source system on the Manage Trading Community Source Systems.

There are two types of external source systems: Others and External.

Version External
The version External source system indicates that the source system is not connected to any other Oracle Fusion applications. This source system is not integrated with Oracle Fusion Product Data Model, Oracle Fusion Trading Community Model, and Oracle Fusion Order Management Cloud. The external source system is also referred as a completely external source system. You cannot enable any other source system settings that are related to other Oracle Fusion applications. You can select the Collections allowed check box now or later depending on when you want to start collecting data. This enables the source system for data collections using the file-based import process.

Version Others
The version Others source system indicates that the source system is connected to other Oracle Fusion applications. This source system is integrated for Oracle Fusion Product Data Model, Oracle Fusion Trading Community Model, and Oracle Fusion Order Management Cloud. The following conditions are applicable when the external source is Others.

- External system data for Items, Item Structures, and Catalogs is uploaded to Oracle Product Data Model Cloud
- External system data for Customers, Customer Sites, Regions and Zones is uploaded to Oracle Trading Community Model Cloud
- External system data for Sales Orders is uploaded to Oracle Order Management Cloud

For more information on types of data that can be collected for each source system, see the Import Templates Used to Create CSV Files for Supply Chain Planning topic.

Organizations Enabled for Data Collections
The process for enabling organizations varies depending on the version of the source system.

To enable organizations for data collections when the source system version is Oracle Fusion, perform the following steps:

1. Click the Manage Organization List button for your Oracle Fusion source system.
2. Click the Refresh Organization List button to update the organizations list
3. Select the Enable for Collections check box for the organizations from which you want to collect data.

Tip: When performing collections during your initial setup, collect order orchestration reference objects from the predefined Oracle Fusion source system, and consider collecting organizations. After enabling organizations for collection, collect organizations first. You can confirm the collection results on the Supply Network Model page.
To enable organizations for data collections when the source system version is **External** (completely external source system), upload organizations using the file-based import process. The organizations are automatically enabled for collections.

To enable organizations for data collections when the source system version is **Others**, perform the following steps:

1. Define an organization as an item-organization in the product data model.
2. Upload the organization using the file-based import process and associate the organization with **Others** source system.

**Related Topics**

- Considerations for Enabling Organizations for Data Collections
- Define Flexfield Mappings

### How the Order Orchestration and Order Promising Processes Use the Collected Planning Data

You perform data collections to populate the planning data repository. In addition to being used by Supply Chain Planning processes, the collected data is used by Oracle Fusion Order Management order orchestration processes and by Oracle Fusion Global Order Promising processes.

#### Data Collections

You must perform data collections to populate the planning data repository, also called the order orchestration and planning data repository, with data from the Oracle Fusion source system or from a completely external source system. When you load data from an external source system, use the XLSM files to organize your data in the required format and then convert the data into CSV files. You can then upload the CSV files to the planning data repository.

#### Order Orchestration

Order orchestration processes use some reference data directly from the planning data repository. You must perform data collections for the order orchestration reference entities even if you are not using the Supply Chain Planning work areas.

**Note:** Before collecting data from your Oracle Fusion source system, you must define at least one organization for the source system. After you have set up at least one organization, you must update the organization list on the Manage Planning Source Systems page and then enable at least one of the organizations for collections. If you have not enabled any organization, then the collections process ends with an error.

#### Order Promising

The Global Order Promising processes use an in-memory copy of the data from the planning data repository. When order orchestration processes send a scheduling request or a check availability request to Oracle Fusion Global Order Promising, the order promising processes use the data stored in main memory to determine the response to send back to order orchestration. You must refresh the Global Order Promising data store after every collections so that the main memory always reflect the current.
How You Enable Cross-References of Entities by Data Collections

Cross-references enable you to locate the correct source value for each cross-referenced entity. When you enable entities for cross-referencing, data collection pays attention to the cross-references that you have set up for certain values.

To enable cross-referencing of entities, click the Manage Planning Data Collection Processes task from your supply chain planning work area. Select the source system from the list, and then enable the available entities that you want to cross-reference during data collections.

You can view the cross-referenced data for each entity on the Cross-Reference Relationships for Collected Data page in the Plan Inputs work area.

How Planning Processes Collect Different Work Definitions and Item Structures

You may be concerned that the work definition and item structure data in your supply chain planning work area does not match with what was defined in Oracle Manufacturing Cloud. You don’t need to worry. The planning application collects and uses data based on how the work definitions and item structures are defined and associated in the manufacturing source system.

Work Definitions and Item Structures in the Source System

The work definition is a primary source of data for the planning application. The planning process uses the work definition of make order items to determine component and resource requirements. In case the work definition is not defined, the planning process uses the defined item structure, but to plan for components only. If a work definition is defined and no item structure is associated to it, then you can manually add ad hoc components to it. If an item structure is associated to it, you can still add ad hoc components to the work definition, alongside the components in the item structure. Remember that while a work definition can be associated with only one item structure, one item structure can be associated with several work definitions within the parent item.
Work Definitions and Item Structures in the Planning Data Repository

In the manufacturing source system, the work definitions and item structures for an item can be defined and associated in different ways. The following table lists the most common source system combinations and how the collections and run plan processes proceed accordingly:

<table>
<thead>
<tr>
<th>Manufacturing Cloud Definition</th>
<th>Item Structure Name and Work Definition Name in the Planning Data Repository</th>
<th>Planning Collections Processes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only item structure is defined for an item. No work definition is defined.</td>
<td>Item structure name exists, no work definition name</td>
<td>The planning process collects the item structure information but does not collect information for routing, operations, or item resources.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The planning process uses item structure to plan components and does not plan resources.</td>
</tr>
<tr>
<td>Only work definition is defined for an item. No item structure is defined.</td>
<td>Work definition name exists, no item structure name</td>
<td>The planning process collects the work definition information to populate the item structure and routing information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The planning process populates the component information and operation sequence number in the item structure based on the ad hoc components and operation assignment available in the work definition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The planning process uses the work definition information to plan both components and resources.</td>
</tr>
<tr>
<td>Both item structure and work definition are defined for the item.</td>
<td>Both work definition name and item structure name exist</td>
<td>The planning process uses the components that are associated with the work definition to plan. The planning process does not consider any components of item structure that are not associated with the work definition. You can override the item structure component usage within the work definition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The planning process collects component attributes (such as component effectiveness) from the item structure if the components are associated with the work definition.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The planning process uses the work definition to plan resources.</td>
</tr>
</tbody>
</table>
Enable External Data Collection for the Oracle Fusion Source System

Enable external data collection if you want to load transactional data from external systems. Typically, you do this if some of your supply chain processes are managed in external applications. You load the transactional data from these applications using file-based data imports (FBDI).

You can use external data sources for these functional areas: Inventory and Materials Management, Procurement, Order Management, and Manufacturing. When you enable external data collection for a functional area, be aware of these restrictions:

- You can't use configure-to-order, drop shipment, and back-to-back fulfillment.
- The entities associated with the functional area are no longer available for Oracle Fusion source collection. For example, if you enable Order Management, the Sales Orders entity won't be available on the Collect Planning Data page for you to select for Oracle Fusion source collection.

This table lists the entities for each functional area.

<table>
<thead>
<tr>
<th>Functional Area</th>
<th>Entities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory and Materials Management</td>
<td>On-hand Quantity and Transfer Orders</td>
</tr>
<tr>
<td>Procurement</td>
<td>Purchase Orders and Requisitions</td>
</tr>
<tr>
<td>Order Management</td>
<td>Sales Orders and Reservations</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>Work Order Supplies, Resource Availability, Resources, Work Definitions, and Item Structures</td>
</tr>
</tbody>
</table>
Enable External Data Collection

Use these steps to enable external data collection:

1. Select the Manage Planning Source Systems task in the Tasks panel from any Supply Planning work area page. Or use this task in the Setup and Maintenance work area:
   - Offering: Supply Chain Planning
   - Functional Area: Supply Chain Planning Configuration
   - Task: Manage Planning Source Systems

2. In the list of source systems, select the row that has Oracle Fusion in the Version column.

3. In the Actions menu, click Select Data Sources.

4. Select the Enable External Data check box, and then select the functional areas that you want to source transactional entities for.

   Note: Every time you enable or disable external data collection, you must run a targeted data collection to ensure complete refresh of data in the data repository.

Collect Planning Data from the Oracle Fusion Source System

How You Collect Different Data Types for Supply Chain Planning

When you collect data, you collect data from three categories: reference data, demand data, and supply data. On the Collect Planning Data page there is a tab for each of these categories.

The collected data are stored in the planning data repository.
The following figure illustrates the three categories of data that you collect from the Oracle Fusion source system to the planning data repository.

Explanation of Callouts

1. Reference data is primarily sourced from Oracle Fusion SCM Cloud.
2. Demand data comes from Oracle Order Management Cloud Service and Oracle Materials Management Cloud Service.
3. Supply data is sourced from Oracle Inventory Management Cloud Service, Oracle Manufacturing Cloud Service, and Oracle Purchasing Cloud Service.

**Reference Data**

The collection process begins with reference data, which is primarily sourced from Oracle Fusion SCM Cloud. You collect the data collection entities, such as basic item, resource, organization, customers and suppliers, and calendar data.

*Note:* Oracle Fusion Sales and Operations Planning uses the Bill of Resources entity to link the make items with their associated components and resource requirements. For more information on collecting Bill of Resources from an external source system, see the Loading Planning Data from Files section.

You also use Oracle Supply Chain Planning Cloud to collect the following items:

- Item structures: To explode item-level demand into component demands and supplies.
- Work Definitions: To assign the component and resource requirements for make items.
- Units of measure: To align plan data and to convert plans from one set of units to another.
- Costs: To review plans in financial terms and evaluate the financial impact of planning decisions.
Demand Data
You collect demand data from two potential sources:

- Sales orders that flow from Oracle Order Management Cloud Service: You can use this as the basis of the demand forecast, while current orders can consume the demand in near-term forecast time buckets.
- Shipment history from Oracle Materials Management Cloud Service: You can use this to generate a shipments forecast.

Supply Data
You collect supply data from three sources:

- Oracle Inventory Management Cloud Service: This provides data related to on hand inventory, reservations, material transfers, in-transit supplies, and receipts.
- Oracle Manufacturing Cloud Service: This provides work in process status and any manufacturing work orders.
- Oracle Purchasing Cloud Service: This provides purchase requisitions and purchase orders.

Collection Filters and Collection Templates
You use collection filters and collection templates when you need to collect some common set of entities repeatedly. The collection filters and collection templates are located on the Collect Planning Data page. To open the Collect Planning Data page, click the Collect Planning Data task from one of the Supply Chain Planning work areas. Depending on your security privileges, you can also open the Collect Planning Data page from the Setup and Maintenance work area. In the Setup and Maintenance work area, use the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Collect Planning Data

Collection Filters
Use collection filters to improve the performance and efficiency of the collections process, and to avoid accumulation of irrelevant data in the planning data repository. You can use several filter criteria while performing collections, such as by employing catalogs, order types, and price lists. You can also use date-based filters for collecting shipment and booking history information.

Enabling Collection Filters
To enable collection filters, you must first run the schedule process called Load Filter Names for Planning Data Collection from the Scheduled Processes work area. When you run the scheduled process, the filters get enabled in the Collect Planning Data page. Then, you can apply the filters from the next collection.

Collection Templates
Use collection templates when you want to collect a set of data repeatedly over a period. You can select either one of the predefined templates that serves your specific need, or you can create your own template and save it for future use.

When you select a predefined template from the list, the Collection Type field is defaulted to **Automatic selection** and you cannot edit the field. Also, when you select a predefined template, the Select Collection Filters field is disabled.
You can create a collection template on the Collect Planning Data page by selecting the data collection entities and saving the template for future use. For example, if you frequently collect certain supply planning transactional entities, such as On Hand, Purchase Orders, and Purchase Requisitions, then save these entities as a collection template. It reduces the overhead of selecting the same entities for subsequent collection cycles.

If the template file contains any error during the upload process, rectify the issue found in the log file and upload the template file again.

**Collect Data Using Targeted Collection Type**

To perform a complete refresh of the data repository used by the Supply Chain Planning products, run a targeted collection. You can run the targeted collection immediately or you can schedule the process to run later. Demand planning data can only be collected by using the Targeted collection type.

| Note: Before collecting demand planning data, you must successfully run the **Load Filter Names for Planning Data Collection** scheduled process. |

Perform the following steps to collect reference data, demand planning data, and supply planning data using the Targeted collection type.

1. Access the Collect Planning Data page from a Supply Planning work area or the Setup and Maintenance work area.
   - If you are in one of the Supply chain Planning work areas:
     - Click the Tasks panel tab.
     - In the Tasks panel drawer, click the **Collect Planning Data** link.
   - If you are in the Setup and Maintenance work area, then select the following:
     - **Offering**: Supply Chain Planning
     - **Functional Area**: Supply Chain Planning Configuration
     - **Task**: Collect Planning Data

2. On the Collect Planning Data page, complete the following steps.
   - On the Parameters tab:
     - Select your source system.
     - For the collection type, select Targeted.
     - Demand planning data can only be collected by using the Targeted collection type.
     - Click **Select Collection Filters** to select the collection filters.
   - On the Reference Data subtab, move the required reference entities to the Selected Entities area.
   - On the Demand Planning Data subtab, set options to collect the historical demand data in the planning data repository. The planning process uses the historical demand data for statistical forecasting.
     - **Collection Time Frame Options**: You can specify a fixed or rolling date range for which to collect data.
     - The **Fixed Date Range** option enables you to collect history data within a fixed date range that you specify.
The **Rolling Date Range** option enables you to collect the history data for the number of days that you specify. For example, if you forecast weekly, specify 7 in the **Number of Days to Collect** field to collect the demand history data once per week. The data collections collect the demand history data for the latest week.

Select **Roll off time periods automatically** to truncate the history data by the number of days that you specify in the **Number of days to keep** field each time you run collections for the demand history data. For example, if you prefer to forecast each week based on the history data of 52 weeks, select the **Roll off time periods automatically** check box and specify **Number of days to keep** as 364 days. This setting ensures that as you collect data every week, you keep the most recent history of 52 weeks and automatically purge history data older than 52 weeks.

- **History Measures and Attributes**: Select your shipments history and bookings history measures.
- **Collection for ETO Items**: Select **Collect history from associated base models** to collect bookings and shipments history for Engineer to Order (ETO) items from the associated base models. When you don't select this option, the history is collected from the standard ETO items.
- **History Data Options**: To collect only specific order types, select from the **Order Types to Include** list of values. By default, all order types are included.

Select **Organization - Consumption Inventory Transactions to Include** to collect consumption inventory transactions at the organization level. You can collect only the transfer orders inventory transactions or all consumption inventory transactions.

Select **Subinventory - Consumption Inventory Transactions to Include** to collect consumption inventory transactions at the subinventory level. You can collect only the transfer orders inventory transactions or all consumption inventory transactions for the organizations that you enabled for subinventory planning.

Select the **Collect amount data for history** check box to collect amount data.

- **Additional Options**: Select additional options for collections.

  - **Collect Price Lists**: Collect the price lists specified in the collections filter for price lists, or collect all price lists if no filter is specified.

  - **Collect Configure to Order Data**: If you selected history measures and attributes, then select the relevant check boxes to collect shipment history options and booking history options.

  - **Sales Organization Hierarchy**: Select **Enable sales organization hierarchy collection** to collect one or more sales hierarchies.

  - On the **Supply Planning Data** subtab:
    1. Move the required supply entities to the Selected Entities area.
    2. If you collect resource availability, then select a date range type: **Fixed** or **Relative to collection run date**.

If you selected **Fixed**, then provide a start date and an end date for collecting resource availability.

If you selected **Relative to collection run date**, then enter a number of days in the **Collection Window in Days** field. The number that you enter determines a collection window in days to collect resource availability based on a rolling time window. That rolling time window adjusts itself, based on the date that you run collections. For example, if you specify 90, then resource availability is collected for the next 90 days each time from the date of the collection run.
Note: You can save your date range type selection for resource availability collection as a collection template to use later.

iii. You can collect the existing data for the resource availability.
iv. You can also regenerate the resource availability data and then collect the data. If you select the Regenerate data, and then collect option, the collections process runs the Update Resource Availability Job scheduled process first and then collects the resource availability data.

3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different time.
4. Click Submit to start the collections process.
5. Monitor the collection status using the Scheduled Processes page.
6. Review the collected data in the Plan Inputs work area.

Related Topics
- Set Up Forecast Consumption for Transfer Orders

Collect Data Using Net Change Collection Type

You can collect data from the Oracle Fusion source system by running the net change collection or by scheduling to run the process later. Before running a Net Change collection, you must run a Targeted collection for the selected entities. After the first Targeted collection, you can run Net Change collections.

Perform the following procedure to collect reference data and supply planning data using the net change collection type:

1. If you are in one of the Supply Chain Planning work areas, then click the Tasks panel tab. In the Tasks panel drawer, click the Collect Planning Data task. If you are in the Setup and Maintenance work area, then use the following:
   - Offering: Supply Chain Planning
   - Functional Area: Supply Chain Planning Configuration
   - Task: Collect Planning Data
2. Complete the following parameters for the Collect Planning Data process:
   a. Select your source system.
   b. Select the collection type as Net change.

   Note: You cannot make any changes to the filter criteria and demand planning data in the net change collection type.
   c. In the Reference Data tab, move the required reference entities to the Selected Entities area.
   d. In the Supplies Planning Data tab, move the required supply entities to the Selected Entities area.
3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different time.
4. Click Submit to initiate the collections process.
5. Monitor the collection status using the Scheduled Processes page.
6. Review the collected data in the Plan Inputs work area.
Enable Organization Group Collection for the Net Change Collection Type

You can use organization groups to limit the net change data collection from a source system to specific organizations. Using organization groups for collection also eliminates the chances of data overlap when multiple instances of net change collections are run at a time. Planners can run collections for their organizations without waiting for each other.

Let's take a simple example where your organization considers only the D1 and D2 distribution centers in your source system for shipments to your customers. In such a case, you can create an organization group, assign D1 and D2 to the organization group, and collect net change data specifically for this group.

**Note:** Before you begin, ensure that you have your organization groups created. A supply planner creates and manages organization groups using the Manage Organization Groups button on the Maintain Supply Network Model page.

Do these to collect net change data for an organization group.

1. Access the Collect Planning Data page or Load Planning Data from Files page from a Supply Planning work area.
2. Select the source system. Organization groups are managed within the source systems.
3. Select the Net Change collection type. You can select an organization group for data collection only when the collection type is Net Change.
4. Enable the organization group collection, and then select an organization group.
5. Perform the net change data collection. Refer to the Collect Data Using Net Change Collection Type topic in this chapter for instructions.

**Note:** After selecting your organization group and other data collection entities, you can also save your selections as a template. Refer to the Collection Filters and Collection Templates topic in this chapter for additional information.

Load Planning Data from Others and External Source Systems

How You Load Planning Data from Files

You upload data using CSV files for specific business objects using the targeted or net change method.

**Note:** To create the CSV files, you can use a set of Microsoft Excel template files that are provided for this purpose. You can download the templates from the File-Based Data Import for SCM Cloud guide in the Oracle Help Center.
You use the targeted mode when you want to refresh data for selected entities in the planning data repository. You use the net change mode to collect data incrementally. The net change collections mode collects only the changed or new data. Data collection using the net change mode is fast compared to the targeted mode. The net change mode is used to retain planning data to current with that of the executing system.

The following figure illustrates the process of collecting data from files.

To load planning data from files, you perform the following steps:

1. Create CSV files using Microsoft Excel template
2. Run the process to load planning data from files
3. Verify the load planning data process
4. Review the loaded data

Create CSV Files to Load Planning Data

To perform the Load Planning Data from Files task in one of the Supply Chain Planning work areas or Setup and Maintenance work area, you must prepare the data you want to load. You must create the necessary CSV files used to create files for import. This procedure explains how to create CSV files to prepare planning data for loading.

1. Locate the applicable file import templates (XLSM files) in the following guide: File Based Data Import for Oracle Supply Chain Management Cloud. Extract the templates to a local space.
For additional information about creating and importing CSV files, see the following section in the Oracle SCM Cloud Implementing Common Features for Oracle SCM Cloud guide: External Integration chapter, External Data Integration Services for Oracle Cloud section.

2. Open the template file for the entity you are preparing and complete the file import template worksheet.

You must enable the macros in the template file before generating the CSV file.

**Caution:** For the cells that contain dates, ensure that the data is set to the correct format in the data type. For example, date must be set to YYYY/MM/DD.

3. After you finish preparing the data in the worksheet, generate the CSV file. The Generate CSV File button is located in the Instructions and CSV Generation worksheet of the workbook.

4. When you save the generated CSV file, you must use the suggested name of the entity. You can add underscore and add additional characters to the file name. For example, you can name the CSV file as ShipmentHistory_abc.csv and you can name the file as LoadingCSV.zip.

5. Compress the CSV file into a zipped file format using a compression utility. You can provide any name to the zipped file.

**Note:** You can include multiple CSV files in a single compressed file for a source system. The load process uploads them in a sequential order. Select the CSV files and compress them directly. Do not compress the parent folder that contains the files.

This completes the preparation of a file that you will upload to collect planning data.

**Data Collection Sequence**

This topic explores the sequence that you should follow for data collection. Data collection involves collecting entities in a pre-defined sequence. The collected entities form the basis for supply planning calculations. To have accurate data, you must ensure to collect the entities in a proper sequence. You cannot collect some entities without collecting their precursor entities. The data collection sequence is very crucial when you collect data from an external source system using CSV files.

If you run targeted collections for all entities, you can ignore the sequence for collections because targeted collections automate the collection sequence for all entities within a single collections request. If you collect many entities in a single request, collections will process them according to the sequences shown in this topic. If you collect only a few entities, then you must be aware of the collections sequence information. For example, you should not collect work orders before you collect items or resources.

To make the workflow simple, the collection sequence is divided into two parts - Part A and Part B. The collection entities in Part B are dependent on the collection entities in Part A. You must collect the entities in Part A before you collect the entities in Part B. Also, the collection entities are grouped together for easier presentation. The data groups in Part A are:

- Collections Sequence Part A for Item Data
- Collections Sequence Part A for Region, Location, and Customer Data
- Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data
The data groups in Part B are:

- Collections Sequence Part B for Sales Order and Assignment Sets
- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Every collection sequence in Part A starts with defining a source system where the collected data will reside. If you are collecting data to the same source system, you define the source system only once. Then, use the same source system to collect all the entities.

The following figure provides an overview of the data collection sequence. The overview shows how Part A and Part B fit together to form a complete data collection flow.

Note: The Organization entity is marked with an asterisk because you can collect other entities such as Planner, Item Cost, Subinventory, Carrier, Calendar Assignment, Supplier, and Supplier Site after collecting Organization. For more information on the collection sequence for these entities, see the Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data figure. Refer to the entities that are collected after Organization. Also, ensure that you collect Location before collecting Supplier Site.
When you collect the data described here, continue to the collection sequence Part B described in the following subsections.

- Collection Sequence Part B for Sales and Order and Assignment Sets
- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure
Collections Sequence Part A for Region, Location, and Customer Data

The following image shows the collections sequence to follow while collecting Regions, and Customers data from external source systems. This image represents only half of the entities for Item data.

Collection Sequence Part A for Region, Location, and Customers Data

Define Source System ➔ Load Customers, Regions in TCA ➔ Load Customer Sites in TCA

Location ➔ Customer ➔ Region

Customer Sites ➔ Calendar Assignments ➔ Continue to Collection Sequence Part B

Customer Specific Item Relationships ➔ Ship Methods ➔ Sourcing Rules, Sourcing Assignments, Source Organization, Receipt Organization

When you collect the data described here, continue to the collection sequence Part B described in the following subsections.

- Collection Sequence Part B for Sales and Order and Assignment Sets
- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure
Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data

The following image shows the collections sequence to follow while collecting Currency, Calendar, Demand Class, and UOM data from external source systems. Also, ensure that you collect Location before collecting Supplier Site.

**Note:** The Calendar entity is marked with an asterisk because there are other entities that are associated with Calendar that you must collect in a sequence. To collect other entities associated with Calendar, see the Calendar Upload Sequence figure.

Collection Sequence Part A for Currency, Calendar, Demand Class and UOM Data

1. **Define Source System**
2. **Currency**
   - Currency Conversion Type
   - Currency Conversion Rate
3. **Calendar**
4. **Demand Class**
5. **UOM**
6. **Location**
7. **Organization**
8. **UOM Conversions**
9. **UOM Class Conversions**

Continue to the next diagram
When you collect the data described here, continue to the collection sequence Part B described in the following subsections.

- Collection Sequence Part B for Sales and Order and Assignment Sets
- Collection Sequence Part B for Work Orders, Work Definition, and Item Structure
Collection Sequence for Calendar Data

The following image shows the collections sequence to follow for collecting the Calendar data. Calendar data is a part of the data collection in Part A. You collect the Calendar data in the following subsection: Collection Sequence Part A for Currency, Calendar, Demand Class, and UOM Data.

**Calendar Upload Sequence**

- Calendar
  - Calendar Shifts
  - Calendar Exceptions
  - Period Start Days
  - Week Start Dates
  - Calendar Workday Pattern
  - Generate Calendar Dates Post Collection
Collections Sequence Part B for Sales Order and Assignment Sets

The following image shows the collections sequence to follow while collecting Sales Order and Assignment Sets data from external source systems. The data entities in Part B are dependent on Part A. So, you must collect entities listed in Part A before you collect the entities in Part B.
Collection Sequence Part B for Work Orders, Work Definition, and Item Structures

The following image shows the collections sequence to follow while collecting Work Orders, Work Definition, and Item Structure data from external source systems. The data entities in Part B are dependent on Part A. So, you must collect entities listed in Part A before you collect the entities in Part B.

Import Templates Used to Create CSV Files for Supply Chain Planning

You can use the Microsoft Excel templates (XLSM files) to prepare the data for the supported collection entities. The templates are listed in the following guide: File-Based Data Import for Oracle Supply Chain Management Cloud. Extract
the templates to a local drive, enter appropriate data as described in the template, and generate CSV files. Compress the CSV files to a zipped file format and upload the .zip file to the Universal Content Manager using the File Import and Export utility. The data is then loaded from the Universal Content Manager to the planning data repository.

**Collect Data from the Oracle Fusion Source**

The following table lists the collections entities that can be loaded into the planning data repository for the Oracle Fusion source. The Collection Entity column provides the name of the entities for which you can collect the data. The XLSM File Name column provides the template name that you will download for the respective collection entity. Download the XLSM template from the File-Based Data Import for Oracle Supply Chain Management Cloud guide (FBDI guide). The Link in Data Import Guide column provides the name of the topic in the FBDI guide from where you will download the template. For example, to collect data for the Item Costs collection entity, refer to the Item Cost Import topic in the FBDI guide.

<table>
<thead>
<tr>
<th>Collections Entity</th>
<th>Link in Data Import Guide</th>
<th>XLSM File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Costs</td>
<td>Supply Chain Planning Item Cost</td>
<td>ScpItemCostImportTemplate. xlsm</td>
</tr>
<tr>
<td>Customer Specific Item Relationships</td>
<td>Supply Chain Planning Item Substitute</td>
<td>ScpItemSubstituteImportTemplate. xlsm</td>
</tr>
<tr>
<td>Planners</td>
<td>Supply Chain Planning Planners</td>
<td>ScpPlannersImportTemplate. xlsm</td>
</tr>
<tr>
<td>Item Suppliers</td>
<td>Supply Chain Planning Approved Supplier List</td>
<td>ScpApprovedSupplierListImportTemplate. xlsm</td>
</tr>
<tr>
<td>Demand Classes</td>
<td>Supply Chain Planning Demand Classes</td>
<td>ScpDemandClassImportTemplate. xlsm</td>
</tr>
<tr>
<td>Allocation Assignments and Allocation Rules</td>
<td>Supply Chain Planning Planning Allocation Rules</td>
<td>ScpPlanningAllocationRulesImportTemplate. xlsm</td>
</tr>
<tr>
<td>ATP Assignments and ATP Rules</td>
<td>Supply Chain Planning Available-to-Promise Rules</td>
<td>ScpATPRulesImportTemplate. xlsm</td>
</tr>
<tr>
<td>Supply Update Rules</td>
<td>Supply Chain Planning Real Time Supply Updates</td>
<td>ScpRealTimeSupplyUpdatesImportTemplate. xlsm</td>
</tr>
<tr>
<td>Measures</td>
<td>Supply Chain Planning Measures</td>
<td>ScpMeasuresImportTemplate. xlsm</td>
</tr>
<tr>
<td>Booking History</td>
<td>Supply Chain Planning Bookings History</td>
<td>ScpBookingHistoryImportTemplate. xlsm</td>
</tr>
<tr>
<td>Collections Entity</td>
<td>Link in Data Import Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
</tr>
<tr>
<td>Option Booking History</td>
<td>Supply Chain Planning Option Bookings History</td>
<td>ScpOptionBookingHistoryImportTemplate.xlsm</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
</tr>
<tr>
<td>Shipment History</td>
<td>Supply Chain Planning Shipments History</td>
<td>ScpShipmentHistoryImportTemplate.xlsm</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
</tr>
<tr>
<td>Option Shipment History</td>
<td>Supply Chain Planning Option Shipments History</td>
<td>ScpOptionShipmentHistoryImportTemplate.xlsm</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
</tr>
<tr>
<td>Price Lists</td>
<td>Supply Chain Planning Price List</td>
<td>ScpPriceListImportTemplate.xlsm</td>
</tr>
<tr>
<td>Collections Entity</td>
<td>Link in Data Import Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Causal Factors</td>
<td>Supply Chain Planning Causal Factors</td>
<td>ScpCausalFactorsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Forecast Measures</td>
<td>Supply Chain Planning Forecast Measures</td>
<td>ScpForecastMeasureImportTemplate. xlsm</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate. xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
</tr>
<tr>
<td>Fiscal Calendars</td>
<td>Supply Chain Planning Fiscal Calendars</td>
<td>ScpFiscalCalendarImportTemplate. xlsm</td>
</tr>
<tr>
<td>Forecasts</td>
<td>Supply Chain Planning External Forecasts</td>
<td>ScpExternalForecastImportTemplate. xlsm</td>
</tr>
<tr>
<td>Safety Stock Levels</td>
<td>Supply Chain Planning Safety Stock Levels</td>
<td>ScpSafetyStockLevelImportTemplate. xlsm</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>Supply Chain Planning Approved Supplier Capacity</td>
<td>ScpApprovedSupplierCapacityImportTemplate. xlsm</td>
</tr>
<tr>
<td>Planned Order Supplies</td>
<td>Supply Chain Planning Planned Order Supply</td>
<td>ScpPlannedOrderSupplyImportTemplate. xlsm</td>
</tr>
<tr>
<td>Sourcing Rule and Assignments</td>
<td>Supply Chain Planning Sourcing Rules</td>
<td>ScpSourcingImportTemplate. xlsm</td>
</tr>
<tr>
<td>Cross-Reference Mapping Information</td>
<td>Supply Chain Planning Cross-Reference Data</td>
<td>ScpCrossReferenceDataImportTemplate. xlsm</td>
</tr>
</tbody>
</table>

**Collect Data from External Source - Version Others**

The following table lists the collections entities that can be loaded into the planning data repository from an external source, where the version is Others. The Collection Entity column provides the name of the entities for which you can collect the data. The XLSM File Name column provides the template name that you will download for the respective collection entity. Download the XLSM template from the File-Based Data Import for Oracle Supply Chain Management Cloud guide (FBDI guide). The Link in Data Import Guide column provides the name of the topic in the FBDI guide from where you will download the template. For example, to collect data for the Items and Item Costs collection entities, refer to the Item Cost Import topic in the FBDI guide.
<table>
<thead>
<tr>
<th>Collections Entity</th>
<th>Link in Data Import Guide</th>
<th>XLSM File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Costs</td>
<td>Supply Chain Planning Item Cost</td>
<td>ScpiItemCostImportTemplate. xlsm</td>
</tr>
<tr>
<td>Customer Specific Item Relationships</td>
<td>Supply Chain Planning Item Substitute</td>
<td>ScpiItemSubstituteImportTemplate. xlsm</td>
</tr>
<tr>
<td>Planners</td>
<td>Supply Chain Planning Planners</td>
<td>ScpiPlannersImportTemplate. xlsm</td>
</tr>
<tr>
<td>Organizations (Warehouses) and Organization Site (Including Organization Site - Internal Location Mapping)</td>
<td>Supply Chain Planning Organizations</td>
<td>ScpOrganizationImportTemplate. xlsm</td>
</tr>
<tr>
<td>Subinventories</td>
<td>Supply Chain Planning Subinventories</td>
<td>ScpSubInventoryImportTemplate. xlsm</td>
</tr>
<tr>
<td>Suppliers and Supplier Sites</td>
<td>Supply Chain Planning Suppliers</td>
<td>ScpPlanningSupplierImportTemplate. xlsm</td>
</tr>
<tr>
<td>Item Suppliers</td>
<td>Supply Chain Planning Approved Supplier List</td>
<td>ScpApprovedSupplierListImportTemplate. xlsm</td>
</tr>
<tr>
<td>Interlocation Shipping Networks</td>
<td>Supply Chain Planning Interlocation Shipping Methods</td>
<td>ScpInterLocationShipMethodsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Currencies, Currency Conversion Types, and Currency Conversion Rates</td>
<td>Supply Chain Planning Currencies</td>
<td>ScpCurrencyImportTemplate. xlsm</td>
</tr>
<tr>
<td>Units of Measure, Units of Measure Conversions, and Units of Measure Class Conversions</td>
<td>Supply Chain Planning Units of Measure</td>
<td>ScpUOMImportTemplate. xlsm</td>
</tr>
<tr>
<td>Calendars, Calendar Exceptions, Calendar Shifts, Week Start Dates, Period Start Dates, and Calendar Shift Workday Pattern</td>
<td>Supply Chain Planning Calendars</td>
<td>ScpCalendarImportTemplate. xlsm</td>
</tr>
<tr>
<td>Calendar Associations</td>
<td>Supply Chain Planning Calendar Assignments</td>
<td>ScpCalendarAssignmentsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Demand Classes</td>
<td>Supply Chain Planning Demand Classes</td>
<td>ScpDemandClassImportTemplate. xlsm</td>
</tr>
<tr>
<td>Ship Mode of Transport, Ship Class of Service, and Carrier</td>
<td>Supply Chain Planning Carriers</td>
<td>ScpCarrierImportTemplate. xlsm</td>
</tr>
<tr>
<td>Allocation Assignments and Allocation Rules</td>
<td>Supply Chain Planning Planning Allocation Rules</td>
<td>ScpPlanningAllocationRulesImportTemplate. xlsm</td>
</tr>
<tr>
<td>Collections Entity</td>
<td>Link in Data Import Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td>ATP Assignments and ATP Rules</td>
<td>Supply Chain Planning Available-to-Promise Rules</td>
<td>ScpATPRulesImportTemplate. xlsx</td>
</tr>
<tr>
<td>Supply Update Rule</td>
<td>Supply Chain Planning Real Time Supply Updates</td>
<td>ScpRealTimeSupplyUpdatesImportTemplate. xlsx</td>
</tr>
<tr>
<td>Freight Terms, FOB Points, Invoicing and Accounting Rules, Shipment Priorities,</td>
<td>Supply Chain Planning Order Orchestration</td>
<td>ScpOrderOrchestrationImportTemplate. xlsx</td>
</tr>
<tr>
<td>Payment Terms, Return Reason, Tax Classification Code, Tax Exemption Reason,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Credit Type, Activity Type, Document Categories, Payment Methods, and</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Receipt Methods</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Measures</td>
<td>Supply Chain Planning Measures</td>
<td>ScpMeasuresImportTemplate. xlsx</td>
</tr>
<tr>
<td>Booking History</td>
<td>Supply Chain Planning Bookings History</td>
<td>ScpBookingHistoryImportTemplate. xlsx</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>template ScpMeasuresImportTemplate. xlsx but will continue to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>be supported. Future enhancements will be made only to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>generic measures template.</td>
</tr>
<tr>
<td>Option Booking History</td>
<td>Supply Chain Planning Option Bookings History</td>
<td>ScpOptionBookingHistoryImportTemplate. xlsx</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>template ScpMeasuresImportTemplate. xlsx but will continue to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>be supported. Future enhancements will be made only to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>generic measures template.</td>
</tr>
<tr>
<td>Shipment History</td>
<td>Supply Chain Planning Shipments History</td>
<td>ScpShipmentHistoryImportTemplate. xlsx</td>
</tr>
<tr>
<td>Collections Entity</td>
<td>Link in Data Import Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option Shipment History</td>
<td>Supply Chain Planning Option Shipments History</td>
<td>ScpOptionShipmentHistoryImportTemplate.xlsm</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
</tr>
<tr>
<td>Price Lists</td>
<td>Supply Chain Planning Price Lists</td>
<td>ScpPriceListImportTemplate.xlsm</td>
</tr>
<tr>
<td>Causal Factors</td>
<td>Supply Chain Planning Causal Factors</td>
<td>ScpCausalFactorsImportTemplate.xlsm</td>
</tr>
<tr>
<td>Forecasts Measures</td>
<td>Supply Chain Planning Forecast Measures</td>
<td>ScpForecastMeasureImportTemplate.xlsm</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
</tr>
<tr>
<td>Fiscal Calendars</td>
<td>Supply Chain Planning Fiscal Calendars</td>
<td>ScpFiscalCalendarImportTemplate.xlsm</td>
</tr>
<tr>
<td>Forecasts</td>
<td>Supply Chain Planning External Forecast</td>
<td>ScpExternalForecastImportTemplate.xlsm</td>
</tr>
<tr>
<td>User-Defined Hierarchies</td>
<td>Supply Chain Planning User-Defined Hierarchies</td>
<td>ScpUserDefinedHierarchyImportTemplate.xlsm</td>
</tr>
<tr>
<td>Collections Entity</td>
<td>Link in Data Import Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Safety Stock Levels</td>
<td>Supply Chain Planning Safety Stock Levels</td>
<td>ScpSafetyStockLevelImportTemplate.xlsx</td>
</tr>
<tr>
<td>Supply Reservations to Sales Orders</td>
<td>Supply Chain Planning Reservations</td>
<td>ScpReservationImportTemplate.xlsx</td>
</tr>
<tr>
<td>On Hand</td>
<td>Supply Chain Planning Supply On Hand</td>
<td>ScpOnhandImportTemplate.xlsx</td>
</tr>
<tr>
<td>Purchase Orders, Purchase Requisitions, PO in Receiving, and In Transits</td>
<td>Supply Chain Planning Purchase Order Requisitions</td>
<td>ScpPurchaseOrderRequisitionImportTemplate.xlsx</td>
</tr>
<tr>
<td>Transfer Orders</td>
<td>Supply Chain Planning Transfer Orders</td>
<td>ScpTransferOrderImportTemplate.xlsx</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>Supply Chain Planning Approved Supplier Capacity</td>
<td>ScpApprovedSupplierCapacityImportTemplate.xlsx</td>
</tr>
<tr>
<td>Resources and Resource Shifts</td>
<td>Supply Chain Planning Resources</td>
<td>ScpResourcesImportTemplate.xlsx</td>
</tr>
<tr>
<td>Resource Availability</td>
<td>Supply Chain Planning Resource Availability</td>
<td>ScpResourceAvailabilityImportTemplate.xlsx</td>
</tr>
<tr>
<td>Work Definition (including mapping between Item Structures and Work Definitions), Work Definition Operations, and Work Definition Operation Resources</td>
<td>Supply Chain Planning Routings</td>
<td>ScpRoutingsImportTemplate.xlsx</td>
</tr>
<tr>
<td>Work Order Supply</td>
<td>Supply Chain Planning Work Order Supplies</td>
<td>ScpWorkOrderSuppliesImportTemplate.xlsx</td>
</tr>
<tr>
<td>Work Order Material Requirements</td>
<td>Supply Chain Planning Work Order Component Demands</td>
<td>ScpWIPComponentDemandsImportTemplate.xlsx</td>
</tr>
<tr>
<td>Work Order Resource Requirements</td>
<td>Supply Chain Planning Work Order Operation Resources</td>
<td>ScpWIPOperationResourceImportTemplate.xlsx</td>
</tr>
<tr>
<td>Planned Order Supplies</td>
<td>Supply Chain Planning Planned Order Supply</td>
<td>ScpPlannedOrderSupplyImportTemplate.xlsx</td>
</tr>
<tr>
<td>Sourcing Rule and Assignments</td>
<td>Supply Chain Planning Sourcing Rules</td>
<td>ScpSourcingImportTemplate.xlsx</td>
</tr>
<tr>
<td>Cross Reference Mapping Information</td>
<td>Supply Chain Planning Cross-Reference Data</td>
<td>ScpCrossReferenceDataImportTemplate.xlsx</td>
</tr>
</tbody>
</table>
Collect Data from External Source - Version External

The following table lists the collections entities that can be loaded into the planning data repository from an external source, where the version is External. The Collection Entity column provides the name of the entities for which you can collect the data. The XLSM File Name column provides the template name that you will download for the respective collection entity. Download the XLSM template from the File-Based Data Import for Oracle Supply Chain Management Cloud guide. The Link in Data Import Guide column provides the name of the topic in the File-Based Data Import for Oracle Supply Chain Management Cloud guide (FBDI guide) from where you will download the template. For example, to collect data for the Items and Item Costs collection entities, refer to the Item Cost Import topic in the File-Based Data Import for Oracle Supply Chain Management Cloud guide. All the planning-related entity names are prefixed with Supply Chain Planning in the FBDI guide.

<table>
<thead>
<tr>
<th>Collection Entities</th>
<th>Link in FBDI Guide</th>
<th>XLSM File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>Supply Chain Planning Items</td>
<td>ScpItemImportTemplate. xlsm</td>
</tr>
<tr>
<td>Item Costs</td>
<td>Supply Chain Planning Item Cost</td>
<td>ScpItemCostImportTemplate. xlsm</td>
</tr>
<tr>
<td>Item Relationships</td>
<td>Supply Chain Planning Item Substitute</td>
<td>ScpItemSubstituteImportTemplate. xlsm</td>
</tr>
<tr>
<td>Catalogs, Categories, and Item Categories</td>
<td>Supply Chain Planning Catalogs</td>
<td>ScpCatalogImportTemplate. xlsm.xlsm</td>
</tr>
<tr>
<td>Item Structures</td>
<td>Supply Chain Planning Item Structures</td>
<td>ScpBillofMaterialImportTemplate. xlsm</td>
</tr>
<tr>
<td>Bill of Resources</td>
<td>Supply Chain Planning Bill of Resources</td>
<td>ScpBillOfResourcesImportTemplate. xlsm</td>
</tr>
<tr>
<td>Planners</td>
<td>Supply Chain Planning Planners</td>
<td>ScpPlannersImportTemplate. xlsm</td>
</tr>
<tr>
<td>Customers and Customer Sites</td>
<td>Supply Chain Planning Customers</td>
<td>ScpCustomerImportTemplate. xlsm</td>
</tr>
<tr>
<td>Regions</td>
<td>Supply Chain Planning Regions</td>
<td>ScpRegionsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Zones</td>
<td>Supply Chain Planning Zones</td>
<td>ScpZonesImportTemplate. xlsm</td>
</tr>
<tr>
<td>Region-Zone Mapping</td>
<td>Supply Chain Planning Region Zone Mappings</td>
<td>ScpRegionZoneMappingImportTemplate. xlsm</td>
</tr>
<tr>
<td>Locations and Region-Location Mapping</td>
<td>Supply Chain Planning Locations</td>
<td>ScpLocationsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Collection Entities</td>
<td>Link in FBDI Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Organizations and Organization Sites</td>
<td>Supply Chain Planning Organizations</td>
<td>ScpOrganizationImportTemplate. xlsm</td>
</tr>
<tr>
<td>Subinventories</td>
<td>Supply Chain Planning Subinventories</td>
<td>ScpSubInventoryImportTemplate. xlsm</td>
</tr>
<tr>
<td>Suppliers and Supplier Sites</td>
<td>Supply Chain Planning Suppliers</td>
<td>ScpSupplierImportTemplate. xlsm</td>
</tr>
<tr>
<td>Item Suppliers (Approved Supplier List)</td>
<td>Supply Chain Planning Approved Supplier List</td>
<td>ScpApprovedSupplierListImportTemplate. xlsm</td>
</tr>
<tr>
<td>Interlocation Shipping Networks and Transit Times</td>
<td>Supply Chain Planning Interlocation Shipping Methods</td>
<td>ScpInterLocationShipMethodsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Currencies and Currency Conversions</td>
<td>Supply Chain Planning Currencies</td>
<td>ScpCurrencyImportTemplate. xlsm</td>
</tr>
<tr>
<td>Units of Measure, Units of Measure Conversions, and Units of Measure Class Conversions</td>
<td>Supply Chain Planning Units of Measure</td>
<td>ScpUOMImportTemplate. xlsm</td>
</tr>
<tr>
<td>Calendars, Calendar Exceptions, Shifts, Shift Workday Pattern, Week Start Dates, and Period Start Dates</td>
<td>Supply Chain Planning Calendars</td>
<td>ScpCalendarImportTemplate. xlsm</td>
</tr>
<tr>
<td>Calendar Associations</td>
<td>Supply Chain Planning Calendar Assignments</td>
<td>ScpCalendarAssignmentsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Demand Classes</td>
<td>Supply Chain Planning Demand Classes</td>
<td>ScpDemandClassImportTemplate. xlsm</td>
</tr>
<tr>
<td>Carrier, Ship Mode of Transport, and Ship Class of Service</td>
<td>Supply Chain Planning Carriers</td>
<td>ScpCarrierImportTemplate. xlsm</td>
</tr>
<tr>
<td>GOP Allocation Rules and Rule Assignments</td>
<td>Supply Chain Planning Planning Allocation Rules</td>
<td>ScpPlanningAllocationRulesImportTemplate. xlsm</td>
</tr>
<tr>
<td>GOP ATP Rules and Rule Assignments</td>
<td>Supply Chain Planning Available-to-Promise Rules</td>
<td>ScpATPRulesImportTemplate. xlsm</td>
</tr>
<tr>
<td>GOP Supply Update Rules</td>
<td>Supply Chain Planning Real Time Supply Updates</td>
<td>ScpRealTimeSupplyUpdatesImportTemplate. xlsm</td>
</tr>
<tr>
<td>Order Orchestration Reference Objects: Freight Terms, FOB Points, Invoicing and Accounting Rules, Shipment Priorities, Payment Terms, Return Reason, Tax</td>
<td>Supply Chain Planning Order Orchestration</td>
<td>ScpOrderOrchestrationImportTemplate. xlsm</td>
</tr>
<tr>
<td>Collection Entities</td>
<td>Link in FBDI Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Classification Code, Tax Exemption Reason, Sales Credit Type, Activity Type, Document Categories, Payment Methods, and Receipt Methods</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cross Reference Mapping Information</td>
<td>Supply Chain Planning Cross-Reference Data</td>
<td>ScpCrossReferenceDataImportTemplate.xlsx</td>
</tr>
<tr>
<td>Measures</td>
<td>Supply Chain Planning Measures</td>
<td>ScpMeasuresImportTemplate.xlsx</td>
</tr>
<tr>
<td>Booking History</td>
<td>Supply Chain Planning Bookings History</td>
<td>ScpBookingHistoryImportTemplate.xlsx</td>
</tr>
<tr>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsx but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option Booking History</td>
<td>Supply Chain Planning Option Bookings History</td>
<td>ScpOptionBookingHistoryImportTemplate.xlsx</td>
</tr>
<tr>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsx but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shipment History</td>
<td>Supply Chain Planning Shipments History</td>
<td>ScpShipmentHistoryImportTemplate.xlsx</td>
</tr>
<tr>
<td><strong>Note:</strong> This template has been superseded by the generic template ScpMeasuresImportTemplate.xlsx but will continue to be supported. Future enhancements will be made only to the generic measures template.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option Shipment History</td>
<td>Supply Chain Planning Option Shipments History</td>
<td>ScpOptionShipmentHistoryImportTemplate.xlsx</td>
</tr>
<tr>
<td>Collection Entities</td>
<td>Link in FBDI Guide</td>
<td>XLSM File Name</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Price Lists</td>
<td>Supply Chain Planning Price Lists</td>
<td>ScpPriceListImportTemplate. xlsm</td>
</tr>
<tr>
<td>Causal Factors</td>
<td>Supply Chain Planning Causal Factors</td>
<td>ScpCausalFactorsImportTemplate. xlsm</td>
</tr>
<tr>
<td>Forecast Measures</td>
<td>Supply Chain Planning Forecast Measures</td>
<td>ScpForecastMeasureImportTemplate. xlsm</td>
</tr>
<tr>
<td>Fiscal Calendars</td>
<td>Supply Chain Planning Fiscal Calendars</td>
<td>ScpFiscalCalendarImportTemplate. xlsm</td>
</tr>
<tr>
<td>Measures, Sales and Operations Planning</td>
<td>Supply Chain Planning Measures</td>
<td>ScpMeasuresImportTemplate. xlsm</td>
</tr>
<tr>
<td>Backlog, Inventory, and Production History</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User-Defined Hierarchies</td>
<td>Supply Chain Planning User-Defined Hierarchies</td>
<td>ScpUser-DefinedHierarchyImportTemplate. xlsm</td>
</tr>
<tr>
<td>Forecasts</td>
<td>Supply Chain Planning External Forecasts</td>
<td>ScpExternalForecastImportTemplate. xlsm</td>
</tr>
<tr>
<td>Sales Orders</td>
<td>Supply Chain Planning Sales Orders</td>
<td>ScpSalesOrderImportTemplate. xlsm</td>
</tr>
<tr>
<td>Safety Stock Levels</td>
<td>Supply Chain Planning Safety Stock Levels</td>
<td>ScpSafetyStockLevelImportTemplate. xlsm</td>
</tr>
<tr>
<td>Supply Reservations to Sales Orders</td>
<td>Supply Chain Planning Reservations</td>
<td>ScpReservationImportTemplate. xlsm</td>
</tr>
</tbody>
</table>

**Note:** This template has been superseded by the generic template ScpMeasuresImportTemplate. xlsm but will continue to be supported. Future enhancements will be made only to the generic measures template.
<table>
<thead>
<tr>
<th>Collection Entities</th>
<th>Link in FBDI Guide</th>
<th>XLSM File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hand</td>
<td>Supply Chain Planning Supply On Hand</td>
<td>ScpOnhandImportTemplate. xslm</td>
</tr>
<tr>
<td>Purchase Orders, Purchase Requisitions, PO in Receiving, In Transits</td>
<td>Supply Chain Planning Purchase Order Requisitions</td>
<td>ScpPurchaseOrderRequisitionImportTemplate. xslm</td>
</tr>
<tr>
<td>Transfer Orders (including expense type transfers)</td>
<td>Supply Chain Planning Transfer Orders</td>
<td>ScpTransferOrderImportTemplate. xslm</td>
</tr>
<tr>
<td>Supplier Capacity</td>
<td>Supply Chain Planning Approved Supplier Capacity</td>
<td>ScpApprovedSupplierCapacityImportTemplate. xslm</td>
</tr>
<tr>
<td>Resources, Resource Shifts</td>
<td>Supply Chain Planning Resources</td>
<td>ScpResourceImportTemplate. xslm</td>
</tr>
<tr>
<td>Resource Availability</td>
<td>Supply Chain Planning Resource Availability</td>
<td>ScpResourceAvailabilityImportTemplate. xslm</td>
</tr>
<tr>
<td>Work Definition (including mapping between Item Structures and Work Definitions), Work Definition Operations</td>
<td>Supply Chain Planning Routings</td>
<td>ScpRoutingsImportTemplate. xslm</td>
</tr>
<tr>
<td>Work Order Supply</td>
<td>Supply Chain Planning Work Order Supplies</td>
<td>ScpWorkOrderSuppliesImportTemplate. xslm</td>
</tr>
<tr>
<td>Work Order Material Requirements</td>
<td>Supply Chain Planning Work Order Component Demands</td>
<td>ScpWIPComponentDemandsImportTemplate. xslm</td>
</tr>
<tr>
<td>Work Order Resource Requirements</td>
<td>Supply Chain Planning Work Order Operation Resources</td>
<td>ScpWIPOperationResourceImportTemplate. xslm</td>
</tr>
<tr>
<td>Planned Order Supplies</td>
<td>Supply Chain Planning Planned Order Supply</td>
<td>ScpPlannedOrderSupplyImportTemplate. xslm</td>
</tr>
<tr>
<td>Sourcing Rule and Assignments</td>
<td>Supply Chain Planning Sourcing Rules</td>
<td>ScpSourcingImportTemplate. xslm</td>
</tr>
<tr>
<td>Key Customer Options</td>
<td>Supply Chain Planning Key Customer Options</td>
<td>ScpKeyCustomerOptionsImportTemplate. xslm</td>
</tr>
</tbody>
</table>
Run the Load Planning Data from Files Process

To load planning data from files, first you must prepare the data you want to load. To prepare the data, download the relevant XLSM template, update the XLSM template with required data, and create the necessary CSV files for upload. This procedure explains how to load planning data from files after you have prepared the data and created CSV files.

1. From the Navigator, use the File Import and Export page to upload the previously prepared and zipped CSV files to the Universal Content Manager. Use the account scm/planningDataLoader/Import to upload the zipped file.

   Note: For more information about uploading files to the Universal Content Manager server, see the following section in the Oracle SCM Cloud Implementing Common Features for Oracle SCM Cloud guide: External Integration chapter, External Data Integration Services for Oracle Cloud section.

2. From one of the Supply Chain Planning work areas or Setup and Maintenance work area, Supply Chain Planning offering, select the Load Planning Data from Files task.

3. Complete the following parameters on the Load Planning Data from Files page:
   a. Select the source system.
   b. Select Collection Type: Net change or Target.
   c. Select the .zip file you previously imported into the Universal Content Manager.

4. Click Submit. Make a note of the process ID. You will need this process ID to review the status of the process.

Verify Collection Processes

Verify the Load Planning Data from Files Process

Perform the following steps to verify the process status of the uploaded file and review log file for any errors or warnings.

1. In the Navigator, click Scheduled Processes.
2. In the search area, enter the process ID you noted when you submitted during the Load Planning Data from Files process. Click Search.
3. Monitor the process to verify completion.

   If the process completes with warnings, select the request that shows the warning status and click the View Log button to review the details.
4. For the rows with errors, resolve the issues found in the log file, and then upload the CSV file again. To load only the revised rows, use the Net Change option.

Review Data in the Planning Data Repository

You can review the data collected or loaded into the planning data repository using two different options. The option you use depends on which data collection entities you want to review.
To review the data collected or loaded into the planning data repository, use one of the following options:

- Review data using the Plan Inputs page layout
- Review data using the Maintain Supply Network Model page

To review the following entities, use the Maintain Supply Network Model page:

- Organizations
- Customers
- Suppliers
- Carriers
- Interlocation Shipping Networks

To review data that is not part of the supply network model, use the Plan Inputs page layout. You can view the following data in the Plan Inputs page layout:

- Supply data
- Demand data

You can view Carriers and Suppliers using either option.

**Review Data Using the Plan Inputs Page Layout**

Perform the following steps to review the planning data that you loaded.

1. In the Navigator, click **Plan Inputs**.
2. From the Plans menu, right-click **Plan Inputs** and click **Open**.

   ![Plan Inputs Page Layout](image)

    **Tip:** You can set the preview pane to Full Pane for viewing your data in full pane. Click **Change** and select **Full Pane**.

3. On the Plan Inputs page, click **Open**, and click **Full Pane**.
4. On the Open Table, Graph, or Tile Set page, search for the table name.
5. Enter the criteria for the data you want to verify and click **Search**.
6. Review the data in the Search Results table.

**Review Data Using the Maintain Supply Network Model Page**

Perform the following steps to review the planning data using the Maintain Supply Network Model page.

1. In the Navigator, click **Plan Inputs**.

   ![Maintain Supply Network Model Page](image)
2. From the Tasks menu, click **Maintain Supply Network Model**.
3. Enter the criteria for the data you want to verify and click **Search**.
4. Review the data in the Search Results table.
7 Exceptions

Configure Exceptions and Exception Sets

Overview of Exceptions and Exception Sets

On the Configure Exceptions page, you can select an exception and edit the thresholds for reporting. You can configure only those exceptions that are relevant to your Supply Chain Planning work area.

On the Configure Exception Sets page, you can restrict the exceptions that are computed as part of the plan run. You can also control the organizations, item categories, time period, and so on for which to compute exceptions.

A defined exception set is associated with a plan. The plan evaluates the exceptions using the filters associated with the exception set. The exception set executed during the plan run is defined on the Plan Options page.

Related Topics

• How You Edit Exceptions

Configure Exception Sets

Use the Configure Exception Sets page to create, modify, or copy an exception set. The set of exceptions and their scope that is calculated by the plan is configured on the Create or Edit Exception Set page. When creating an exception set, you must first specify which exceptions to include in the set.

The exception set also enables you to restrict the generation of exceptions to specific organizations, categories, suppliers, and customers. You can then point to the exception set on the Plan Options page for a plan.

Related Topics

• How You Edit Exceptions

Set Filters on Planning Dimensions for Exception Reporting

After selecting available exceptions for an exception set to use in a plan, you can add filters on some of the key planning dimensions. The levels on which you can define filters are organizations, categories, suppliers, and customers.

On the Configure Exception Sets page in the Filters tab, select one or more organizations, suppliers, categories, and customers in each of the tables for which to generate exceptions. If you do not specify a filter for a level, you will generate exceptions for all records in that level. For example, if you do not specify an organization, exceptions will be generated for all planning organizations when a plan is run. If any of the organizations, categories, suppliers, or customers in the exception set are not available in the plan, they will be ignored.

In the Exception Cutoff Days field, specify the number of calendar days, starting from the plan start date, from which to generate the exceptions. If this field is blank, exceptions will be generated for the full planning horizon.
Related Topics

- How You Edit Exceptions

Work With Exceptions in Plans

Create Tables and Graphs for Exceptions

Create a table or graph for plan exceptions based on their measures, such as number of exceptions generated, and the quantity associated with the exception.

Creating a Table for Exceptions

1. In a Supply Chain Planning work area, open a plan.
2. Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.
3. In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select Table.
4. On the Create Table page, do the following:
   - Enter a name for your table.
   - Select a group.
   - Enter a description.
   - Select the type of access (public or private).
5. On the Measures tab, do the following:
   a. In the Available Measures section, expand the Overall Plan Health folder.
      The Overall Plan Health folder contains the measures associated with exceptions.
   b. Select the exception facts that you want to view in the table.
6. On the Hierarchies tab, include the Exception Type hierarchy.
7. On the Members tab, select the exception types to display in the table.
8. Click Save and Close.

Creating a Graph for Exceptions

1. In a Supply Chain Planning work area, open a plan.
2. Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.
3. In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select Graph.
4. On the Create Graph page, do the following:
   - Enter a name for your graph.
   - Select a group.
   - Enter a description.
   - Select the type of access (public or private).
5. On the Measures tab, do the following:
   a. In the Available Measures section, expand the Overall Plan Health folder. The Overall Plan Health folder contains the measures associated with exceptions.
   b. Select the exception facts that you want to view in the graph.

6. On the Hierarchies tab, include the Exception Type hierarchy.

7. On the Members tab, select the exception types to display in the graph.

8. On the Layout tab, do the following:
   a. In the Graph Layout Options section, select a type of graph.
   b. Configure your graph in the horizontal panels below the Graph Layout Options.

   The horizontal panels below the Graph Layout Options section vary, depending on the type of graph that you select. For example, if you select Pie Graph for your graph type, the horizontal panels include General Options, Pie Slice, and Formatting.

9. Click Save and Close.

Related Topics
- How You Edit Exceptions
- How You Manage Tables, Graphs, Analysis Sets, Infotiles, and Tile Sets
- Plan Exceptions

User-Defined Exceptions

User-Defined Exceptions

Using user-defined exceptions, you can define exceptions based on specific conditions in the supply chain that you want to identify. A user-defined exception is defined as a combination of levels and conditions across several dimensions. For example, the user-defined exception can be defined at the product dimension as the item, customer dimension as customer site, and time dimension as week level. You use Configure Exception task to create a user-defined exception.

While all predefined exceptions are computed at the lowest level along the selected dimensions, user-defined exceptions can also be computed at a higher level. A user-defined exception refers to a condition being met or exceeded, or a threshold being met in the plan due to constraints in the supply chain.

You create an exception on a specific measure called Base Measure. You can create an exception based on the following thresholds:

   - Value: Set the value and the specific operation, such as less than, equal, and larger than, against the base measure.
   - Measure: Select the measure based on your business requirement and select the specific operation that meets the condition against the base measure.

User-defined exceptions let you focus on problem areas where user interaction provides value to the business. It can highlight potential problems with accuracy. For example, any gaps between last year’s booking or shipment or orders against the values for the current year. You can define exceptions based on your business requirements.
Related Topics

- Example of a User-Defined Exception
8 Segmentation

Segmentation in Oracle Fusion Replenishment Planning

Segmentation is the process of grouping item-location combinations into segments on the basis of user-defined, static, or dynamic attributes. Through segmentation, you can better manage the replenishment requirements for many item-location combinations by grouping them into a few segments.

You do replenishment planning and forecasting and apply policy assignment sets by segment groups. You also view data in tables and graphs by segments.

For example, you can perform segmentation by defining segment groups that are based on:

- Intermittency and volatility
- Demand volume and cost
- Item attributes for the Product and Organization dimensions
- User-defined attributes and organizations, regions, and zones

You collect the item-location combinations and associated attributes from Oracle Fusion Product Management. To restrict segmentation to items for which replenishment planning must be done, you first set the MPS and MRP Planning Method attribute of items to Replenishment planning in Product Management. Then, while setting up the criteria for segments of a segment group, you set the Planning Method attribute for the Product dimension to Replenishment planning. After segmentation, only replenishment planning items are grouped into the segments of the segment group. If you don't restrict the scope of segmentation, it happens for all item-location combinations collected from Product Management; however, the replenishment plans process only those item-location combinations for which the MPS and MRP Planning Method attribute is set in Product Management.

How You Perform Segmentation

Here's what you do during the segmentation process:

1. Set up a segment group and its segments. The segment group has a specific granularity that's applicable to the segments. You specify dimension-based or measure-based criteria for each segment on the basis of which item-location combinations are assigned to the segment.
2. Run the segmentation job for the segment group from the Manage Segment Groups and Criteria page (Actions > Execute Segmentation).
   
   The item-location combinations are grouped into the segments.
3. View the results of segmentation, and optionally override the assignment of item-location combinations to segments to better meet your business requirements.
This flow chart summarizes the segmentation process:

When the segments are used as members for tables and graphs, for item-location combinations that aren't associated with a segment in the segment group, the segment information is shown as "Not available."

**What You Do After Segmentation**

Here's what you do after the segmentation process:

1. Create a policy assignment set, and attach the segment group to the policy assignment set.
2. Attach the segment group to a replenishment plan.
3. Run the replenishment plan to calculate the unique replenishment requirements for the item-location combinations in each segment.

Work with Segment Groups

Create a Segment Group

A segment group consists of segments into which combinations are grouped. The segment group has a granularity that's also applicable to the segments. You define the segments on the basis of dimension-based or measure-based criteria.

In the case of Oracle Fusion Replenishment Planning, the combinations comprise items and locations that are collected from Oracle Fusion Product Management. In the case of Oracle Fusion Demand Management, the combinations could also include customers and demand classes that are collected from Oracle Fusion applications and external sources.

To create a segment group, you must:

1. Create the segment group.
2. Define the segments.
3. Define criteria for the segments.

To restrict segmentation to items for which replenishment planning must be done, you first set the MPS and MRP Planning Method attribute of items to Replenishment planning in Product Information Management. Then, while setting up criteria for segments of the segment group, you set the Planning Method attribute for the Product dimension to Replenishment planning. After collection and segmentation, only replenishment planning items are grouped into the segments of the segment group.

Create the Segment Group

Follow these steps to create the segment group:

2. Under Search Results, click Actions > Create. The Create Segment Group page opens.
3. In Segment Group, enter the segment group name.
4. In Source System, select the source system for the segment group. The source system must be the same as that used in the replenishment plan to which you attach the segment group. Only the combinations in the selected source system are available after segmentation in the segment group.
5. In Simulation Set, select a simulation set for the segment group. If you plan to simulate changes to the same item attributes at the segment group and demand or replenishment plan levels, preferably, use the same simulation set in both cases.
6. In Description, enter the segment group description.
7. Under Segment Granularity, in the Dimension column, select the dimension that you want to specify for the segment group granularity. You must select at least one dimension. The lowest levels for the selected dimensions are displayed in the Level column, and the displayed levels make up the segment group's granularity.
Only the predefined Customer, Demand Class, Organization, and Product dimensions are supported.

If the segment group is to be used with replenishment plans, only the Organization and Product dimensions should be selected.

8. Add more dimensions as required by clicking the Add Row icon.

9. In Catalog, select the Product Information Management catalog from which you want to use categories while specifying the attributes for Product dimension-based criteria of segments in the group.

10. Select the Retain segment overrides check box.

If you select this check box, the segment overrides you perform on the Manage Segment Members page for combinations of the segment group are retained after segmentation is run.

11. Click Save.

Define the Segments

Follow these steps to create a segment in the segment group:

1. Under Segments, click the Add Row icon to add a segment.
2. Enter the segment name and description.
3. Under Rank, accept the default number that's a multiple of 10 or enter a whole number that's unique for the segment group.

During segmentation, if a combination meets the criteria for more than one segment, the combination is assigned to the segment with the lower rank.

4. Add more segments as required.
5. Click Save.

Define Criteria for the Segments

Follow these steps to define criteria for segments:

1. Under Segments, select the segment for which you want to define criteria.
2. Under Segment Criteria, click the Add Row icon.

A row appears for the segment criteria of the segment.

3. Set the criteria as follows:

   a. In the list under Dimension, if you want the criteria to be based on the selected dimensions for the segment group:

      i. Select a dimension.

      The list under Attribute is enabled and displays the attributes for the selected dimension.

      ii. In the list for attributes, select an attribute for the dimension.

      The list under Operator is enabled.

      If you selected the Product dimension, and you previously specified a Product Information Management catalog, the list includes Category as an attribute.

      iii. In the list for operators, select the operator with which you want to evaluate the attribute.

      Depending on your selection, the fields or lists under From Value and To Value may be enabled, and dialog boxes may open.
If you selected **Category** as an attribute, the categories for the selected Product Information Management catalog are displayed in the list under **From Value**.

iv. Specify the values for the attribute.

b. In the list under **Dimension**, if you want the criteria to be based on measures:

i. Select **Measure-based criteria**.

The Search and Select: Plans dialog box appears.

ii. In the Available Plans pane, in **Type**, specify whether demand or replenishment plans are to be displayed.

iii. Click the **Find** icon.

The demand or replenishment plans are displayed. Only those replenishment plans for which the **Generate forecast** check box is selected on the Scope tab of the Plan Options page are displayed.

The demand or replenishment plans should have been run and contain tables with the required measures. The tables should have only those dimensions and levels that are in the segment group.

iv. Select and move plans to the Selected Plans pane.

v. Click **OK** to return to the Create Segment Group page.

vi. In the list under **Measure Evaluation Table**, select the table from which measures should be selected for the segment criteria.

The list under **Measure Name** is enabled.

The tables associated with the selected demand or replenishment plans are available in the list.

vii. In the list for measures, select a measure.

The list under **Operator** is enabled.

viii. In the list for operators, select the operator with which you want to evaluate the measure value.

Depending on your selection, the **From Value** field, **To Value** field, or both are enabled.

ix. Specify the values for the measure.

4. Add more rows for segment criteria as required.

   If you’re adding rows, enter a whole number in the field under **Group** for each row. During segmentation, those rows with the same whole number are processed with the AND operator. Then, the resulting criteria are processed with the OR operator.

5. Click **Save**.

---

**Edit a Segment Group**

You can edit and delete segment groups, segments, and segment criteria.

**Edit the Segment Group**

You can duplicate, edit, and delete a segment group.

In the Replenishment Planning work area, you can delete the segment group only if it’s not associated with a policy assignment set or replenishment plan.
The changes you can make to the segment group are limited. You can’t change the name or source system for the segment group, and you can’t change its granularity by adding or deleting dimensions.

Follow these steps to edit the segment group:

1. On the Tasks panel tab, under Plan Inputs, select **Manage Segment Groups and Criteria**.
   The Manage Segment Groups and Criteria page opens.
2. Search for the segment group that you want to edit.
3. Select the segment group, and click **Actions > Edit**.
   The Edit Segment Group page opens.
4. Change the description and simulation set as required.
   If you plan to simulate changes to the same item attributes at the segment group and demand or replenishment plan levels, preferably, use the same simulation set in both cases.
5. In **Catalog**, select the catalog from Oracle Fusion Product Management from which you want to use categories while specifying the attributes for Product dimension-based criteria of segments in the group.
   If you previously selected a catalog and used one of its categories while setting up a Product dimension-based criterion, the list is grayed out.
6. Select or deselect the **Retain segment overrides** check box.
   If you select this check box, the segment overrides you perform on the Manage Segment Members page for combinations of the segment group are retained after you run segmentation again.
7. Click **Save**.

**Edit the Segments**
You can add, duplicate, and delete segments and change their names, descriptions, and ranks.

In the Replenishment Planning work area, you can delete segments only if the segment group isn’t associated with a policy assignment set or replenishment plan.

If you change the rank of a segment, you may change how combinations are assigned to segments after you run segmentation again. During segmentation, if a combination meets the criteria for more than one segment, the combination is assigned to the segment with the lower rank.

**Edit the Segment Criteria**
You can add or delete criteria for a segment.

The changes that you can make to existing criteria are limited to the values and group.

Depending on the operator used for the criterion, you can change the values under **From Value**, **To Value**, or both.

If you change the value under **Group** for the criterion, you may affect the segmentation result. During segmentation, those criteria with the same whole number are processed with the AND operator. Then, the resulting criteria are processed with the OR operator.
Run Segmentation

Segmentation can be run for a segment group from the Manage Segment Groups and Criteria page. Follow these steps to run segmentation for the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

   The Manage Segment Groups and Criteria page opens.

2. Search for the segment group for which you want to run segmentation.

3. Select the segment group, and click Actions > Execute Segmentation.

   The Execute Segmentation dialog box opens.

4. Click Yes.

   Another dialog box opens and provides you with the request number (process ID) of the segmentation job. You can use this request number to search for the job status and log on the Scheduled Processes page. If the segmentation job fails, see the log for more information and troubleshooting.

   On the Manage Segment Groups and Criteria page, the status and last run date of segmentation for the segment group are updated after you submit the request.

5. Click OK.

View the Segmentation Summary

You can view segmentation results on the Segmentation Summary page. The numbers of combinations originally assigned to and manually reassigned to segments (segment overrides) are displayed.

In the case of Oracle Fusion Replenishment Planning, the combinations comprise items and locations that are collected from Oracle Fusion Product Management. In the case of Oracle Fusion Demand Management, the combinations could also include customers and demand classes that are collected from Oracle Fusion applications and external sources.

Follow this procedure to view the segmentation summary for a segment group:

1. Perform one of these steps:
   - On the Tasks panel tab, under Plan Inputs, select View Segmentation Summary.
     
     The Segmentation Summary page opens.
   - On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > View Segmentation Summary.
     
     The Segmentation Summary page opens.

2. In the Segment Group list of the page, select the segment group for which you want to view the segmentation summary.

   The page is refreshed with the segmentation summary for the segment group. The numbers of combinations originally assigned to, manually added to, manually removed from, and finally in segments of the segment group are displayed.
If you opened the Segmentation Summary page from the Manage Segment Groups and Criteria page, the list is grayed out, and you can view segmentation results for only the segment group you selected on the page.

3. Click **Done**.

## Override Segmentation Results

You can override segmentation results by manually assigning combinations to segments.

In the case of Oracle Fusion Replenishment Planning, the combinations comprise items and locations that are collected from Oracle Fusion Product Management. In the case of Oracle Fusion Demand Management, the combinations could also include customers and demand classes that are collected from Oracle Fusion applications and external sources.

You can override segmentation results using:

- the Manage Segment Members page
- the edit-in-spreadsheet feature

Changes you make to the segments for combinations are overwritten the next time you run segmentation unless you have selected the **Retain segment overrides** check box for the segment group on the Create Segment Group or Edit Segment Group page.

### Override Segmentation Results Using the GUI

To override segmentation results through the Manage Segment Members page, follow this procedure:

1. Perform one of these steps:
   - On the Tasks panel tab, under Plan Inputs, select **Manage Segment Members**.
   - The Manage Segment Members page opens.
   - On the Manage Segment Groups and Criteria page, select a segment group, and click **Actions > Manage Segment Members**.
   - The Manage Segment Members page opens.
   - On the Segmentation Summary page, for the segment of a segment group, click the number under **Original Count**, **Manually Added to Segment**, **Manually Removed from Segment**, or **Final Count**.
   - The Manage Segment Members page opens and displays the combinations originally assigned to, manually added to, manually removed from, or finally in the segment.

2. On the Manage Segment Members page, under Search, select the segment group for which you want to override the segmentation results, and click **Search**. You can further refine your search by segment and the levels for the dimensions in the segment group.

   The page is refreshed with the segmentation results.

3. For each combination for which you want to override the segmentation results, in the list under **Segment Override**, select the new segment.

4. Click **Save and Close**.
Override Segmentation Results Using a Spreadsheet

To override segmentation results through the edit-in-spreadsheet feature, follow this procedure:

**Note:** You must first download and install the desktop integration installer that's available under Navigator > Tools. Otherwise, you can’t override segmentation results using a spreadsheet.

1. Perform one of these steps:
   - On the Tasks panel tab, under Plan Inputs, select Manage Segment Members.
   - The Manage Segment Members page opens.
   - On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > Manage Segment Members.
   - The Manage Segment Members page opens.
   - On the Segmentation Summary page, for the segment of a segment group, click the number under Original Count, Manually Added to Segment, Manually Removed from Segment, or Final Count.
   - The Manage Segment Members page opens and displays the combinations originally assigned to, manually added to, manually removed from, or finally in the segment.

2. On the Manage Segment Members page, under Search, select the segment group for which you want to override the segmentation results, and click Search. You can further refine your search by segment and the levels for the dimensions in the segment group.
   - The page is refreshed with the segmentation results.

   - A dialog box opens and prompts you to open or save a Microsoft Excel file.

4. Open the spreadsheet.
   - The Connect dialog box opens and prompts you to connect to the application URL.

5. Click Yes.
   - A dialog box opens and prompts you to enter your credentials.

6. Sign in with your Oracle Applications Cloud credentials.
   - The spreadsheet is refreshed with the combinations in the segment group displayed on the Manage Segment Members page.

7. To narrow your search to a combination in the segment group, enter the details in the first table, and click Manage Segment Members > Search.
   - You can use the percent sign as a wildcard character for your search.

8. For each combination for which you want to override the segmentation results, in the list under the Segment Override column, select the new segment.
   - A symbol appears in the cell under the Changed column for each changed row.

9. To upload your changes to Oracle Fusion Demand Management or Oracle Fusion Replenishment Planning, click Manage Segment Members > Upload.
   - The results of the upload for each row are displayed under the Status column.
   - The symbol in the cell under the Changed column disappears for each successfully uploaded row.

10. Save and close the spreadsheet.
11. To view your changes on the Manage Segment Members page, click **View > Refresh**.
9 Policy Assignment Sets

Policy Assignment Sets

A policy assignment set is a group of policy parameters that are defined for each segment of a segment group. Policies are calculated for item-location combinations on the basis of these policy parameters. The policy assignment set can also contain policy overrides for segments and item-location combinations.

The policy assignment set is attached to a segment group. You can define multiple policy assignment sets for the segment group. However, you can specify only one policy assignment set for the segment group on the Scope tab of the Plan Options page in a replenishment plan.

The policy assignment set consists of the following:

- Policy parameters
- Default policy parameters
- Policy parameter overrides
- Item-location level policy overrides

Policy Parameters

You define policy parameters at the segment level.

This table lists the policy types that you can specify:

<table>
<thead>
<tr>
<th>Policy Type</th>
<th>Method for Calculation of Quantities</th>
<th>How the Policy Type is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min-max planning</td>
<td>The following is the formula for calculation of the minimum quantity: Demand During Lead Time + Safety Stock, where Demand During Lead Time = Total Lead Time * Average Daily Demand and Total Lead Time = Preprocessing Lead Time + Processing Lead Time + Postprocessing Lead Time (taken from the Items table) The safety stock and average daily demand are calculated as discussed later in this guide. The maximum quantity is calculated as specified later in this topic.</td>
<td>When the sum of the Projected Available Balance and On Order measures falls below the minimum quantity, a replenishment order is triggered. The quantity of the replenishment order is what's required to bring the inventory up to the maximum quantity (provided by Maximum Quantity - (Projected Available Balance + Order Quantity)).</td>
</tr>
<tr>
<td>Fixed order cycle</td>
<td>The maximum quantity is calculated as specified later in this topic.</td>
<td>The replenishment orders are placed on only those days on which suppliers can take orders, according to the associated fixed order cycle calendar.</td>
</tr>
<tr>
<td>Policy Type</td>
<td>Method for Calculation of Quantities</td>
<td>How the Policy Type Is Used</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reorder point (ROP) and order quantity</td>
<td>The following is the formula for calculation of the ROP: Demand During Lead Time + Safety Stock,</td>
<td>When the sum of the Projected Available Balance and On Order measures falls below the ROP, a replenishment order is triggered.</td>
</tr>
<tr>
<td></td>
<td>where Demand During Lead Time = Total Lead Time * Average Daily Demand</td>
<td>The quantity of the replenishment order is the order quantity.</td>
</tr>
<tr>
<td></td>
<td>and Total Lead Time = Preprocessing Lead Time + Processing Lead Time + Postprocessing Lead Time (taken from the Items table)</td>
<td>If the fixed order quantity isn't defined in the Items table or the default order quantity isn't defined at the segment level in the policy assignment set, replenishment orders are created to bring the inventory to the ROP level.</td>
</tr>
<tr>
<td></td>
<td>The average daily demand and safety stock are calculated as discussed later in this guide.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The order quantity is taken for the item-location combination from the Fixed Order Quantity column of the Items table. If this value is unavailable, the default order quantity specified at the segment level in the policy assignment set is used. If the fixed order quantity isn't defined at the item-level or the default order quantity isn't defined at the segment level in the policy assignment set, replenishment orders are created to bring the inventory to the ROP level.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Therefore, for this policy type, the fixed order quantity should be correctly defined at the item level.</td>
<td></td>
</tr>
<tr>
<td>ROP and economic order quantity (EOQ)</td>
<td>The following is the formula for calculation of the ROP: Demand During Lead Time + Safety Stock,</td>
<td>When the sum of the Projected Available Balance and On Order measures falls below the ROP, a replenishment order is triggered.</td>
</tr>
<tr>
<td></td>
<td>where Demand During Lead Time = Total Lead Time * Average Daily Demand</td>
<td>The quantity of the replenishment order is the EOQ.</td>
</tr>
<tr>
<td></td>
<td>and Total Lead Time = Preprocessing Lead Time + Processing Lead Time + Postprocessing Lead Time (taken from the Items table)</td>
<td>If the EOQ can't be calculated at the item-location level or the default EOQ isn't defined at the segment level in the policy assignment set, replenishment orders are created to bring the inventory to the ROP level.</td>
</tr>
<tr>
<td></td>
<td>The average daily demand, safety stock, and EOQ are calculated as discussed later in this guide.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Therefore, for this policy type, the EOQ should be correctly calculated.</td>
<td></td>
</tr>
</tbody>
</table>
You specify whether you want to calculate safety stock on the basis of the days of cover or service level.

By specifying Units as the unit of measure (UOM), you ensure that the policies are static. By specifying Days as the UOM, you ensure that the policies are time-phased.

You determine whether the average daily demand should be calculated on the basis of the forecast or history.

You calculate the maximum quantity based on these methods:

- Days of cover: The average daily demand is multiplied by the maximum quantity days of cover specified in the policy assignment set.
- Minimum plus order quantity: The minimum quantity is added to the order quantity, which is taken for an item-location combination from the Fixed Order Quantity column of the Items table. If this value is unavailable, the default order quantity specified at the segment level in the policy assignment set is used.
- Minimum plus EOQ: The minimum quantity is added to the EOQ.

**Default Policy Parameters**

You define these default policy parameters at the segment level:

- Default daily demand: This value is used when forecast or history data is unavailable at the item-location level for the calculation of the average daily demand.
- Default order quantity
- Default EOQ: If you specify this default, the default standard cost, default carrying cost percentage, and default ordering cost can't be specified.
  - Default standard cost
  - Default carrying cost percentage
  - Default ordering cost

The default order quantity, default standard cost, default carrying cost percentage, and default ordering cost are used when the corresponding values are unavailable for the item-location combination in the Items table.

**Policy Parameter Overrides**

You define these policy parameter overrides at the segment level:

- Safety stock override
- Order quantity override
- Minimum override: If this value is specified, the safety stock isn't calculated, and no value is shown for the safety stock in tables.
  - EOQ override
  - Maximum override
  - ROP override: If this value is specified, the safety stock isn't calculated, and no value is shown for the safety stock in tables.

Use policy parameter overrides when all item-location combinations in a segment must have the same policy values. When these overrides are specified, policies aren't calculated for all the item-location combinations of the segment.
Item-Location Level Policy Overrides
You define overrides at the level of individual item-location combinations, and these settings take precedence over those for the segments to which the item-location combinations belong:

- Policy type
- Policy UOM
- Safety stock override
  - Minimum override: If this value is specified, the safety stock isn't calculated, and no value is shown for the safety stock in tables.
- Maximum override
- ROP override: If this value is specified, the safety stock isn't calculated, and no value is shown for the safety stock in tables.
- Order quantity override
- EOQ override
- Fixed order cycle calendar

Use these policy overrides when you know what values you need for item-location combinations in your business, and you want to generate replenishment orders on the basis of these values. When these overrides are specified, inventory policies aren't calculated for the corresponding item-location combinations.

Hierarchy for Reading Policy Overrides and Item Attributes
The following hierarchy explains how policy overrides and item attributes are read during the policy calculation process:

1. If policy overrides are specified for item-location combinations, these values are used as the policies, and policies aren't calculated for these item-location combinations.
2. If policy overrides are specified for segments, these values are used as the policies for all the item-location combinations in the segments, and policies aren't calculated for these item-location combinations.
3. If a simulation set is assigned to the replenishment plan to which the policy assignment set is attached, the item attributes for item-locations combinations are taken from the simulation set.
4. If values are unavailable in the simulation set, the collected item attributes are taken.
5. If item attributes are unavailable in the Items table, the default values specified at the segment level in the policy assignment set are used.

How You Use Policy Assignment Sets
The following is the process for using policy assignment sets in the Replenishment Planning work area:

1. Perform the segmentation process.
2. Create a policy assignment set, and define the policy parameters for segments and policy overrides for item-location combinations.
3. Attach the policy assignment set to a replenishment plan.
4. Run the replenishment plan.
   - Generate the forecast, calculate the policy parameters, and calculate the replenishments. Refresh the plan with the current, collected data.
5. Review the calculated policies.
6. If the calculated policies aren't satisfactory, follow these steps:
   
   a. Perform simulations, and make changes to the policy parameters for segments or policy overrides for item-location combinations
   b. Run the replenishment plan again.

   Calculate the policy parameters and replenishments, and don't refresh the measures with current data.

The following is the flow chart for using policy assignment sets:

1. Run segmentation process
2. Create policy assignment set, policy parameters, policy overrides
3. Attach policy assignment set to replenishment plan
4. Run replenishment plan, generate forecast, calculate policies, calculate replenishments
5. Are calculated policies OK?
   - Yes: End
   - No: Perform simulations, change policy parameters, change policy overrides
   - Then: Run replenishment plan, calculate policies, calculate replenishments
How Average Daily Demand Is Calculated in Oracle Fusion Replenishment Planning

This topic explains how average daily demand is calculated in Oracle Fusion Replenishment Planning.

Settings That Affect Average Daily Demand

The following settings affect the calculation of the average daily demand:

- Whether the history or forecast is to be considered
- Whether policy parameters or segment-level defaults have been defined in the policy assignment set for a replenishment plan

How Average Daily Demand Is Calculated

How average daily demand for an item-location combination is calculated depends on whether you selected **History** or **Forecast** in the **Days of Cover Basis** list on the Policy Parameters subtab for the policy assignment set.

<table>
<thead>
<tr>
<th>Selection in Days of Cover Basis List</th>
<th>Calculation of Average Daily Demand</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td>These steps are taken:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. The value in the <strong>Horizon for Average Daily Demand</strong> field on the Policy Parameters subtab is read. The working days in the calendar are considered. If there's no attached calendar, all days are considered. Only those days within the planning horizon of the replenishment plan are considered.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. The <strong>MSC_DFLT_SHIPMENT_HIST_MEASURE</strong> profile is used for determining which shipment history measure must be used for the history data. The shipment history is collected or uploaded through a CSV file. If the history is unavailable, the default daily demand defined at the segment level is used.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. The shipment history is divided by the number of days.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. The result of Step 3 is multiplied by the value entered in the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The horizon for the average daily demand is 30, and the calendar is open on all days.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The shipment history is 600.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The extrapolation percentage is 15.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This calculation provides the average daily demand: ( \frac{600}{30} + 15% \text{ of } \left( \frac{600}{30} \right) = 20 + 3 = 23 )</td>
<td></td>
</tr>
</tbody>
</table>
### How EOQ Is Calculated in Oracle Fusion Replenishment Planning

The economic order quantity (EOQ) is the optimal quantity that should be ordered so that inventory holding and ordering costs are minimized. In a replenishment plan, you can use the reorder point (ROP) and EOQ policy type to calculate replenishments on the basis of the EOQ.

<table>
<thead>
<tr>
<th>Selection in Days of Cover Basis List</th>
<th>Calculation of Average Daily Demand</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Extrapolation Percentage</strong> field on the Policy Parameters subtab.</td>
<td>5. The results of Steps 3 and 4 are added for the calculation of the average daily demand.</td>
<td></td>
</tr>
<tr>
<td><strong>Forecast</strong></td>
<td>These steps are taken:</td>
<td>The total demand for the next 20 days is 500.</td>
</tr>
<tr>
<td>1. The total demand indicated by the forecast is read. The source of the forecast can be one of the following:</td>
<td></td>
<td>The number of days is 20, and the calendar is open on all days.</td>
</tr>
<tr>
<td>- A demand plan</td>
<td>2. The number of days is identified. The total demand is considered during these days. The value in the <strong>Horizon for Average Daily Demand</strong> field on the Policy Parameters subtab is read. The working days in the calendar are considered. If there’s no attached calendar, all days are considered. Only those days within the planning horizon of the replenishment plan are considered.</td>
<td>This calculation provides the average daily demand: 500/20 = 25</td>
</tr>
<tr>
<td>- A replenishment plan for which the <strong>Generate forecast</strong> check box is selected on the Plan Options page</td>
<td>3. The total demand is divided by the number of days for the calculation of the average daily demand.</td>
<td></td>
</tr>
<tr>
<td>- An external forecast</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- The value in the <strong>Default Daily Demand</strong> field on the Default Policy Parameters subtab, if the other forecast sources are unavailable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The total demand for the next 20 days is 500. The number of days is 20, and the calendar is open on all days. This calculation provides the average daily demand: 500/20 = 25
Settings That Affect EOQ

The following settings affect the EOQ calculation:

- Whether information is present for an item-location combination in the Items table
- Whether segment-level defaults have been defined in the policy assignment set for the replenishment plan

How EOQ Is Calculated

The following formula provides the EOQ:

\[ EOQ = \sqrt{\frac{2CD}{H}} \]

<table>
<thead>
<tr>
<th>Equation Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Fixed cost per order defined at the item-location level</td>
</tr>
</tbody>
</table>

The value of C is read as follows:

1. If the value is present for the item-location combination in the Order Cost column of the Items table, it’s used for calculating the EOQ.
2. If the value isn’t present for the item-location combination in the Order Cost column, the default ordering cost defined for the segment in the policy assignment set is used for calculating the EOQ.
3. If the value isn’t present for the item-location combination in the Order Cost column, and the default EOQ is specified in the policy assignment set, the default EOQ is used.

| H                 | Annual carrying cost per item-location combination, which is provided by this calculation: Carrying Cost Percentage * Standard Cost |

The value of H is read as follows:

1. If the carrying cost percentage isn’t present for the item-location combination in the Annual Carrying Cost Percentage column of the Items table, the default carrying cost percentage defined for the segment in the policy assignment set is used for calculating the EOQ.
2. If the standard cost isn’t present for the item-location combination in the Standard Cost column of the Items table, the default standard cost defined for the segment in the policy assignment set is used for calculating the EOQ.
3. If the values aren’t present for the item-location combination, and the default EOQ is specified in the policy assignment set, the default EOQ is used.
### How Safety Stock Is Calculated in Oracle Fusion Replenishment Planning

The safety stock is the quantity of an item that an organization holds as a buffer in the inventory to protect against fluctuations in demand or supply. This quantity is in addition to that required by normal operations of the organization.

#### Settings That Affect Safety Stock

The value of the safety stock depends on whether it should be calculated based on the days of cover or service level.

#### How Safety Stock Is Calculated

How safety stock for an item-location combination is calculated depends on whether you selected **Days of cover** or **Service level-based** in the **Safety Stock Calculation** list on the Policy Parameters subtab for the policy assignment set.

- **If you selected Days of cover**, the following calculation is done: Safety Stock = Average Daily Demand * Days of Cover
  
  The days of cover is taken from the **Safety Stock Days of Cover** field on the Policy Parameters subtab.
  
  For example, the average daily demand is 30, and the days of cover is 3. The safety stock is 90, which is 30 * 3.

- **If you selected Service-level based**, and the demand isn't intermittent, a normal distribution formula is used. These inputs affect the formula's result:
  
  - Target service level percentage. If this value isn’t present in the Service Level Percentage column of the Items table, it’s taken from the **Target Service Level Percentage** field on the Policy Parameters subtab.
  
  - Mean average percentage error (MAPE), which is taken from the demand plan, replenishment plan, or external demand schedule that’s used as the demand schedule for the replenishment plan
  
  - Average daily demand
  
  - Replenishment lead time, which is the sum of the Preprocessing Lead Time, Processing Lead Time, and Postprocessing Lead Time columns of the Items table
  
- **If you selected Service level-based**, and the demand is intermittent, a Poisson distribution formula is used. These inputs affect the formula's result:
  
  - Number of demands during the replenishment lead time

### Oracle SCM Cloud

**Using Replenishment Planning**

**Chapter 9**

**Policy Assignment Sets**

<table>
<thead>
<tr>
<th>Equation Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Annual demand for the item-location combination, which is provided by this calculation: Average Daily Demand * Total Number of Working Days in a Year</td>
</tr>
</tbody>
</table>
Target service level percentage. If this value isn't present in the Service Level Percentage column of the Items table, it's taken from the **Target Service Level Percentage** field on the Policy Parameters subtab.

## Static Policies or Time-Phased Policies in Oracle Fusion Replenishment Planning

The unit of measure (UOM) you select for a policy assignment set at the segment or item-location level determines whether the policies are static or time-phased. If you selected Units as the UOM, the policies are static. If you selected Days, the policies are time-phased.

In static policies, the values of measures don't vary from day to day. In time-phased policies, these measure values can vary from day to day.

Use static policies when the total demand doesn't drastically change from day to day, and use time-phased policies when the total demand can vary from day to day.

If required, you can override the values of these measures for a replenishment plan by using these tables:

- Manage Policy Parameters by Item: Use this table when you want to change the measure values for all days.
- Replenishment Workbench: Use this table when you want to change the measure values for specific days.

### Static Policies

This table illustrates how static policies are calculated:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
<th>Day 8</th>
<th>Day 9</th>
<th>Day 10</th>
<th>Day 11</th>
<th>Day 12</th>
<th>Day 13</th>
<th>Day 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Quantity</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Maximum Quantity</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
</tr>
<tr>
<td>Adjusted Maximum Quantity</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
</tr>
</tbody>
</table>

*Note: NA indicates that the value is not applicable or not available.*
This table depicts the calculation of static policies for a replenishment plan with a planning horizon of 14 days.

The minimum quantity is calculated by the following formula: Demand During Lead Time + Safety Stock, where Demand During Lead Time = Total Lead Time * Average Daily Demand and Total Lead Time = Preprocessing Lead Time + Processing Lead Time + Postprocessing Lead Time.

The maximum quantity is calculated through the days of cover, minimum plus order quantity, or minimum plus economic order quantity (EOQ) method.

### Time-Phased Policies

This table illustrates how time-phased policies are calculated:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
<th>Day 8</th>
<th>Day 9</th>
<th>Day 10</th>
<th>Day 11</th>
<th>Day 12</th>
<th>Day 13</th>
<th>Day 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final Max. Quantity</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>55</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
</tr>
</tbody>
</table>

This table illustrates how time-phased policies are calculated:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
<th>Day 8</th>
<th>Day 9</th>
<th>Day 10</th>
<th>Day 11</th>
<th>Day 12</th>
<th>Day 13</th>
<th>Day 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Demand</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Min. Days</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Max. Days</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Min. Qty (Time-Phased Value)</td>
<td>30</td>
<td>35</td>
<td>40</td>
<td>45</td>
<td>50</td>
<td>55</td>
<td>60</td>
<td>50</td>
<td>40</td>
<td>30</td>
<td>35</td>
<td>40</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Adjusted Min. Qty</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Final Min. Qty (Time-Phased Value)</td>
<td>30</td>
<td>35</td>
<td>40</td>
<td>45</td>
<td>50</td>
<td>55</td>
<td>60</td>
<td>50</td>
<td>40</td>
<td>30</td>
<td>35</td>
<td>40</td>
<td>40</td>
<td>40</td>
</tr>
</tbody>
</table>
### Table 9-1: Time-Phased Policies for Replenishment Plan

<table>
<thead>
<tr>
<th>Measure</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
<th>Day 8</th>
<th>Day 9</th>
<th>Day 10</th>
<th>Day 11</th>
<th>Day 12</th>
<th>Day 13</th>
<th>Day 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Quantity (Time-Phased Value)</td>
<td>75</td>
<td>85</td>
<td>95</td>
<td>105</td>
<td>100</td>
<td>95</td>
<td>90</td>
<td>85</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td>Adjusted Maximum Quantity</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>Final Maximum Quantity (Time-Phased Value)</td>
<td>75</td>
<td>85</td>
<td>95</td>
<td>105</td>
<td>100</td>
<td>95</td>
<td>90</td>
<td>85</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
<td>80</td>
</tr>
</tbody>
</table>

This table depicts the calculation of time-phased policies for a replenishment plan with a planning horizon of 14 days.

The total demand is calculated according to the forecast processing logic.

The formula for the calculation of the minimum days is Minimum Quantity (static value)/Average Daily Demand. The formula for calculation of the maximum days is Maximum Quantity (static value)/Average Daily Demand.

The formulas for the calculation of the static values of the minimum and maximum quantities are the same as those used for static policies.

For the calculation of the time-phased minimum quantity for Day X, the minimum days are considered, and the total demand is summed up starting from Day X for the minimum days. If the number of days left in the planning horizon is less than the minimum days on Day X, the previous day's time-phased minimum quantity is used. For the calculation of the time-phased maximum quantity for Day X, the maximum days are considered, and the total demand is summed up starting from Day X for the maximum days. If the number of days left in the planning horizon is less than the maximum days on Day X, the previous day's time-phased maximum quantity is used.

### How Order Modifiers Are Applied When Replenishments Are Calculated

This topic explains how order modifiers are applied when replenishments are calculated for a replenishment plan.
Settings That Affect How Order Modifiers Are Applied to Replenishments

The policy type specified in the policy assignment set that's attached to the replenishment plan affects how order modifiers are applied to the calculated replenishments.

How Order Modifiers Are Applied to Replenishments

This table describes how order modifiers are applied to replenishments calculated for the replenishment plan when the policies are of different types:

<table>
<thead>
<tr>
<th>Policy Type</th>
<th>How Order Modifiers Are Applied</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min-max planning</td>
<td>The order modifiers specified in the Fixed Lot Multiplier, Minimum Order Quantity, Maximum Order Quantity, and Fixed Order Quantity columns of the Items table are applied to the replenishment order quantity.</td>
<td>If the minimum quantity is 50, maximum quantity is 100, sum of the projected available balance and on order quantity is 40, and fixed order quantity is 50, the replenishment order quantity is 60 (100 - 40). Two replenishment orders of 50 each are created.</td>
</tr>
<tr>
<td></td>
<td>The minimum order quantity and fixed lot multiplier can also be defined at the supplier level.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Here's how the modifiers are used:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the replenishment order quantity is less than the minimum order quantity, the former is increased to the latter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the replenishment order quantity is more than the maximum order quantity, the former is decreased to the latter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the replenishment order quantity isn't a multiple of the fixed lot multiplier, the former is converted into a multiple of the latter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the fixed order quantity is defined, it's used as the replenishment order quantity.</td>
<td></td>
</tr>
<tr>
<td>Fixed order cycle</td>
<td>The order modifiers are specified and used as explained for the min-max planning policy type.</td>
<td>If the maximum quantity is 100, sum of the projected available balance and on order quantity is 80, and fixed lot multiplier is 50, the replenishment order quantity is 20 (100 - 80). One replenishment order of 50 is created.</td>
</tr>
</tbody>
</table>
Work With Policy Assignment Sets

Create a Policy Assignment Set

This topic explains how you can create a policy assignment set in the Replenishment Planning work area.

To create the policy assignment set, you perform these steps:

1. Name the policy assignment set, and associate it with a segment group.
2. Add segments, and define the following for their item-location combinations:
   a. Policy parameters
   b. Default policy parameters
   c. Policy parameter overrides
3. Define policy overrides for specific item-location combinations.

Name the Policy Assignment Set and Associate It with a Segment Group

Follow these steps to name the policy assignment set and associate it with a segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Policy Assignment Sets.
   The Manage Policy Assignment Sets page opens.
2. Under Search Results, on the toolbar, click Create.
   The Create Policy Assignment Set dialog box opens.
3. Enter the name and description of the policy assignment set.
4. In Segment Group, select the segment group to which the policy assignment set should be attached.
   Only those segment groups for which the segmentation process has been successfully run are available for selection. The segment groups that use the Customer or Demand Class dimension aren't displayed.
5. Click Save.

Define Policy Parameters

Follow these steps to define policy parameters for a segment:

1. On the Segment-Level Policy Parameters Assignment tab, on the toolbar, click Add Row.
   A row appears underneath the toolbar.
2. In the list under Segment, select a segment of the segment group.
3. On the Policy Parameters subtab, under Replenishment Policy, in Policy Type, select the policy type for the segment.
4. In Policy UOM, select the unit of measure (UOM) for the policy type.
The policy parameters are calculated based on the UOM.

5. In **Fixed Order Cycle Calendar**, select a calendar for the policy type.

   This list is enabled when you select **Fixed order cycle** in the Policy Type list.


7. In **Safety Stock Days of Cover**, enter the number of days to be covered by the safety stock.

   This field is enabled when you select **Days of cover** in the Safety Stock Calculation list.

8. In **Days of Cover Basis**, select whether the average daily demand should be calculated based on the history or forecast.

9. In **Horizon for Average Daily Demand**, enter the number of days of the history or forecast for which the daily demand is averaged.

10. In **Extrapolation Percentage**, enter the value by which the average demand should be increased.

    This field is enabled when you select **History** in the Days of Cover Basis list.

11. In **Target Service Level Percentage**, enter the value for calculation of the safety stock.

    This field is enabled when you select **Service level-based** in the Safety Stock Calculation list.


    This list is enabled when you select **Min-max planning** or **Fixed order cycle** in the Policy Type list.

13. In **Maximum Quantity Days of Cover**, enter the number of days for which the maximum quantity must be held.

    This list is enabled when you select **Days of cover** in the Maximum Quantity Calculation Method list.

14. Repeat Steps 1 through 13 for other segments.

15. Click **Save**.

**Define Default Policy Parameters**

Follow these steps to define default policy parameters for item-location combinations in a segment:

1. On the Segment-Level Policy Parameters Assignment tab, under the toolbar, select a segment.

2. On the Default Policy Parameters subtab, in **Default Daily Demand**, enter the default value for the daily demand.

   This value is used if history or forecast data is unavailable for the calculation of the average daily demand.

3. Enter these values:

<table>
<thead>
<tr>
<th>If You Selected One of These Combinations on the Policy Parameters Subtab</th>
<th>Then on the Default Policy Parameters Subtab</th>
</tr>
</thead>
<tbody>
<tr>
<td>o Min-max planning or Fixed order cycle in the Policy Type list and Minimum plus order quantity in the Maximum Quantity Calculation Method list</td>
<td>o In Default Order Quantity, enter the default value for the order quantity.</td>
</tr>
<tr>
<td>o ROP and order quantity in the Policy Type list</td>
<td></td>
</tr>
<tr>
<td>o Min-max planning or Fixed order cycle in the Policy</td>
<td>o In Default EOQ, enter the default economic order quantity (EOQ).</td>
</tr>
</tbody>
</table>

---

Oracle SCM Cloud

Using Replenishment Planning

Chapter 9

Policy Assignment Sets

117
If You Selected One of These Combinations on the Policy Parameters Subtab

<table>
<thead>
<tr>
<th>Type list and Minimum plus EOQ in the Maximum Quantity Calculation Method list</th>
<th>Then on the Default Policy Parameters Subtab</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROP and order quantity or ROP and EOQ in the Policy Type list</td>
<td>If you specify this default, you can't specify the default standard cost, default carrying cost percentage, and default ordering cost.</td>
</tr>
<tr>
<td></td>
<td>- In Default Standard Cost, enter the default standard cost.</td>
</tr>
<tr>
<td></td>
<td>- In Default Carrying Cost Percentage, enter the default carrying cost percentage.</td>
</tr>
<tr>
<td></td>
<td>- In Default Ordering Cost, enter the default ordering cost.</td>
</tr>
</tbody>
</table>

4. Repeat Steps 1 through 3 for other segments.
5. Click Save.

Define Policy Parameter Overrides

Follow these steps to define policy parameter overrides for item-location combinations in a segment:

1. On the Segment-Level Policy Parameters Assignment tab, under the toolbar, select a segment.
2. On the Policy Parameters Overrides subtab, in Safety Stock Override, enter the override value for the safety stock.
3. In Order Quantity Override, enter the override value for the order quantity.
4. In Minimum Override, enter the override value for the minimum order quantity.
   
   The minimum override must be greater than or equal to the safety stock override.

   This field is enabled when you select Min-max planning in the Policy Type list on the Policy Parameters subtab.
5. In EOQ Override, enter the override value for the EOQ.
6. In Maximum Override, enter the override value for the maximum order quantity.
   
   The maximum override must be greater than or equal to the minimum override and safety stock override.

   This field is enabled when you select Min-max planning or Fixed order cycle in the Policy Type list on the Policy Parameters subtab.
7. In ROP Override, enter the override value for the reorder point (ROP).
   
   The ROP override must be greater than or equal to the safety stock override.

   This field is enabled when you select ROP and order quantity or ROP and EOQ in the Policy Type list on the Policy Parameters subtab.
8. Repeat Steps 1 through 8 for other segments.
9. Click Save.

Define Item-Location Level Policy Overrides

Follow these steps to define overrides at the item-location level for the segment group:

1. On the Item-Location Level Policy Overrides tab, on the toolbar, click Add Row.
   
   A row appears under the column headings.
2. In the list under Item, select an item of the segment group.
3. In the list under Location, select a location for the item.
4. In the list under Policy Type, select a policy type for the item-location combination.
5. In the list under **Policy UOM**, select the UOM for the policy type.

6. In the field under **Safety Stock Override**, enter the override value for the safety stock.

7. In the field under **Minimum Override**, enter the override value for the minimum order quantity.
   
   The minimum override must be greater than or equal to the safety stock override.
   
   This field is enabled when you select **Min-max planning** in the **Policy Type** list.

8. In the field under **Maximum Override**, enter the override value for the maximum order quantity.
   
   The maximum override must be greater than or equal to the minimum override and safety stock override.
   
   This field is enabled when you select **Min-max planning** or **Fixed order cycle** in the **Policy Type** list.

9. In the field under **ROP Override**, enter the override value for the ROP.
   
   The ROP override must be greater than or equal to the safety stock override.
   
   This field is enabled when you select **ROP and order quantity** or **ROP and EOQ** in the **Policy Type** list.

10. In the field under **Order Quantity Override**, enter the override value for the order quantity.
   
   This field is enabled when you select **ROP and order quantity** in the **Policy Type** list.

11. In the field under **EOQ Override**, enter the override value for the EOQ.
   
   This field is enabled when you select **ROP and EOQ** in the **Policy Type** list.

12. In the list under **Fixed Order Cycle Calendar**, select a calendar for the policy type.
   
   This list is enabled when you select **Fixed order cycle** in the **Policy Type** list.

13. Repeat Steps 1 through 12 for other item-locations combinations.

14. Click **Save**.

---

**Edit a Policy Assignment Set**

You can duplicate, edit, and delete a policy assignment set.

The changes you can make to the policy assignment set are limited. You can't change the policy assignment set's name, and you can't delete it if it's being used in a replenishment plan. To change the segment group, you first have to delete all the segments from the policy assignment set.

You can duplicate the policy parameters that you have specified for a segment and reuse them in another segment.

**Edit the Parameters for a Segment**

You can edit the policy parameters, default policy parameters, and policy parameter overrides defined for a segment of the segment group that's attached to the policy assignment set.

Any change that you make to the policy parameters takes effect the next time you run the associated replenishment plan with the **Calculate policy parameters** check box selected on the Plan Options page.

**Edit the Item-Location Level Policy Overrides**

You can edit the item-location level policy overrides defined for the segment group that's attached to the policy assignment set.

Any change that you make to the item-location level policy overrides takes effect the next time you run the associated replenishment plan with the **Calculate policy parameters** check box selected on the Plan Options page.
Edit Policy Parameters for Segments Within a Replenishment Plan

Within a replenishment plan, you can edit the policy parameters, default policy parameters, and policy parameter overrides for the associated policy assignment set.

Follow these steps to edit the segment-level policy parameters from within the replenishment plan:

1. On the Tasks panel tab, under Plan, select Manage Plans.
   
   The Manage Plans page opens.
2. Select the replenishment plan for which you want to edit the segment-level policy parameters, and click Actions > Open.
   
   The replenishment plan opens.
3. Click the Open drop-down button.
   
   The Open Table, Graph, or Tile Set dialog box opens.
4. Search for the Manage Policy Assignments table, select it, and click OK.
   
   The Manage Policy Assignments table opens.
5. On the Segment-Level Policy Parameters Assignment subtab for the table, select the segment for which you want to edit policy parameters, and edit them.

   Note: You can only view details on the Item-Location Level Policy Overrides subtab. To change item-location level policy overrides, edit the Manage Policy Parameters by Item or Replenishment Workbench table.

6. Click the Save drop-down button.
7. Click Actions > Run to run the replenishment plan again.

   On the Parameters tab of the Run Plan dialog box, under Scope Options, ensure that the Calculate policy parameters check box is selected.

   Under Data Refresh Options, select Do not refresh with current data.
8. If you're satisfied with the changes, save them to the policy assignment set by clicking Actions > Save Changes to Policy Assignment Set.

   The Save Changes to Policy Assignment Set dialog box opens and displays the changes that you have saved to the policy parameters within the replenishment plan but not saved to the policy assignment set.

   If you don't save the changes, they're lost the next time you run the replenishment plan with the Refresh with current data option selected under Data Refresh Options on the Parameters tab of the Run Plan dialog box.

9. Review the changes that you made to the policy parameters for each segment.
10. Under Changes to Save, select the check boxes for the segments for which you want to save changes to the policy assignment set.
11. Click OK.
Edit Policy Values for Items Within a Replenishment Plan

Within a replenishment plan, you can edit some policy values for item-location combinations of the associated segment group.

Changes to policy values for item-location combinations within the replenishment plan persist until you override the changes. These changes also take precedence over the item-location level policy overrides specified in the associated policy assignment set but aren't updated there.

You can use the following tables to change the policy values for item-location combinations:

- **Manage Policy Parameters by Item**: Use this table when you want to change policy values for all days. Using this table, you can change the minimum quantity, maximum quantity, minimum days, maximum days, reorder point (ROP) quantity, ROP days, and economic order quantity (EOQ) for an item-location combination.
- **Replenishment Workbench**: Use this table when you want to change policy values for specific days. Using this table, you can change the shipments forecast, gross forecast, net forecast, planned replenishments by due date, minimum quantity, and maximum quantity for the item-location combination.

Other changes to the policy values for the item-location combination must be done on the Item-Location Level Policy Overrides tab of the policy assignment set.

**Note**: To change the policy parameters for all item-location combinations of a segment for all days, edit the Manage Policy Assignments table.

**Edit Policy Parameters of Item-Location Combinations**

Follow these steps to edit policy values for item-location combinations in the replenishment plan:

1. On the Tasks panel tab, under Plan, select **Manage Plans**.
   
   The Manage Plans page opens.

2. Select the replenishment plan for which you want to edit the item-location level policy values, and click **Actions > Open**.
   
   The replenishment plan opens.

3. Click the **Open** drop-down button.
   
   The Open Table, Graph, or Tile Set dialog box opens.

4. Search for the Manage Policy Parameters by Item or Replenishment Workbench table, select it, and click **OK**.
   
   The Manage Policy Parameters by Item or Replenishment Workbench table opens.

5. On the toolbar, click **View > Highlight Editable Cells** to identify the cells that you can edit.

6. Filter the rows by a segment of the segment group.

7. For an item-location combination for which you want to edit policy values, enter values in the editable cells. In the Replenishment Workbench, edit the cells for specific days.

8. Repeat Steps 6 and 7 for the item-location combinations for which you want to make changes.

9. Click the **Save** drop-down button.

10. Click **Actions Run** to run the replenishment plan again.

   On the Parameters tab of the Run Plan dialog box, under **Scope Options**, ensure that the **Calculate replenishments** check box is selected.
Work With the Policy Comparison Feature

Overview of the Policy Comparison Feature

The policy comparison feature automates the comparison of suggested policy parameters with existing policy parameters. You can set a threshold percentage for automatically accepting suggested policy parameters and manually accept or reject the remaining, suggested policy parameters.

The following policy parameters are compared:

- Minimum quantity
- Maximum quantity
- Reorder point (ROP) quantity
- ROP days
- Minimum days
- Maximum days

This table lists the policy parameters that are compared for different policy types and units of measure (UOMs):

<table>
<thead>
<tr>
<th>Policy Type</th>
<th>UOM</th>
<th>Compared Policy Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min-max planning</td>
<td>Days</td>
<td>Minimum days and maximum days</td>
</tr>
<tr>
<td>Min-max planning</td>
<td>Units</td>
<td>Minimum quantity and maximum quantity</td>
</tr>
<tr>
<td>Fixed order cycle</td>
<td>Days</td>
<td>Maximum days</td>
</tr>
<tr>
<td>Fixed order cycle</td>
<td>Units</td>
<td>Maximum quantity</td>
</tr>
<tr>
<td>ROP and order quantity</td>
<td>Days</td>
<td>ROP days</td>
</tr>
<tr>
<td>ROP and order quantity</td>
<td>Units</td>
<td>ROP quantity</td>
</tr>
<tr>
<td>ROP and economic order quantity (EOQ)</td>
<td>Days</td>
<td>ROP days</td>
</tr>
<tr>
<td>ROP and EOQ</td>
<td>Units</td>
<td>ROP quantity</td>
</tr>
</tbody>
</table>
Benefits of the Policy Comparison Feature

By using the policy comparison feature, you can avail of these benefits:

- Automatically accept suggested policy parameters if the percentage of deviation between them and the existing policy parameters is within the threshold. Therefore, you can avoid having to manually review the suggested policy parameters for millions of item-location combinations and improve the efficiency and accuracy of your policy comparison process.
- Manually accept or reject suggested policy parameters if the percentage of deviation between them and the existing policy parameters is above the threshold.
- Use embedded analytics to review the policy comparison process.

Set Up the Policy Comparison Feature

To set up the policy comparison feature, you must do the following:

1. Create a policy comparison plan for which the **Calculate policy parameters** check box is selected and the **Calculate replenishments** check box not selected on the Plan Options page.
   
   Moreover, in the Scope: Advanced Options dialog box, you must select the **Enable for policy comparison** check box and enter a value in the **Threshold Percentage for Policy Comparison** field.

   Optionally, select the **Retain policy overrides** check box to retain manual policy overrides after the replenishment plan is run with the **Refresh with current data** option selected in the Run Plan dialog box. The manual overrides are retained even if the deviation percentages between the suggested and existing policy parameters are within the threshold.

2. Run the policy comparison plan with the **Refresh with current data** option selected in the Run Plan dialog box.

3. Use the policy comparison plan to provide the updated policy parameters to an integrated replenishment plan or automated execution plan.

Related Topics

- Create a Replenishment Plan
- Set Up Policy Comparisons and Retain Policy Overrides
- Best Practices for Setting Up Replenishment Plans

How You Use the Policy Comparison Feature

The following is the process for using the policy comparison feature:

1. Set up a policy comparison plan.
   
   In the Scope: Advanced Options dialog box of the Scope tab of the Plan Options page, select the **Enable for policy comparison** check box, and enter a value in the **Threshold Percentage for Policy Comparison** field.

2. Run the policy comparison plan.
   
   When the deviation percentages between the suggested policy parameters and existing policy parameters are within the threshold, the suggested policy parameters are automatically accepted.

3. Review the remaining, suggested policy parameters.
   
   - Manually accept those suggested policy parameters that don't require changes.
Manually adjust those suggested policy parameters that require changes.
Mark the remaining, suggested policy parameters as reviewed, or leave them as is.

These suggested policy parameters don’t take effect.

4. Update the policy measures so that the manually accepted or adjusted policy parameters overwrite the corresponding, existing policy parameters for item-location combinations.

The updated policy parameters are then used by the integrated replenishment plan or automated execution plan that’s linked to the policy comparison plan.

The following is the flow chart for using the policy comparison feature:

**Related Topics**
- Best Practices for Setting Up Replenishment Plans
- Run a Replenishment Plan
# Measures Used for Comparing Policy Parameters

This topic lists the measures that are used for comparing policy parameters. These measures provide the following kinds of information:

- Summary of the policy comparison process
- Existing policy parameters and whether they were calculated or adjusted
- Suggested policy parameters
- Percentages of deviation between the existing and suggested policy parameters

## Measures that Provide a Summary of the Policy Comparison Process

These measures provide a summary of the policy comparison process:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policies Automatically Accepted</td>
<td>Number of item-location combinations with policy parameters that are automatically accepted. The policy parameters have the Automatically accepted status.</td>
</tr>
<tr>
<td>Policies Manually Accepted</td>
<td>Number of item-location combinations with policy parameters that are manually accepted. The policy parameters have the Manually accepted status.</td>
</tr>
<tr>
<td>Policies to Review</td>
<td>Number of item-location combinations with policy parameters that must be reviewed. The policy parameters have the To be reviewed status.</td>
</tr>
<tr>
<td>Policies Reviewed</td>
<td>Number of item-location combinations with policy parameters that are reviewed. The policy parameters have the Reviewed status.</td>
</tr>
<tr>
<td>Policies Adjusted</td>
<td>Number of item-location combinations with policy parameters that are manually adjusted (overridden). The policy parameters have the Adjusted status.</td>
</tr>
<tr>
<td>Policies Retained</td>
<td>Number of item-location combinations with policy parameter overrides that are retained. The policy parameters have the Retained status.</td>
</tr>
</tbody>
</table>

Policy parameter overrides are retained when the **Retain policy overrides** check box is selected in the Scope: Advanced Options dialog box on the Scope tab of the Plan Options page for a replenishment plan.
Measures for Existing Policy Parameters
These measures provide information about the existing policy parameters and whether they were calculated or adjusted:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous Minimum Days</td>
<td>Days previously calculated for the Minimum Days measure.</td>
</tr>
<tr>
<td>Previous Minimum Days Type</td>
<td>Indicator specifying whether the previous value of the Minimum Days measure was calculated or adjusted.</td>
</tr>
<tr>
<td>Previous Maximum Days</td>
<td>Days previously calculated for the Maximum Days measure.</td>
</tr>
<tr>
<td>Previous Maximum Days Type</td>
<td>Indicator specifying whether the previous value of the Maximum Days measure was calculated or adjusted.</td>
</tr>
<tr>
<td>Previous Minimum Quantity</td>
<td>Quantity previously calculated for the Minimum Quantity measure.</td>
</tr>
<tr>
<td>Previous Minimum Quantity Type</td>
<td>Indicator specifying whether the previous value of the Minimum Quantity measure was calculated or adjusted.</td>
</tr>
<tr>
<td>Previous Maximum Quantity</td>
<td>Quantity previously calculated for the Maximum Quantity measure.</td>
</tr>
<tr>
<td>Previous Maximum Quantity Type</td>
<td>Indicator specifying whether the previous value of the Maximum Quantity measure was calculated or adjusted.</td>
</tr>
<tr>
<td>Previous ROP Days</td>
<td>Reorder point (ROP) days previously calculated for the ROP Days measure.</td>
</tr>
<tr>
<td>Previous ROP Days Type</td>
<td>Indicator specifying whether the previous value of the ROP Days measure was calculated or adjusted.</td>
</tr>
<tr>
<td>Previous ROP Quantity</td>
<td>ROP quantity previously calculated for the ROP Quantity measure.</td>
</tr>
<tr>
<td>Previous ROP Quantity Type</td>
<td>Indicator specifying whether the previous value of the ROP Quantity measure was calculated or adjusted.</td>
</tr>
</tbody>
</table>

Before the policy comparison process begins, the existing policy parameters are copied into these measures.
# Measures for Suggested Policy Parameters

These measures provide information about the suggested policy parameters:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suggested Average Daily Demand</td>
<td>Suggested average daily demand.</td>
</tr>
<tr>
<td>Suggested EOQ</td>
<td>Suggested economic order quantity (EOQ).</td>
</tr>
<tr>
<td>Suggested Minimum Days</td>
<td>Suggested minimum days.</td>
</tr>
<tr>
<td>Suggested Maximum Days</td>
<td>Suggested maximum days.</td>
</tr>
<tr>
<td>Suggested Minimum Quantity</td>
<td>Suggested minimum quantity.</td>
</tr>
<tr>
<td>Suggested Maximum Quantity</td>
<td>Suggested maximum quantity.</td>
</tr>
<tr>
<td>Suggested Order Quantity</td>
<td>Suggested order quantity.</td>
</tr>
<tr>
<td>Suggested Policy Type</td>
<td>Suggested policy type.</td>
</tr>
<tr>
<td></td>
<td>The value is the existing policy type.</td>
</tr>
<tr>
<td>Suggested Policy UOM</td>
<td>Suggested unit of measure (UOM).</td>
</tr>
<tr>
<td></td>
<td>The value is the existing UOM.</td>
</tr>
<tr>
<td>Suggested ROP Days</td>
<td>Suggested ROP days.</td>
</tr>
<tr>
<td>Suggested ROP Quantity</td>
<td>Suggested ROP quantity.</td>
</tr>
<tr>
<td>Suggested Safety Stock</td>
<td>Suggested safety stock.</td>
</tr>
<tr>
<td>Suggested Safety Stock Days</td>
<td>Suggested safety stock days.</td>
</tr>
</tbody>
</table>

You can use the Suggested Replenishment Policy Parameters table for the replenishment plan to view these measures.
Measures for Deviation Percentages Between Existing and Suggested Policy Parameters

These measures provide the percentages of deviation between the existing and suggested policy parameters:

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Days Deviation</td>
<td>Percentage of deviation between the Previous Minimum Days and Suggested Minimum Days measures.</td>
</tr>
<tr>
<td>Maximum Days Deviation</td>
<td>Percentage of deviation between the Previous Maximum Days and Suggested Maximum Days measures.</td>
</tr>
<tr>
<td>Minimum Quantity Deviation</td>
<td>Percentage of deviation between the Previous Minimum Quantity and Suggested Minimum Quantity measures.</td>
</tr>
<tr>
<td>Maximum Quantity Deviation</td>
<td>Percentage of deviation between the Previous Maximum Quantity and Suggested Maximum Quantity measures.</td>
</tr>
<tr>
<td>ROP Days Deviation</td>
<td>Percentage of deviation between the Previous ROP Days and Suggested ROP Days measures.</td>
</tr>
<tr>
<td>ROP Quantity Deviation</td>
<td>Percentage of deviation between the Previous ROP Quantity and Suggested ROP Quantity measures.</td>
</tr>
</tbody>
</table>

Work with the Manage Policy Comparison Table

This topic explains how you work with the Manage Policy Comparison table for a policy comparison plan.

Manage Policy Comparison Table

After the policy comparison plan is run, the Manage Policy Comparison table lists the existing and suggested policy parameters for each item-location combination. The percentage of deviation between an existing and a suggested policy parameter is also provided.

The Policy Review Status column indicates the statuses of the policies for the item-location combination:

<table>
<thead>
<tr>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically accepted</td>
<td>The suggested policy parameters for the item-location combination have been automatically accepted because the percentages of deviation were within the threshold. This threshold was specified in the Threshold Percentage for Policy Comparison field in the Scope: Advanced Options dialog box of the Scope tab of the Plan Options page.</td>
</tr>
</tbody>
</table>
### Status | Meaning
--- | ---
Manually accepted | The accepted policy parameters can be seen in the Replenishment Policy Parameters table and are ready for use by the integrated replenishment plan or automated execution plan that’s linked to the policy comparison plan.
To be reviewed | You have accepted the suggested policy parameters for the item-location combination.
The percentages of deviation are above the threshold.
Reviewed | The suggested policy parameters for the item-location combination must be reviewed because the percentages of deviation are above the threshold.
Adjusted | You have reviewed the suggested policy parameters that had the To be reviewed status for the item-location combination and neither accepted or modified them.
Retained | You have manually adjusted the suggested policy parameters for the item-location combination.
The adjustments you made to the policy parameters for the item-location combination before the latest run of the policy comparison plan have been retained.

The adjustments are retained because you selected the **Retain policy overrides** check box in the Scope: Advanced Options dialog box of the Scope tab of the Plan Options page. When this check box is selected, the adjustments are retained even if the deviation percentages between the suggested and existing policy parameters are within the threshold.
The retained policy parameters can be seen in the Replenishment Policy Parameters table and are ready for use by the integrated replenishment plan or automated execution plan that’s linked to the policy comparison plan.
The Retained status is also used when the item-location combination is subject to an override that’s specified in the policy assignment set that’s attached to the policy comparison plan. In such cases, no policy comparison takes place.

### Work with the Manage Policy Comparison Table
To work with the Manage Policy Comparison table, follow these steps:

1. Do one of the following to open the policy comparison plan:
   - To open the policy comparison plan using the Manage Plans page:
     1. On the Tasks panel tab, under Plans, select **Manage Plans**.
        The Manage Plans page opens and displays the available replenishment plans.
     2. Select the policy comparison plan, and click **Actions > Open**.
        The policy comparison plan opens in a separate tab.
   - On the Plans panel tab, under Plans, right-click the policy comparison plan, and select **Open**.
      The policy comparison plan opens in a separate tab.
   2. Click the **Open** drop-down button.
The Open Table, Graph, or Tile Set dialog box opens.

3. Search for the Manage Policy Comparison table, select it, and click OK.

The Manage Policy Comparison table opens in a separate subtab of the policy comparison plan.

4. Search for the segment that you want to work with.

To narrow your search, filter the rows by the To be reviewed status of the Policy Review Status column.

5. Follow these steps to adjust, review, or accept the suggested policy parameters:

<table>
<thead>
<tr>
<th>Objective</th>
<th>Steps</th>
</tr>
</thead>
</table>
| To adjust the policy parameters for an item-location combination | a. Select the row for the item-location combination. The cells for the adjusted values are enabled for entry. You can perform this step for only those item-location combinations that have the To be reviewed or Retained status.  
| | b. For the policy parameter that you want to edit, enter an adjusted value. If the policy type is min-max planning, the adjustments for both the minimum and maximum values must be specified. The final policy parameters for the item-location combination are adjusted accordingly, and the status is changed to Adjusted. |
| To mark the suggested policy parameters for the item-location combination as reviewed | a. Select the row for the item-location combination. You can perform this step for only those item-location combinations that have the To be reviewed status.  
| | b. Click Actions > Mark as Reviewed. The status for the item-location combination is changed from To be reviewed to Reviewed. The existing policy parameters for the item-location combination remain unchanged. |
| To accept the suggested policy parameters for the item-location combinations that are displayed after your search | Click Actions > Accept All, and click Yes in the warning message that appears. For the item-location combinations with the To be reviewed status, the final policy parameters are updated accordingly, and the status changes to Manually accepted. |
| To accept the suggested policy parameters for selected item-location combinations | a. Select the rows for the item-location combinations. The status for these item-location combinations should be To be reviewed.  
| | b. Click Actions > Accept Suggested Policies. The final policy parameters for the item-location combinations are updated accordingly, and the status changes to Manually accepted. |

6. Click Actions > Update Policy Measures to update the policy parameters for those item-location combinations for which you have manually adjusted or accepted the suggested policy parameters.

The updated policy parameters for the item-location combinations take effect when the linked integrated replenishment plan or automated execution plan is run.

7. Save the Manage Policy Comparison table.

Points to Remember While Working with the Policy Comparison Feature

Be aware of these points while working with the policy comparison feature:

- If policy parameters don't exist for item-location combinations, or if the policy type or unit of measure (UOM) is changed, the suggested policy parameters are automatically accepted.
• Policies aren't compared for those item-location combinations that are covered by overrides in the policy assignment set that's attached to the policy comparison plan.

• For a min-max planning policy, the deviation percentages between the suggested and existing values for both the minimum and maximum days or quantities must be within the threshold for the policy to be automatically accepted.

• The threshold for automatically accepting suggested policy parameters must be set with care. Permanently setting the threshold at a low level can decrease the efficiency of your policy comparison process. Start with a low threshold value, and increase it when you get comfortable with using the policy comparison feature.

Related Topics
• Best Practices for Setting Up Replenishment Plans
• Set Up Policy Comparisons and Retain Policy Overrides

How You Use the Policy Comparison Analytics

This topic explains how you use the predefined analytics for the policy comparison feature in a policy comparison plan.

Use the Policy Comparison Summary Tile Set

For using the analytics for the policy comparison feature, you must create a page layout that uses the predefined Policy Comparison Summary tile set. The predefined page layouts don't include this tile set.

The Policy Comparison Summary tile set includes the following:

• Policy Comparison Tile: The tile provides a plan-level summary of the policy parameters that are in the To be reviewed or Automatically accepted status.

• Policy Comparison Summary by Segment Graph: The graph provides a segment-wise breakup of the policy parameters in the Automatically accepted or To be reviewed status. By default, the graph is linked to the Manage Policy Comparison and Policy Comparison Summary by Location tables.

• Policy Review Status by Segment Table: The table provides a segment-wise breakup of the policy parameters in various statuses. By default, the table is linked to the Manage Policy Comparison and Policy Comparison Summary by Location tables.

The following example shows how you use the Policy Comparison Summary tile set to effectively use the policy comparison feature:

1. Run the policy comparison plan.
2. Open the page layout that has the Policy Comparison Summary tile set.
3. Identify the segment that has the most policy parameters with the To be reviewed status.
4. Select the graph bar or table cell for the policy parameters with the To be reviewed status:
   o To view a list of the locations to which the policy parameters pertain, click Actions > Drill To > Default Group > Manage Policy Comparison Summary by Location.

   The Policy Comparison Summary by Location table opens in a subtab and displays the policy parameters that have the To be reviewed or Automatically accepted status for various locations of the segment.

   You can select a cell and click Actions > Drill To > Manage Policy Comparison to view policy parameters for the items in a location and act on them.
To view a list of the item-location combinations to which the policy parameters pertain, and take action on them, do the following:

i. Click **Actions > Drill To > Manage Policy Comparison**.

   The Manage Policy Comparison table opens in a subtab and displays the segment's item-location combinations that have the policy parameters with the searched status.

ii. Select the rows for the item-location combinations, and work with the suggested policy parameters.

iii. Click **Actions > Update Policy Measures**.

5. Return to the page layout that has the Policy Comparison Summary tile set, and click **View > Refresh**.

The updated information about the policy parameters is displayed.
10 Statistical Forecasts

Create a Forecasting Profile

A forecasting profile is a collection of definitions used during the generation of demand forecasts. Each profile includes the definitions of the forecasting methods used and at what level demand data is aggregated. The profile also includes the causal factors used to explain variations in demand and the groups they’re assigned to for decomposition purposes.

Predefined Forecasting Profiles

This table lists the predefined forecasting profiles:

<table>
<thead>
<tr>
<th>Forecasting Profile</th>
<th>Work Area</th>
<th>Input Measure</th>
<th>Output Measure</th>
<th>Forecasting Table</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast Bookings</td>
<td>Demand Management</td>
<td>Final Bookings History</td>
<td>Bookings Forecast</td>
<td>Forecast Bookings Definitions</td>
<td>For forecasting on the basis of bookings history</td>
</tr>
<tr>
<td></td>
<td>Demand and Supply Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Bookings Including Event Activity</td>
<td>Demand Management</td>
<td>Final Bookings History</td>
<td>Bookings Forecast</td>
<td>Forecast Bookings Definitions</td>
<td>For forecasting on the basis of bookings history while incorporating the impact of events</td>
</tr>
<tr>
<td></td>
<td>Demand and Supply Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Consumption</td>
<td>Replenishment Planning</td>
<td>Final Consumption History</td>
<td>Consumption Forecast</td>
<td>Forecast Consumption Definitions</td>
<td>For forecasting on the basis of consumption history</td>
</tr>
<tr>
<td>Forecast Shipments</td>
<td>Demand Management</td>
<td>Final Shipments History</td>
<td>Shipments Forecast</td>
<td>Forecast Shipments Definitions</td>
<td>For forecasting on the basis of shipments history</td>
</tr>
<tr>
<td></td>
<td>Demand and Supply Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Replenishment Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Shipments Including Event Activity</td>
<td>Demand Management</td>
<td>Final Shipments History</td>
<td>Shipments Forecast</td>
<td>Forecast Shipments Definitions</td>
<td>For forecasting on the basis of shipments history while incorporating the impact of events</td>
</tr>
<tr>
<td></td>
<td>Demand and Supply Planning</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
You can't edit predefined forecasting profiles. However, you can modify copies of predefined forecasting profiles for your use.

Create a Forecasting Profile
Follow these steps to create a forecasting profile:

1. In the Demand Management, Demand and Supply Planning, or Replenishment Planning work area, on the Tasks panel tab, under Configuration, select Manage Forecasting Profiles.

   The Manage Forecasting Profiles page opens.

2. Click Actions > Create.

   The Manage Forecasting Profiles page opens.

3. Enter the name and description for the forecasting profile.

4. In Enable in Work Area, select the check boxes for the work areas in which the forecasting profile should be available.

   After the forecasting profile is created, it'll be visible on the Managing Forecasting Profiles page in only these work areas. Moreover, during the creation of a demand plan, demand and supply plan, or replenishment plan, in the Forecast Profiles section of the Demand tab of the Plan Options page, only the forecasting profiles enabled for the work area can be selected.

5. In Forecasting Table, select the forecasting table for the forecasting profile.

   The forecasting table defines the data aggregation levels that are used in the forecasts.

   The list displays only the tables available in the selected work areas.

6. In Input Measure, select the input measure for the forecasting profile.

   This measure's data is used as the basis of historical demand in forecasts.

   The measures available for selection are in the selected forecasting table and are dimensioned by time.

7. In Output Measure, select the output measure for the forecasting profile.

   This measure stores the forecast after the plan is run.

   The measures available for selection are in the selected forecasting table and are dimensioned by time. Moreover, the available measures can't be shared across plans and are refreshed with current data.

8. In Measure Catalogs, select the measure catalogs for the forecasting profile.

   Select all the measure catalogs that you anticipate are required for plans that use the forecasting profile. Predefined measure catalogs aren't available for selection.

9. Use the Forecasting Methods tab to configure the forecasting methods and method parameters for the forecasting profile.

    For instructions, refer to the topic on forecasting methods in this chapter.

10. Use the Decomposition Groups tab to select and configure decomposition groups for the forecasting profile.

     For instructions, refer to the topic on decomposition groups in this chapter.

11. Use the Forecasting Parameters tab to select and configure forecasting parameters for the forecasting profile.

     For instructions, refer to the topic on forecasting parameters in this chapter.

12. Click Save and Close.
Related Topics

- Create Measures and Assign to a Measure Catalog

Edit a User-Defined Forecasting Profile

You can duplicate, edit, or delete a user-defined forecasting profile.

You can’t edit a predefined forecasting profile. However, you can duplicate the predefined forecasting profile and edit the copy.

To delete the user-defined forecasting profile, you must first deselect it for the associated demand, demand and supply, or replenishment plan in the Forecast Profiles section on the Demand tab of the Plan Options page.

Follow these steps to edit the user-defined forecasting profile:

1. In the Demand Management, Demand and Supply Planning, or Replenishment Planning work area, on the Tasks panel tab, under Configuration, select Manage Forecasting Profiles.

   The Manage Forecasting Profiles page opens.

2. Select the forecasting profile, and click Actions > Edit

   The Manage Forecasting Profiles page opens.

3. Edit the name and description as required.

4. In Enable in Work Area, select or deselect the work areas in which the forecasting profile should be available.

   You can’t deselect a work area if the forecasting profile is associated with a plan in that work area. Before deselecting the work area, you must first deselect the forecasting profile for the plan in the Forecast Profiles section on the Demand tab of the Plan Options page.

5. In Forecasting Table, select the forecasting table that defines the data aggregation levels that are used in the forecasts.

   The list displays only the tables available in the selected work areas.

   If you changed the selected work areas and the previously selected forecasting table isn't available in all the selected work areas, you must select another forecasting table.

6. In Input Measure, select the input measure for the forecasting profile.

   This measure's data is used as the basis of historical demand in forecasts.

   The measures available for selection are in the selected forecasting table and are dimensioned by time.

7. In Output Measure, select the output measure for the forecasting profile.

   This measure stores the forecast after the plan is run.

   The measures available for selection are in the selected forecasting table and are dimensioned by time. Moreover, the available measures can’t be shared across plans and are refreshed with current data.

8. In Measure Catalogs, select the measure catalogs for the forecasting profile.

   Select all the measure catalogs that you anticipate are required for plans that use the forecasting profile. Predefined measure catalogs aren't available for selection.

9. Use the Forecasting Methods tab to configure the forecasting methods and method parameters for the forecasting profile.
For instructions, refer to the topic on forecasting methods in this chapter.

10. Use the Decomposition Groups tab to select and configure decomposition groups for the forecasting profile. If you add a causal factor (measure) to a decomposition group, and that measure isn’t available in each of the selected work areas for the forecasting profile, you can’t save your changes. You must change the work areas selected for the forecasting profile or add the measure to these work areas.
   For instructions, refer to the topic on decomposition groups in this chapter.

11. Use the Forecasting Parameters tab to select and configure forecasting parameters for the forecasting profile.
   For instructions, refer to the topic on forecasting parameters in this chapter.

12. Click Save and Close.
   The edited forecasting profile takes effect the next time you run the associated plan.

Forecasting Methods

Oracle Demand Management Cloud provides 15 forecasting methods. You can use one or a combination of these forecasting methods, while configuring your forecasting profile. You can control the forecasting methods using the forecasting profiles available in the Manage Forecasting Profiles page.

While you review a forecasting combination, the forecast methods measure shows you the methods used in the last execution of your forecasting profile.

The following table lists the fifteen forecasting methods and its associated letter combinations.

<table>
<thead>
<tr>
<th>Forecast Method</th>
<th>Representative Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Regressive External Inputs</td>
<td>X</td>
</tr>
<tr>
<td>Auto Regressive Integrated Inputs</td>
<td>V</td>
</tr>
<tr>
<td>Auto Regressive Logistic</td>
<td>A</td>
</tr>
<tr>
<td>Causal Winters</td>
<td>B</td>
</tr>
<tr>
<td>Combined Transformation</td>
<td>E</td>
</tr>
<tr>
<td>Croston for Intermittent</td>
<td>F</td>
</tr>
<tr>
<td>Dual Group Multiplicative</td>
<td>D</td>
</tr>
<tr>
<td>Holt</td>
<td>H</td>
</tr>
<tr>
<td>Logistic</td>
<td>G</td>
</tr>
</tbody>
</table>
When you use a forecasting method in your profile, the letter representing the forecasting method is written as part of the forecast output. For example, when you use Forecast Shipments as the forecasting profile, the letters of the forecasting methods are written into the Shipments Forecasting Methods measure.

**Related Topics**
- Statistical Forecasts, Causal Factors, and Decomposition Groups

## Configure Decomposition Groups

A decomposition group is a container for the measures that you use as causal factors. Causal factors enable several forecasting methods to understand the variation in historical demand and produce an accurate and adoptive forecast. Decomposition groups allow you to organize measures that have similar impacts and effects on a forecast. The definitions are also used when the forecast is decomposed into causal factors, when using the forecast decomposition run plan option.

For your forecasting profile, you can add, edit, or delete decomposition groups. You can also activate and deactivate a group using the check box against each groups. Selecting a group enables all causal factors associated with that group.

To create a decomposition group:

1. On the **Decomposition Groups** tab in your forecasting profile, click Actions, then New.
2. On the **Create Decomposition Group** dialog, do the following:
   - Provide a name and description.
   - From the **Available Measures** list, move the required measures to the **Selected Measures** list.
3. Click **OK**.

To configure the causal factors in a decomposition group:

1. On the Decomposition Groups tab in your forecasting profile, expand a decomposition group.

<table>
<thead>
<tr>
<th>Forecast Method</th>
<th>Representative Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modified Ridge Regression</td>
<td>M</td>
</tr>
<tr>
<td>Multiplicative Monte Carlo Intermittent</td>
<td>K</td>
</tr>
<tr>
<td>Multiplicative Monte Carlo Regression</td>
<td>C</td>
</tr>
<tr>
<td>Regression</td>
<td>R</td>
</tr>
<tr>
<td>Regression for Intermittent</td>
<td>J</td>
</tr>
<tr>
<td>Transformation Regression</td>
<td>L</td>
</tr>
</tbody>
</table>
The expanded list detail the available causal factors.

2. You can select the check boxes:

- Short: Use short for the methods that use a limited set of causal factors. These methods include Regression and Causal Winters.
- Long: Use long for the methods that use an extended set of causal factors. These methods include Monte Carlo Regression.
- Multiplicative: Use multiplicative in the Dual Group Multiplicative forecasting method.
- Not Seasonal: Assigns the causal factor for use by auto regressive models that detect seasonal and repeating patterns automatically.
- Fill Missing: Controls whether 0 values for the causal factor will be replaced by another value. Enable this setting for causal factors which always have values. For example, price.

Forecasting Parameters

Forecasting parameters control the several aspects of a demand forecast such as, handling of missing values, outlier detection, fit and forecast validation, and sparse data forecasting.

You can improve the default settings based on your data analysis and forecast results.

The following table lists the commonly used forecasting parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FillMissingMethod</td>
<td>Specifies how to fill any undefined historical values. Parameter values may be 0, 1, 2. 0 for no missing values field. 1 for linear interpolation based on not missing neighbors. 2 for omitting missing values.</td>
</tr>
<tr>
<td>GlobalAllocationPeriods</td>
<td>Specifies the number of days to use for average demand calculation.</td>
</tr>
<tr>
<td>EnableNaiveForecast</td>
<td>Specifies whether naive modeling is used, and if so, what type. Parameter values may be 0 or a positive integer. Use 0 to disable naive modeling. 1 to use Oracle proprietary naive modeling. Any integer greater than 1 to use simple moving average with the value controlling number of historical periods used.</td>
</tr>
<tr>
<td>IntermitCriterion</td>
<td>Specifies the lowest percentage of zero values in historical demand for which the time series are evaluated using intermittent forecasting methods.</td>
</tr>
<tr>
<td>WriteFit</td>
<td>Specifies amount of historical forecast, or fit, persisted during the forecast process. Parameters values may be 0 or a positive integer. 0 to keep future forecast only. A positive integer to keep forecast for the last number of historical periods where the number is the positive integer. Definition of period can be daily, weekly, or monthly based on forecast calendar definition.</td>
</tr>
<tr>
<td>DetectOutlier</td>
<td>Specifies whether the engine should attempt to detect and smooth outliers in the time series.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OutlierSensitivity</td>
<td>Specifies the sensitivity of outlier detection. The greater the more liberal the detection. For common detection, use values less than 2.</td>
</tr>
<tr>
<td>RemoveExtremeOutlier</td>
<td>Specifies whether the engine should perform aggressive outlier smoothing. Enable this feature only if there is a clear cause to remove extreme values.</td>
</tr>
<tr>
<td>EnableFitValidation</td>
<td>Specifies whether to enable statistical fit validation. Yes to enable validation. No to disable validation.</td>
</tr>
<tr>
<td>EnableForecastValidation</td>
<td>Specifies whether to enable statistical forecast validation. Yes to enable validation. No to disable validation.</td>
</tr>
<tr>
<td>FitValidationSensitivity</td>
<td>Controls the sensitivity of fit validation. Forecast methods with MAPE greater than the specified value are rejected. The smaller the value the stricter is the validation. For loose validation use values between 1 and 2. For strict validation select values between .3 and .5.</td>
</tr>
<tr>
<td>ForecastValidationSensitivity</td>
<td>Specifies the sensitivity of forecast validation. The smaller the value, the stricter the test. For loose forecast validation use values between 5 and 10.</td>
</tr>
</tbody>
</table>

Additional forecasting parameters are available and you can include by selecting the **Actions** menu, and then the **Add** item. This provides a full list of all available forecasting parameters. Select the parameter you want, and click the **Add** button to include it in the forecasting profile.
11 Replenishment Plans

Create a Replenishment Plan

This topic explains how you create a replenishment plan in the Replenishment Planning work area.

To create the replenishment plan, follow these steps:

1. Do one of the following:
   - To create the replenishment plan from the Manage Plans page:
     i. On the Tasks panel tab, under Plans, select Manage Plans.
        The Manage Plans page opens.
     ii. Under Search Results, click Actions Create.
        The Plan Options page opens.
   - To directly create the replenishment plan, on the Plans panel tab, select Plans, and click Actions Create, or right-click Plans, and select Create.
        The Plan Options page opens.

2. Enter the name and description of the replenishment plan.

3. To make the replenishment plan measures available for reporting in Oracle Transactional Business Intelligence (OTBI), select the Enable for OTBI reporting check box.

4. Define the access level.
   - Select Public to make the replenishment plan available to all users.
   - Select Private to make the replenishment plan accessible to only yourself or other users to whom you want to provide access.

      If you select Private, the Edit Users icon is enabled. Click this icon to open the Users dialog box in which you can edit the list of users who can open the replenishment plan.

5. In Owner, select the replenishment plan’s owner.
6. Select the check boxes:

<table>
<thead>
<tr>
<th>Check Box</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable for incremental planning</td>
<td>Select this check box to process only those item-location combinations with net changes in supplies and demands in subsequent plan runs after the initial plan run.</td>
</tr>
<tr>
<td>Generate forecast</td>
<td>Select this check box to use the replenishment plan to generate the demand forecast.</td>
</tr>
</tbody>
</table>

   - This check box can be used with only the Calculate replenishments check box.

   - If you select this check box, the Demand tab is enabled, and you need to select a forecasting profile on that tab for the replenishment plan.
### Check Box | Feature
---|---
If you don't select this check box, you can use a demand plan, another replenishment plan that has the **Generate forecast** check box selected, or an external forecast schedule for the demand forecast. Under Demand Schedules on the Organizations and Schedules subtab of the Supply tab, select the demand plan, replenishment plan, or external forecast schedule, and select the check box under **Use for Demand Schedule**.

#### Calculate policy parameters
Select this check box to use the replenishment plan to calculate policy parameters.

If you select only this check box, you need to use a demand plan, another replenishment plan that has the **Generate forecast** check box selected, or an external forecast schedule for the demand forecast. Under Demand Schedules on the Organizations and Schedules subtab of the Supply tab, select the demand plan, replenishment plan, or external forecast schedule, and select the check box under **Use for Demand Schedule**.

If you don't select this check box, you can use another replenishment plan that has the **Calculate policy parameters** check box selected for calculating policy parameters. Under Demand Schedules on the Organizations and Schedules subtab of the Supply tab, select the replenishment plan, and select the check box under **Use for Policy Parameters**.

#### Calculate replenishments
Select this check box to use the replenishment plan to calculate replenishments.

If you select only this check box, then you need to do the following under Demand Schedules on the Organizations and Schedules subtab of the Supply tab:

- Select a demand plan, another replenishment plan that has the **Generate forecast** check box selected, or an external forecast schedule for the demand forecast, and select the check box under **Use for Demand Schedule**.
- Select another replenishment plan that has the **Calculate policy parameters** check box selected, and select the check box under **Use for Policy Parameters**.

To create an integrated replenishment plan, select the **Generate forecast**, **Calculate policy parameters**, and **Calculate replenishments** check boxes.

Refer to other topics in this chapter for information about the Scope, Demand, and Supply tabs of the Plan Options page.

---

**Open a Replenishment Plan**

You can open a replenishment plan using the Manage Plans page or Plans panel tab.

You can open only those replenishment plans that have been successfully run. Replenishment plans that haven't been run must be run before they can be viewed. For replenishment plans that haven't been successfully run, you must troubleshoot them and successfully run them before you can open them. Review the plan messages for troubleshooting.

Once you open replenishment plans, you can view their data and perform other actions.

On the Manage Plans page, replenishment plans are listed irrespective of their run status. On the Plans panel tab, only those replenishment plans that have been successfully run are listed.
Do one of the following to open a replenishment plan:

- To open the replenishment plan using the Manage Plans page:
  
  a. On the Tasks panel tab, under Plans, select Manage Plans.

     The Manage Plans page opens and displays the available replenishment plans.
  
  b. Select the replenishment plan, and click Actions > Open.

     The replenishment plan opens in a separate tab.

- On the Plans panel tab, under Plans, right-click the replenishment plan, and select Open.

     The replenishment plan opens in a separate tab.

Copy a Replenishment Plan

You can make copies of replenishment plans to save time and perform planning activities incrementally. For example, you have defined the organizations, segments, and policy assignment set for a replenishment plan. You can make a copy of that replenishment plan if the new replenishment plan uses the same entities.

Follow these steps to copy the replenishment plan:

1. To open the Duplicate Plan dialog box, do one of the following:

   a. To open the Duplicate Plan dialog box from the Manage Plans page:

      i. On the Tasks panel tab, under Plans, select Manage Plans.

         The Manage Plans page opens.

      ii. Under Search Results, select the replenishment plan that must be copied, and click Actions > Duplicate.

         The Duplicate Plan dialog box opens.

   b. To directly open the Duplicate Plan dialog box, on the Plans panel tab, under Plans, right-click the replenishment plan that must be copied, and select Duplicate.

      The Duplicate Plan dialog box opens.

   Only replenishment plans that have been successfully run are displayed on the Plans panel tab.

2. In Copy Type, select one of the following:

   a. Copy plan options only: This choice is for copying the plan options to the new replenishment plan. However, the plan data isn't copied.

      If the source replenishment plan hasn't been successfully run, only this choice is available.

   b. Copy all plan data with no reference to base plan: This choice is for making a full, standalone copy of the replenishment plan. Both the plan options and plan data are copied.

3. Enter a name and description for the new replenishment plan.

4. Select the access level for the new replenishment plan.

   If you select Private, the Users icon is enabled. Click this icon to open the Users dialog box in which you can edit the list of users who can open the replenishment plan.
5. In Owner, select the owner of the new replenishment plan.
6. Click Save and Close.

View a Replenishment Plan

You can view a replenishment plan using the Manage Plans page or the Plans panel tab.

On the Manage Plans page, you can view all the replenishment plans regardless of whether they have been successfully run. You can also search for replenishment plans using various criteria.

On the Plans panel tab, you can view only those replenishment plans that have been successfully run.

Follow these steps to view replenishment plans using the Manage Plans page:

1. On the Tasks panel tab, under Plans, select Manage Plans.
   The Manage Plans page opens and displays the available replenishment plans.
   You can configure the columns that display information about the replenishment plans.
2. In the Search region, specify the criteria by which you want to search for replenishment plans, and click Search.

To view replenishment plans using the Plans panel tab, expand Plans on the panel tab.

Manage Plan Options

Scope Plan Options for Replenishment Plans

Scope options determine the replenishment plan's scope. Define or modify scope options on the Scope tab of the Plan Options page.

The Scope tab includes the following:

- Dimension Catalog list
- Plan Organizations section
- Plan Items section
- Plan Parameters section

Dimension Catalog

In the Dimension Catalog list, select the dimension catalog from which hierarchies are made available for the replenishment plan.

You can use the predefined Default Replenishment Planning Catalog or a dimension catalog that you have created for your requirements. The dimension catalog that you use contains the hierarchies that you can select for your replenishment plan.

Note that Oracle Fusion Replenishment Planning doesn't support the Customer or Demand Class dimension. Any dimension catalog that contains these dimensions won't be available in the Dimension Catalog list.
Plan Organizations

Specify a hierarchy, a level, and level members by which to filter the organizations for the replenishment plan. Only the Enterprise hierarchy can be selected.

Also, select the source system to use for filtering organizations. Ensure that the selected source system is the same as that for the segment group that you select in the Segment Group list under the Plan Items section.

Plan Items

Select the segment group and segments that must be included in the replenishment plan.

Only those segment groups for which the segmentation process has been successfully run and that don't use the Customer or Demand Class dimension are available in the Segment Group list.

Only those item-location combinations belonging to the selected segments and organizations selected as level members under the Plan Organizations section are included in the replenishment plan scope. Moreover, in Oracle Fusion Product Management, the MPS and MRP Planning Method attribute must be set to Replenishment planning for these items.

Plan Parameters

The following table describes the plan parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Calendar</td>
<td>Planning calendar.</td>
</tr>
<tr>
<td></td>
<td>Only those planning calendars that are a part of the selected dimension catalog are available for selection. Moreover, the planning calendar can be of the fiscal, Gregorian, or organization type. You can select fiscal calendars when only the Generate forecast check box is selected on the Plan Options page.</td>
</tr>
<tr>
<td>Planning Time Level</td>
<td>Planning time level.</td>
</tr>
<tr>
<td></td>
<td>The planning time levels you can select are day and month for a fiscal calendar, month for a Gregorian calendar, and day, week and period for an organization calendar.</td>
</tr>
<tr>
<td>Number of Buckets</td>
<td>Number of planning buckets that determines the planning time granularity.</td>
</tr>
<tr>
<td></td>
<td>The maximum numbers of planning buckets you can specify are 31 for the day planning time level, 26 for the week planning time level, and 12 for the month or period planning time level. The planning time level and number of planning buckets together determine the planning horizon that's represented by the plan start date and plan end date on the General subtab of the Supply tab.</td>
</tr>
<tr>
<td>Policy Assignment Set</td>
<td>Policy assignment set for the selected segment group.</td>
</tr>
<tr>
<td></td>
<td>Policies are calculated based on policy parameters defined in the policy assignment set.</td>
</tr>
<tr>
<td>Measure Catalog</td>
<td>Catalog containing measures used in the replenishment plan output.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>By enabling only those measures that are needed for your replenishment plan, you can perform a focused analysis with improved performance.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Enable for incremental planning</strong> and <strong>Calculate replenishments</strong> check boxes are selected on the Plan Options page, the Incremental Replenishment Planning Default Catalog is selected, and the list is grayed out.</td>
</tr>
<tr>
<td>Exception Set</td>
<td>Exceptions computed as a part of the replenishment plan.</td>
</tr>
<tr>
<td></td>
<td>By enabling only required exceptions, you can improve the performance of the replenishment plan.</td>
</tr>
<tr>
<td></td>
<td>You must create exception sets and exceptions because there aren’t any predefined exception sets and exceptions for Replenishment Planning.</td>
</tr>
<tr>
<td>Simulation Set</td>
<td>Set of adjustments to item attributes.</td>
</tr>
<tr>
<td></td>
<td>Apply a simulation set to your replenishment plan to model different business scenarios.</td>
</tr>
</tbody>
</table>

### Set Up Policy Comparisons and Retain Policy Overrides

You can compare policies and retain policy overrides for a replenishment plan for which the **Calculate policy parameters** check box is selected on the Plan Options page. Additionally, while the **Generate forecast** check box may or may not be selected, the **Calculate replenishments** check box should not be selected.

Follow these steps to set up policy comparisons and retain policy overrides:

1. Open the Plan Options page for the replenishment plan through one of these ways:
   - Use the Manage Plans page:
     i. On the Tasks panel tab, under Plans, select **Manage Plans**.
        
        The Manage Plans page opens.
     ii. Under Search Results, select the replenishment plan that you want to edit, and click **Actions > Edit Plan Options**.
     - On the Plans panel tab, under Plans, right-click the replenishment plan that you want to edit, and select **Edit Plan Options**.
        
        Only those replenishment plans that have been run successfully are displayed.
   - On the Scope tab of the Plan Options page, click **Select Advanced Options**.

2. The Scope: Advanced Options dialog box opens.

3. Select the **Enable for policy comparison** check box.

   The **Threshold Percentage for Policy Comparison** field and **Retain policy overrides** check box are enabled.

4. In the **Threshold Percentage for Policy Comparison** field, enter the deviation percentage for automatically accepting newly calculated policy parameters.
If the deviation percentage between a newly calculated policy parameter and an existing policy parameter is less than the threshold value, the newly calculated policy parameter is automatically accepted.

5. Select the **Retain policy overrides** check box to retain manual policy overrides after the replenishment plan is run with the **Refresh with current data** option selected on the Run Plan dialog box.

   If you don’t select this check box, the policy overrides you made are overwritten the next time you run the replenishment plan and refresh it with current data.

   If you select this check box, the policy overrides are retained even if the deviation percentages for the newly calculated policy parameters are within the threshold percentage.

6. Click **Done**.

Considerations for Storing Plan Data at Aggregate Time Levels

For demand plans and replenishment plans, you can select a planning time level to determine whether plan data is stored at aggregate time levels. Storing the demand signal data at a daily level isn’t efficient if you forecast using demand signals at aggregate levels, such as weekly and monthly. When your data is stored at aggregate time levels, embedded analytics are more responsive and perform faster across your demand plan or replenishment plan. This decision is applicable to the Demand Management, Demand and Supply Planning, Planning Central, and Replenishment Planning work areas. Your choices for your forecasting time level are based on what you selected for your planning time level.

**Planning Time Level Parameter**

The **Planning Time Level** parameter is located on the Plan Options page, Scope tab, in the **Plan Parameters** section. Your selection for the **Planning Time Level** parameter determines the time level at which the plan data is stored. The values available for the **Planning Time Level** parameter are based on what you selected for the **Planning Calendar** parameter as follows:

- Gregorian calendar: Day or Month
  - Oracle Fusion Replenishment Planning doesn’t support the daily planning time level for the Gregorian calendar.
- Manufacturing calendar: Day, Week, or Period

**Forecasting Time Level Parameter**

For demand plans or replenishment plans, the **Forecasting Time Level** parameter is located on the Demand tab of the Plan Options page. The selections available for the **Forecasting Time Level** parameter are limited to the selected planning time level and any parent levels above it in the selected planning calendar. For example, if the Month level in the Gregorian calendar is selected for the planning time level, then the **Forecasting Time Level** parameter is limited to Month, Quarter, and Year.

**Configuration Examples: Weekly and Monthly Plans**

Weekly Plan: The following table shows an example of a configuration for a weekly demand plan or replenishment plan.

<table>
<thead>
<tr>
<th>Parameter Location</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Parameters section of the Scope tab</td>
<td>Planning Calendar</td>
<td>a manufacturing calendar</td>
</tr>
</tbody>
</table>
Monthly Plan: The following table shows an example of a configuration for a monthly demand plan or replenishment plan.

<table>
<thead>
<tr>
<th>Parameter Location</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Parameters section of the Scope tab</td>
<td>Planning Calendar</td>
<td>Gregorian calendar</td>
</tr>
<tr>
<td>Plan Parameters section of the Scope tab</td>
<td>Planning Time Level</td>
<td>Month</td>
</tr>
<tr>
<td>Demand tab</td>
<td>Forecasting Time Level</td>
<td>Month</td>
</tr>
</tbody>
</table>

**Demand Plan Options for Replenishment Plans**

Define or modify demand options for a replenishment plan on the Demand tab of the Plan Options page. The Demand tab is enabled only when the **Generate forecast** check box is selected on the Plan Options page.

In the **Forecasting Time Level** list, select the time level at which the forecast is generated. The selections in the list are restricted to the planning time level that you selected on the Scope tab or higher levels.

The following are the available forecasting time levels:

- Fiscal calendar: Day, month, quarter, and year
- Gregorian calendar: Month, quarter, and year
- Organization calendar: Day, week, and period

**Forecasting Profiles, Input Measures, and Output Measures**

In the Forecast Profiles section, specify the forecasting profiles for the replenishment plan. Only those forecasting profiles that are enabled for the Replenishment Planning work area are available for selection. When you run the replenishment plan, the forecasting profiles run in the specified order.

You can't edit the input measure or output measure for a forecasting profile. The data in the input measure serves as the basis of historical demand for the forecast. The output measure stores the generated forecast.

The following table lists the predefined forecasting profiles for Oracle Fusion Replenishment Planning:
### Analysis Set

An analysis set is an optional criterion used to apply a forecasting profile to a subset of a replenishment plan.

- If you don't select an analysis set, the forecasting profile applies to the full scope of the replenishment plan.
- If you select an analysis set, the forecasting profile is applied to only the subset of the replenishment plan scope that's defined by the analysis set.

For example, you have an analysis set containing a specific set of products, and you select that analysis set for a forecasting profile. The forecast is generated for only the products included in both the analysis set and the replenishment plan, instead of for all the products in the replenishment plan.

You can also use segments as member filters while configuring the analysis sets. Then, you can apply forecasting profiles to specific segments by selecting the associated analysis sets.

### Historical Buckets

Defines the amount of historical data to use during the forecasting process. The number of historical buckets is multiplied by the forecasting time level for determining the time horizon (number of days between the history start and end dates) for considering the collected historical demand.

The historical buckets substantially affect the demand forecast generated when you run the replenishment plan. Use at least 12 months of history, but using 18 to 36 months of history is the best practice. When setting the historical buckets, keep the following in mind:

- Very long history affects the replenishment plan runtime and makes the forecast less relevant to current demand patterns.
- Less than one year of history makes determining the impact of seasonal occurrences and holidays difficult or impossible.

The historical bucket setting is the maximum amount of history used during forecast generation. The actual amount depends on the data available for an item-location combination. For each item-location combination, the forecasting process identifies all available historical data, removes any leading zero demand prior to the first positive demand point, and generates a forecast.

### History Start and End Dates

The history end date is determined by the plan start date (displayed on the General subtab of the Supply tab of the Plan Options page) and the planning calendar. The history start date is determined from the history end date and the number of days between the dates. The number of days between the history start and end dates is determined by multiplying the number of historical buckets by the forecasting time level.
Forecast Buckets
Indicates the number of time periods for the demand forecast and is driven by the planning horizon set for the replenishment plan and the forecasting time level.

Locked Forecast Periods
Indicates the number of buckets from the end of historical data that don’t receive a new forecast when you run the replenishment plan.

Forecast End Date
Indicates the end date for the generated forecast. The end date is set to an end-of-period date based on the history end date, forecasting buckets, and forecasting time level.

Related Topics
- Create a Forecasting Profile
- Edit a User-Defined Forecasting Profile

Considerations for Configuring Supply Plan Attributes in Replenishment Plans

You can specify generic attributes of a replenishment plan, such as the assignment set and time horizon for demand, in the Supply Plan Attributes section on the Plan Options page, Supply tab, General subtab.

The Supply tab is enabled only when the Calculate policy parameters or Calculate replenishments check box is selected by itself or with other check boxes on the Plan Options page.

The plan start and end dates are calculated by the replenishment planning process. The plan start date is set to the date on which you run the replenishment plan, and the plan end date is calculated from the plan start date based on the planning time level and number of buckets defined on the Scope tab. The plan start and end dates are automatically advanced each time you run the replenishment plan. The plan start and end dates together define the planning horizon.

Assignment Set
Use assignment sets to link sourcing rules and bills of distribution to organizations and items. Using sourcing rules, bills of distribution, and assignment sets together, you specify how material is supplied and transferred across a supply chain.

Select the assignment set that must be used with the replenishment plan.

Overwrite Firm Planned Orders
Specify whether firm planned orders are retained between replenishment plan runs. When you select All, the replenishment planning process overwrites all orders, planned and firm planned, from the current replenishment plan. When you select None, the replenishment planning process doesn’t overwrite firm planned orders. However, planned orders that aren’t firm are overwritten.
Time Horizon for Demand
Specify the time window that's considered for the demand for an item-location combination when the inventory is calculated. When you select None, only the current day's demand for the item-location combination is considered. When you select Item lead time, the demand within the lead time for the item-location combination is considered.

Lead Time Multiplier
Enter the number by which the lead time for the item-location combination should be multiplied when the demand is considered during the calculation of inventory.

This field is enabled when you select Item lead time in the Time Horizon for Demand list.

A large lead time multiplier results in a large inventory.

Supply Cutoff Days
Enter the number of days after the plan end date for which already placed orders must be considered during the calculation of replenishments. Those orders whose due dates fall within the specified period after the plan end date aren't included in the normal or incremental replenishment planning process.

This value is required for proper calculation of the On Order measure and prevents excess replenishments from being created when the replenishment plan is run.

Automatic Release Options
Automatic release uses scheduled processes to release planned orders automatically after the plan run completes. The following options are available in the Automatic Release Parameters section on the Plan Options page in one of the Supply Chain Planning work areas:

- Release planned orders automatically
- Include rescheduled supplies in automatic releases

Release Planned Orders Automatically
When you enable the Release Planned Orders Automatically option, the planning process releases the planned orders automatically within the release time fence after the plan runs successfully.

For a supply plan or a demand and supply plan, the Release planned orders automatically plan option isn't copied when you copy a plan. The planning process won't release planned orders when you use the duplicated plan to perform simulations.

**Note:** Release time fence is an item-organization attribute and isn't defined in plan options.

Include Rescheduled Supplies in Automatic Releases
When you enable the Include Rescheduled Supplies in Automatic Releases option, the planning process automatically releases rescheduled supplies. This option is active only if you selected Release Planned Orders Automatically.

This option isn't available in the Replenishment Planning work area.
To navigate to the Automatic Release Parameters section, follow these steps:

1. On the Edit Plan page, click the Tasks panel drawer.
2. In the Tasks panel drawer, click Manage Plans.
3. In the Search area, search for your plan.
4. Select the plan from the displayed search result. Click Actions and then click Edit Plan Options.
5. On the Plan Options page, click the Supply tab.

The General tab appears. The Automatic Release Parameters section is a part of this tab.

Release Recommendation Options

Use the Release Recommendations Parameters section in the Supply: Advanced Options dialog box to configure the following supply plan options:

- Compression days tolerance for automatic release
- Requisition load group by
- Transfer load group by
- Released only by user

Access the Release Recommendations Parameters section from a Supply Planning, Demand and Supply Planning, Replenishment Planning, or Planning Central work area.

Compression Days Tolerance for Automatic Release

Use this option to indicate the number of compression days allowed for the automatic release of planned orders. The number of compression days applies only to automatic release of planned orders and recommendations. Compression days means the number of days reduced between the start date and due date as suggested by the planning process.

The Compression Days Tolerance for Automatic Release field isn't available in the Supply: Advanced Options dialog box for a replenishment plan.

Requisition Load Group By

Use this option to indicate the requisition load group when loading requisitions to purchasing. For each option, except All, the planning process creates one line for each planned order within each requisition.

- **All**: The planning process creates one purchase requisition for all recommended orders.
- **Item**: The planning process creates one purchase requisition for each item.
- **Buyer**: The planning process creates one purchase requisition for each buyer.
- **Supplier**: The planning process creates one purchase requisition for each supplier.
- **Category**: The planning process creates one purchase requisition for each item category.
- **Location**: The planning process creates one purchase requisition for each location.

Transfer Load Group By

Use this option to indicate the transfer load group when loading transfers to logistics. The value of Transfer Load Group By determines how the actual transfer order is created.

- **All**: The planning process creates all transfers in one transfer order.
• **Source and destination and ship date:** The planning process creates one transfer order for each Ship From and Ship To organization, and each ship date.

• **Source and destination, shipping method and ship date:** The planning process creates one transfer for each Ship From and Ship To organization pair, and shipping method and ship date.

**Released Only by User**

Use this option to specify whether to restrict implementation of planned orders and recommendations to the current user. If you enable this option, the planning process implements only those planned orders and recommendations that the current user has marked. If you disable this option, the planning process implements planned orders and recommendations that are marked by any user.

**Note:** This option applies only to the manual release of planned orders.

Use these steps to navigate to the Release Recommendations Parameters section in the Supply: Advanced Options dialog box:

1. Open a plan:
   a. In a Supply Planning, Demand and Supply Planning, Replenishment Planning, or Planning Central work area, click the Tasks panel drawer.
   b. In the Tasks panel drawer, click **Manage Plans**.
   c. In the Search area, search for your plan.
   d. Select the plan from the displayed search result.
2. On the Edit Plan page, click **Actions** and then click **Edit Plan Options**.
3. On the Plan Options page, click the Supply tab.
4. On the General subtab, click **Select Advanced Options**.

The Supply: Advanced Options dialog box opens, which includes the Release Recommendations Parameters section.

**Technical Control Parameters**

When you enable this option, the planning process implements multithreading during the plan run. Multithreading decreases the overall run time of a plan. To enable this option, click **Select Advanced Options** in the General tab of a supply plan and select **Enable multithreading** on the Supply: Advanced Options dialog box.

**Organizations and Schedules Options for Replenishment Plans**

Use the Organizations and Schedules subtab of the Supply tab of the Plan Options page to configure subinventory netting for the organizations covered by your replenishment plan. You also use the subtab to select demand plans, replenishment plans, or external forecast schedules for providing the demand forecast and replenishment plans for providing policy parameters.

The Supply tab is enabled only when the **Calculate policy parameters** or **Calculate replenishments** check box is selected by itself or with other check boxes on the Plan Options page.
Organizations

Use the Organizations section of the subtab to specify the subinventory netting for organizations that are covered by the replenishment plan.

These organizations are the same as those that you selected in the Level Members dialog box on the Scope tab of the Plan Options page.

For each listed organization, in the Subinventory Netting dialog box, select or deselect the check boxes under **Enable Netting** to include or exclude subinventories from the supply-demand netting in the replenishment plan. During the collection process, data is collected from the subinventories based on the organization configuration in the source system. If you enable subinventory netting for a new subinventory in the source system, the replenishment plan automatically includes the new subinventory after the next collection process.

Demand Schedules

Use the Demand Schedules section of the subtab to specify the sources of the demand forecast and the replenishment plan for calculating policy parameters.

You can select the following for the demand forecast:

- Another replenishment plan that has the **Generate forecast** check box selected on the Plan Options page and that has been run
- A demand plan that has been run
- An external forecast schedule

If the replenishment plan is used for incremental planning (the **Enable for incremental planning** check box is selected along with the **Calculate replenishments** check box on the Plan Options page), you can’t select another replenishment plan, a demand plan, or an external forecast schedule for the demand forecast. Only actual demands (sales orders, transfer orders, and inventory position) are considered during replenishment calculation.

If the **Generate forecast** check box is selected on the Plan Options page, the replenishment plan is listed in the Demand Schedules section, and the check box under **Use for Demand Schedule** is automatically selected and can’t be deselected.

If the **Calculate policy parameters** check box is selected on the Plan Options page, the replenishment plan is listed in the Demand Schedules section, and the check box under **Use for Policy Parameters** is automatically selected and can’t be deselected.

This table explains how you use the Demand Schedules section:

<table>
<thead>
<tr>
<th>Selected Check Box</th>
<th>Selection in Demand Schedules Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calculate policy parameters</strong></td>
<td>Select a source for the demand forecast.</td>
</tr>
<tr>
<td></td>
<td>If you select more than one source, the forecasts from different sources are added up for the item-location combination.</td>
</tr>
<tr>
<td></td>
<td>If you select a replenishment plan, you must select the check box under <strong>Use for Demand Schedule</strong>. If you select a demand plan or an external forecast schedule, the check box is automatically selected and grayed out.</td>
</tr>
</tbody>
</table>
For a demand or replenishment plan, you must select an output measure for the forecast in the **Demand Plan Output** list. The available measures are as follows:

- Approved Final Bookings Forecast
- Approved Final Shipments Forecast
- Final Bookings Forecast
- Final Consumption Forecast
- Final Shipments Forecast

Select another replenishment plan that has been run with the **Calculate policy parameters** check box selected on the Plan Options page, and select the check box under **Use for Policy Parameters**.

You can select only one replenishment plan for calculating policy parameters.

You can also use the same replenishment plan for generating the forecast and calculating policy parameters if it was run with the **Generate forecast** and **Calculate policy parameters** check boxes selected on the Plan Options page.

---

### Run a Replenishment Plan

When you run a replenishment plan, you can specify how you want to refresh the data and if you want to generate the forecast, calculate policy parameters, calculate replenishments, and archive the plan. Also, you can run the replenishment plan immediately or in the background at a set time or on a repetitive schedule.

Regardless of your plan setup, you use the following sequence for running your replenishment plan:

1. Generate the forecast or specify the external forecast schedule.
2. Calculate the policy parameters.
3. Calculate the replenishments.

Consider these examples:

<table>
<thead>
<tr>
<th>Setup of Replenishment Plans</th>
<th>Run Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replenishment Plan A generates the forecast, calculates the policy parameters, and calculates the replenishments.</td>
<td>Run Replenishment Plan A only once.</td>
</tr>
<tr>
<td>Replenishment Plan 1 generates the forecast and calculates the replenishments, and Replenishment Plan 2 calculates the policy parameters.</td>
<td>You need to run Replenishment Plan 2 before being able to attach it to Replenishment Plan 1. Therefore, the only remaining step is to run Replenishment Plan 1 for generating the forecast and calculating the replenishments.</td>
</tr>
<tr>
<td>Replenishment Plan Y generates the forecast and calculates the policy</td>
<td>1. Run Replenishment Plan Y to generate the forecast and calculate the policy parameters. 2. Run Replenishment Plan Z to calculate the replenishments.</td>
</tr>
</tbody>
</table>
### Data Refresh Options

These data refresh options are available under the Details region on the Parameters tab of the Run Plan dialog box:

- **Do not refresh with current data:** Select this option to run your replenishment plan with no changes to demands and supplies for item-location combinations. You use this option for simulation planning. When you select this option, the plan start and end dates displayed on the Plan Options page, Supply tab, General subtab aren’t advanced.

- **Refresh with net-changed data:** Select this option to perform incremental replenishment planning for only those item-location combinations with net changes in demands and supplies. This option is available only when the **Enable for incremental planning** and **Calculate replenishments** check boxes are selected on the Plan Options page for the replenishment plan.

- **Refresh with current data:** Select this option to refresh the replenishment plan with the latest collected data and advance the plan start and end dates on the Plan Options page, Supply tab, General subtab. If you’re running the replenishment plan for the first time, only this option is enabled, and it’s selected by default. If you have selected only the **Calculate policy parameters** check box on the Plan Options page and are running the replenishment plan for the policy comparison process, you must select this option.

### Scope Options

These scope options are available under the Details region on the Parameters tab of the Run Plan dialog box:

- **Generate forecast:** Select this check box to generate the forecast as a part of the plan run. The check box is enabled only when the **Generate forecast** check box is selected on the Plan Options page. If this check box is enabled, and you’re running the replenishment plan for the first time, the check box is selected by default and can’t be deselected.

- **Calculate policy parameters:** Select this check box to calculate policy parameters as a part of the plan run. The check box is enabled only when the **Calculate policy parameters** check box is selected on the Plan Options page. If this check box is enabled, and you’re running the replenishment plan for the first time, the check box is selected by default and can’t be deselected.

- **Calculate replenishments:** Select this check box to calculate replenishments as a part of the plan run. The check box is enabled only when the **Calculate replenishments** check box is selected on the Plan Options page. If this check box is enabled, and you’re running the replenishment plan for the first time, the check box is selected by default and can’t be deselected.

- **Archive plan:** Select this check box to archive the results of the plan run. This check box is available only when the **Generate replenishments** check box is selected on the Plan Options page and the **Enable for archiving** check box is selected on the Scope: Advanced Options dialog box of the Plan Options page, Scope tab.

### Run the Replenishment Plan

Follow these steps to run the replenishment plan:

1. Open the Run Plan dialog box through one of these ways:
   - Use the Manage Plans page:
     1. On the Tasks panel tab, under Plans, select **Manage Plans**.
Best Practices for Setting Up Replenishment Plans

You can configure replenishment plans in various ways to meet your business requirements. This table explains the various configurations that you can use for your replenishment plans:

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Plan Purpose</th>
<th>Planning Horizon</th>
<th>Planning Time Level</th>
<th>Frequency of Plan Runs</th>
<th>Selected Check Boxes</th>
<th>Release from Plan?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strategic replenishment plan</td>
<td>To estimate how well your policies meet anticipated demands</td>
<td>6 months to 1 year</td>
<td>Weeks or periods</td>
<td>Weekly or monthly</td>
<td>Generate forecast, Calculate policy parameters, and Calculate replenishments check boxes</td>
<td>No</td>
</tr>
<tr>
<td>Integrated replenishment plan</td>
<td>To monitor and execute policies</td>
<td>31 days or less</td>
<td>Day</td>
<td>Daily</td>
<td>Generate forecast, Calculate</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Replenishment Plans

<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Plan Purpose</th>
<th>Planning Horizon</th>
<th>Planning Time Level</th>
<th>Frequency of Plan Runs</th>
<th>Selected Check Boxes</th>
<th>Release from Plan?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automated execution plan</td>
<td>To incrementally calculate replenishments according to a schedule and actual demands (sales orders, transfer orders, and inventory position)</td>
<td>15 days or less</td>
<td>Day</td>
<td>Daily or intraday</td>
<td>Enable for incremental planning and Calculate replenishments check boxes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>You must use another replenishment plan for the policy parameters.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>You can’t select another replenishment plan, a demand plan, or an external forecast schedule for the demand forecast.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Optionally, you can use a weekly demand plan, a weekly replenishment plan, or an external forecast schedule for the forecast.

Optionally, you can use a policy comparison or policy calculation plan for the policy parameters.
<table>
<thead>
<tr>
<th>Plan Type</th>
<th>Plan Purpose</th>
<th>Planning Horizon</th>
<th>Planning Time Level</th>
<th>Frequency of Plan Runs</th>
<th>Selected Check Boxes</th>
<th>Release from Plan?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy comparison plan or policy calculation plan</td>
<td>To compare or calculate policies</td>
<td>6 months</td>
<td>Week</td>
<td>Monthly</td>
<td>Generate forecast and Calculate policy parameters check boxes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Related Topics**

- Overview of the Policy Comparison Feature
12 Forecast Simulation

Overview of Forecast Simulations

Simulating forecast scenarios help in evaluating different scenarios by changing the demand plan parameters, causal factors, or configuration of a forecasting profile. Simulation enables you to change almost any input to the forecasting process, and in near real time, see what impacts it would have on the results. When you run a forecast in simulation, the forecast may be assigned different output measures. Thus, you can view the results of your complete plan run side by side with simulation results.

You can select up to six output measures on the Simulate Demand page. Simulation results are stored in these measures instead of the measures the complete plan forecast is using. In most cases, you modify the Forecast Measure selection to review the results, without altering other settings such as, forecast level, forecast methods, and decomposition information.

Simulation is run on the members of a table or graph. You can run the simulation on all the members of the table or graph, or restrict the execution to certain members based on the selected Scope option:

- Table or Graph: Generate a forecast based on the population of the table or graph.
- Table with Pivot Filter: Generate a forecast based on the pivot table filter.
- Table Selection: Generate a forecast on only the selected table members.

Simulation is also the best way to quickly create new forecasting profiles, modify some of their definitions and view the output side by side with established forecasting profiles. If the new results look like an improvement you can then modify the established forecasting profiles as needed.

You have two sets of predefined output measures. They are by the name Simulation 1 and Simulation 2, and other output measures begin with the word Simulate. You can create additional measures based on these measures to support additional scenarios.

**Note:** If multiple users are conducting simulations using the same forecasting profiles and modifying the profile, each users changes can impact the other user. It may be best for different users who are running simulations to each have their own forecasting profile. You can create a new forecasting profile based on an existing profile by duplicating it. Use the Duplicate icon available on the Simulate Demand dialog.

You can use simulation in the following scenarios:

- Run unlimited number of forecast simulations to review impacts, such as changes in the price, running a marketing campaign, shift in weather, and demand upside request.
- Simulate how changes to forecasting models and parameters have an immediate impact on the statistical forecast.
- Simulate changes to attach rates or change the independent option forecast for configure to order items.
- Simulate the impact of introducing new products in particular geographic areas.
- Perform side by side analysis of any number of scenarios and review the impact on operational and financial objectives.
Simulate Demand

Use this topic to understand how to simulate forecasts using Simulate Demand. Selections to run simulate demand are valid for different use cases. Hence, for faster results you should select the specific options.

Simulation provides you with an easy way to view the results of different scenarios side by side. To accomplish this you need to ensure that your scenarios have a different output measure. You can do this by modifying the output measure each time you run a simulation or create several profiles you use for simulation purposes and execute each scenario using a different profile.

To run simulate demand:

1. In the Navigator, click the Demand Management work area link.
2. On an open table in the plan, click the Actions menu, and then click Simulate Demand.
3. On the Simulate Demand page, perform the following:
   a. Select the details for the forecast generation, forecast methods and causal factors.
      When you run a plan you may select whether you want to see the forecast decomposed into more detailed information based on forecasting methods and causal factors. The same options are available when running simulation and these options can provide substantial value in simulations where a targeted part of the plan receives a forecast. Note that adding more details increases forecast generation runtimes but this should not be impact for relatively small simulations.
   b. Review the parameters in the other tabs.
      For example, review and activate the forecasting methods from the Forecasting Methods tab.
4. Click the Simulation Output tab, select the output measures parameters and add to table, as required.
   From the Output Measure parameters, select the Forecast Measure, the measure to which the forecast will be stored. The other selections for measure are primarily useful when you are performing more detailed forecast analysis and diagnosis.
   The Add to Table check box controls whether the measure is automatically added to the table when you run a simulation. This streamlines the process for viewing simulation results by adding any new measure to the table.
5. Click Save and Run.
   Once simulation run is complete, you can review the revised configuration side-by-side with previous forecasts.

Create a Simulation Set

Perform the following steps to create a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Open button.
3. In the Open Table, Graph, or Tile Set dialog box, do the following:
   a. In the Search drop-down list, select: Name.
   b. In the Search text box, enter the name of a table, such as Items or Resources.
   c. Click the Search icon button.
d. Select the Items (or Research) table and click OK.

4. On the Plan Inputs page, Items tab (or Resources tab), click the Search button.

5. In the Search Results region, select one or more rows and do the following:
   a. Click Actions and then select Add to Simulation Set.
   b. In the Add to Simulation Set dialog box, click the Search: Simulation Set down arrow for a list of values, and then click Create Simulation Set.
   c. In the Create Simulation Set dialog box, in the Simulation Set field, enter the name of the simulation set you want to create.
   d. Click Save and Close.
   e. In the Add to Simulation Set dialog box, click Save and Close.

Related Topics
- Overview of Simulation Sets
- Simulations in Supply Planning
- Copy Data to Simulation Sets in Supply Planning
- Add Data from Plan Inputs to Simulation Sets

Edit a Simulation Set

Perform the following steps to edit a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Plans panel tab.
3. In the Plans panel drawer, do the following:
   a. Expand the list of Simulation Sets.
   b. Select a simulation set, right-click on it and select Open.
4. On the Simulation Set page, click Open and then select Full Pane.
5. In the Open Table, Graph, or Tile Set dialog box, select a table, such as Resources or Items, and then click OK.

On the Simulation Set page, a new tab opens for the table that you selected, such as the Resources tab or the Items tab.

6. In the Search region, click Search.
7. In the Search Results region, select one or more rows. Click Actions and then select Edit from the drop-down list.
8. In the edit dialog box, you can edit some of the attributes and drill down to additional tables, depending on the table that you accessed. For example:
   o For the Resources table, you can change the Bottleneck value. You can also drill down to the Resource Availability table.
   o For the Items table, you can change the Processing Lead Time value. You can also drill down to the Suppliers table.
9. When done, click OK to return to the Simulation Set page. Changed rows and fields are marked with small colored dots.

Related Topics
- Overview of Simulation Sets
Simulate Demand and Supply Changes

Edit a Simulation Set from a Spreadsheet

You can download simulation set data into a spreadsheet, make edits, including certain updates, additions, and deletions, and then upload it back to the simulation set. In the Plan Inputs work area, while working with the Items or Supplies and Demands table in a simulation set, use the Edit in Spreadsheet option in the Actions menu to download the table rows into a Microsoft Excel file.

Note: Before working with spreadsheets, you must download and install the desktop integration installer that is available under Navigator > Tools. Otherwise, you can't download information into or upload information from spreadsheets.

To edit the data in the Items or Supplies and Demands table of the simulation set in a Microsoft Excel spreadsheet, follow these steps:

1. In the Plan Inputs work area, click the Plans panel tab.

   Note: The simulation set can also be edited from the Planning Central, Sales and Operations Planning, and Supply Planning work areas. However, the Supplies and Demands table is available in the simulation set only when it is edited in the Supply Planning work area.

2. In the Plans panel drawer, do the following:
   a. Expand the list of simulation sets.
   b. Select the simulation set that you want to edit, right-click, and click Open. The simulation set opens.

3. In the Open menu, select Full Pane. The Open Table, Graph, or Tile Set dialog box opens.
4. Select the Items or Supplies and Demands table, and click OK. The table opens in a page in the simulation set.
5. Perform a search for the table rows in the simulation set.
6. In the Actions menu for the table, click Edit in Spreadsheet. A dialog box opens and prompts you to save or open a Microsoft Excel file.
7. Click Yes. A dialog box opens and prompts you to type your credentials.
8. Sign in with your Oracle Applications Cloud credentials. The spreadsheet is refreshed with the data in the simulation set.
9. Edit the data.

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add an item to the Items table of the simulation set</td>
<td>Click the Add Item icon in the Items menu of the spreadsheet, and provide values in the Add Item dialog box that opens. You can add an existing item or create an item that is based on an existing item.</td>
</tr>
<tr>
<td>To create an order in the Supplies and Demands table of the simulation set</td>
<td>Click the Create Order icon in the Supplies and Demands menu of the spreadsheet, and provide values in the Create Order dialog box that opens. (Not applicable to sales and operations planning.)</td>
</tr>
<tr>
<td>To edit a row</td>
<td>Modify the values in the row cells that are not grayed out. A symbol appears in the cell under the Changed column for the row.</td>
</tr>
<tr>
<td>Task</td>
<td>Steps</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To delete a row</td>
<td>Click the corresponding cell in the Mark for Deletion column. A symbol appears in the cell to mark the table row for deletion. To deselect the row, click the cell again.</td>
</tr>
</tbody>
</table>

11. Click the **Upload** icon in the **Items** or **Supplies and Demands** menu. In the Upload Options dialog box that appears, select the check boxes for the options that you want to use, and click **OK**. The data is uploaded to the simulation set.

12. Save the simulation set. The changes are displayed and marked with colored symbols.

13. Save and close the spreadsheet.
13 Business Insights

Manage Notes in Supply Chain Planning

Use Notes in Supply Chain Planning to document and communicate important information about your plan. You can use notes to provide reasons for any changes made to a plan or to record decisions and assumptions that led to those changes. You can save these notes for future reference or to provide details to other users. Participants in the plan management process can annotate the data with notes to document changes and assumptions.

Notes functionality is available in the Demand Management, Supply Planning, Planning Central, and Sales and Operations work areas. You can create notes for the following:

- Plans
- Planning level members, such as items, organization, and customers
- Planning combinations, such as a specific item-organization-date-measure combination
- Exceptions

When you create a note, you must specify a note type. Note types enable notes to be categorized, which you can use as a search criteria. The following lists the predefined note types:

- General
- Assumption
- Decision
- Issue
- Possibility
- Risk
- Reference
- Special

You also specify whether the note is private or public. Private notes are visible only to the user who created the note. Public notes are visible to all the users with whom the object is associated.

From the Demand Management or the Sales and Operations work area, you can access the Notes table to display planning level members for Product hierarchies. You can create a layout to view the Notes table as part of the layout instead of as a dialog box. The Notes table is not available for Supply Planning or Planning Central.

Notes for Plans

You can create notes for plans. When you copy a plan, any notes associated with the plan are copied into the new plan.

To create a note for a plan, do the following:

1. Open the Plan Options page for your plan and click the Manage Notes icon.
2. In the Manage Notes dialog box, click Actions > Add.
3. In the Add Notes dialog box, add your notes.
4. Click OK.
5. Click Save and Close.
Notes for Planning Level Members

You can associate notes with planning-level members, such as items, organizations, and customers. You can create notes at any level of the hierarchy, such as on an individual item, on a brand, or on a product category.

Notes that you create on planning level members at lower levels in the hierarchy are visible when you open Manage Notes from an aggregate level. Notes that you create on level members are not plan-specific. This means that a note associated with a level member is visible from any plan that contains that member.

To create a note on a level member, click **Create Note** from the **Actions** menu.

To view, edit, or delete an existing note, select the level member, click **Manage Notes** from the **Actions** menu.

Notes for Planning Combinations

You can associate notes for the planning combinations, such as a specific item, organization, date, and measure combination. Planning combinations appear as cells within a table.

You can create a note at any level; however, they are only visible at the level at which they are created. For example, if you create a note at a brand, month, and measure combination, you cannot view that note at the item, day, and measure level.

If you copy a plan, then any plan-specific notes on planning combinations are also copied.

To create a note for the planning combinations, do the following:

1. Select the associated table's cell in the table.
2. Click **Create Note** from the Actions menu.
3. Add your notes.
4. Click **Save and Close**.

To view, edit or delete an existing note on a planning combination, do the following:

1. Select the **Note** icon from the table's cell level.
2. Click **Manage Notes** from the Actions menu.

**Note:** If you create a note on a planning combination and the associated measure is shared across plans, then the note is not plan-specific. In this case, the note is visible across all plans. If you create a note on a planning combination and the associated measure is not shared across plans, then the note is plan-specific. In this case, the note is visible within the plan in which you created it.

Notes for Exceptions

You can associate notes for exceptions. Notes on exceptions persist across plan runs. If an exception still exists after a plan is run again, then any notes associated with the exception are retained. When an exception is resolved, the exception is removed from the application. In that case, any notes associated with the exception are also removed.

To create notes for an exception, do the following:

1. Click the **Note** icon on the table row of the exception.
2. Add your notes.
3. Click **Save and Close**.

Related Topics

- Overview of Oracle Social Network
Glossary

dimension
A data category used to organize business data for retrieval and preservation of values. Dimensions usually contain hierarchies of related members grouped within them. A dimension categorizes and describes measure data. For example, a measure named Price might be categorized by Product and Time, so that the price of items can be tracked over time.

planning data repository
The set of data collected from source systems and stored for use by order management, order promising, and supply chain planning processes.

Selector Tool
A user interface within supply chain planning work areas used to select measures, hierarchy levels, and dimension members. Used when creating and editing tables, graphs, analysis sets, and infotiles.

work area
A set of pages containing the tasks, searches, and other content you need to accomplish a business goal.